
Welcome to Movie Magic Screenwriter
In an attempt to bring some logic into an inherently chaotic world, I've decided to try to organize this 
help file in terms of stages of learning.    Thus we have the following sections.

Copyright Notice
Things Every Screenwriter User Should Know
Installation / Uninstallation

Quick Help Page

Basic Information
Running Movie Magic Screenwriter
Choosing a Script Format
Typing the Script
Editing the Script
Saving the Script
Opening a Saved Script
Printing the Script
Importing Scripts
The Main Menu Bar

Advanced Movie Magic Screenwriter Features
Configuring Movie Magic Screenwriter
Using User Lists
Setting Script Options
Exporting the Script
Movie Magic Screenwriter in Production
Movie Magic Screenwriter in Animation Production
Appendix



Copyright Notice
Copyright Schafer 1993-97
All rights reserved.    No part of this publication may be transmitted, reproduced, stored in any 
retrieval system or translated into any language or computer language in any form or by any means, 
mechanical, electronic, magnetic, optical, chemical, manual, or otherwise without prior written 
consent by Ken Schafer at ScriptPerfection Enterprises.

The software described in this help file is furnished under license and may be used only in 
accordance with the terms of such license.

ScriptThing, ScriptThing for Windows, SmartCheck, SmartTab, ZapSave, QuickType, PrintThing and 
the ScriptThing Logo are trademarks of ScriptPerfection Enterprises, WordPerfect is a registered 
trademark of the WordPerfect Corporation; Microsoft Word is a registered trademark of Microsoft 
Corporation; Movie Master is a registered trademark of Comprehensive Video Software; Scriptware 
is a registered trademark of Cinovation, Inc; Movie Magic and Dramatica are registered trademarks 
of Screenplay Systems; Collaborator is a registered trademark of Collaborator Systems; all others 
are registered trademarks of their respective corporations.

Disclaimer
Ken Schafer and ScriptPerfection Enterprises make no representation or warranties with respect to 
the contents hereof and specifically disclaim any implied warranties of merchantability or fitness for 
any particular purpose.    Movie Magic Screenwriter is provided "as is" without warranty of any kind, 
either expressed or implied.

Ken Schafer and ScriptPerfection Enterprises shall have no liability or responsibility to you or any 
other person or entity with respect to any loss or damage caused by Movie Magic Screenwriter 
including, but not limited to, any loss of profits, interruption of service, loss of business or 
consequential damages resulting from the use of such programs.



Quick Help Page
This Page is a graphic representation of a page of script with all of the possible elements -- 
action/dialogue/script notes/scene headings/shots, etc. on it and all you have to do is click on the 
element in question and it will give you information about it and the keystrokes used to put it in, and 
the menu options affecting it.

Quick Help is gotten to by pressing <ALT+F1> or going to the Help Menu and choosing Quick Help



Basic Information
Conventions in this Help File
If I tell you to press two different keys separated by a "+" sign, you should press the first one, hold it 
down, press the second one, and then release them both.    If you're supposed to type text, no 
special annotation will be used.    Things in angle brackets "< >" are keystrokes. Variable text to be 
supplied by the user is denoted in capitalized and parenthesized text.    For example, if I tell you to do
the following:

<CTRL+F> (FILENAME) <ENTER>

That means you should press the CTRL key and hold it down, then press the F key and release both
of them.    You should then type whatever the file name is and then press ENTER. Although 
keystrokes are usually described in all capitals in this Help file, you can enter them either in lower 
case or capitals, unless explicitly directed otherwise.

PushButtons are designated by square-bracketed text in this Help file.    For example [Alias] refers to 
the button labelled "Alias" on the Edit User List Menus.

Vocabulary & Menus

Element - A Movie Magic Screenwriter' Element is the most basic unit of the script, with its own 
margins, line spacing, capitalization etc.    The six most common elements are Scene Heading, 
Action, Character Name, Dialogue, Parenthetical, and Transition.

Main Menu Bar - Movie Magic Screenwriter' Pull-Down menus can be accessed from the Main 
Menu Bar by single-clicking on the menu items or by pressing the Alt key and the underlined letter in
the menu item (e.g. <Alt+ F> for the File menu)).

NOTE: To use Alt-keys to access Main Menu Bar you must have Enable Alt-keys for Character 
Name Entry box unchecked in the Program Options.

There are three basic types of menus:

Pull-Down Menu - This is a scrollable menu whose options all have a Underlined QuickSelect letter 
in them.    To make a selection, you can (1) scroll through the options with the arrow keys and press 
<ENTER>, (2) use the mouse and single-click on the one you want, or (3) simply press the 
Underlined QuickSelect Letter and the option you want will be instantly selected.

List Menu - This is a scrollable menu similar to the Pull-Down menu except this menu's options DO 
NOT have any Underlined QuickSelect letters in them.    
You can (1) scroll through the options with the arrow keys, (2) scroll through the options using scroll-
bar, (3) use the mouse and click on the option you want, or (4) type letters and it will match what 
you've typed against the menu options, automatically scrolling to the matching one.    When the one 
you want is highlighted, press <ENTER>.

Option Menu - These menus have different types of input options including PushButtons, 
CheckBoxes, RadioBoxes, and Text & Numerical Input Fields.    All options have a Underlined letter, 
and you can select the option you want by (1) pressing that letter (if you're in a Text or Numerical 
Input Field such as the File Name, press Alt + that letter so that it can distinguish that from straight 
input); (2) moving around in the menu by pressing the Tab key or the up and down arrow keys and 
edit the option you want when it's highlighted, or (3) using the mouse and clicking on the one you 
want.

PushButtons - You select a PushButton by (1) clicking on it with a mouse, (2) selecting it with the 
arrow or tab keys and pressing <ENTER>, or (3) pressing its Underlined letter and whatever function



it does will be accessed immediately.    [OK] will always exit a menu, accepting all of the current 
settings, Cancel will always cancel a menu without changing anything.

CheckBoxes - CheckBoxes are checked and unchecked by (1) pressing the Underlined QuickSelect
Letter, (2) clicking on them with the mouse, or (3) cursoring to them and pressing <ENTER> or the 
<Space Bar>.

RadioBoxes - RadioBoxes are identical to CheckBoxes except that only one RadioBox in any given 
group--usually shown in a box will be checked at any one time.    If you select a different RadioBox 
then the currently checked one, the old one will automatically be unchecked.

Text or Numerical Input Fields - Text or Numerical Input Fields will allow you to enter text or 
numbers as required.    Depending on what you are entering text for, it may or may not allow you to 
enter spaces, and it may or may not automatically be in all caps.

Movie Magic Screenwriter also has the following features to facilitate your scriptwriting:

Top Speedbar -The Top Speedbar has several PushButtons for editing and file management, a 
Current Element Window, a Change Element Pulldown menu, and a Right-Left Scroll Bar that allows 
quick access to frequently used program functions. The Top Speedbar is located just under the Main 
Menu Bar. 

Right Speedbar - The Right Speedbar has an Up-Down Scroll bar and PushButtons, and optional 
Element Buttons for easy script management. The right Speedbar is displayed at the right side of 
your screen.
    
PowerPanel - The PowerPanel is a unique Movie Magic Screenwriter feature that can be accessed 
by clicking on the right button of your mouse.    This Pop-Up Panel of PushButtons considerably 
speeds up script editing.



Running Movie Magic Screenwriter
To run the program in Microsoft Windows simply double-click on the Movie Magic Screenwriter Icon, 
then the logo will appear and when loading procedure is finished you'll be taken to a screen specified
in Startup/Files Page of the Program Options Menu.

Default Startup option will display a screen-sized Retrieve List of all the files in your Scripts 
subdirectory.    You can either retrieve an existing script or start a new one at this point.    In either 
case, you will be taken to the Main Editing screen.    

Main Menu Bar - Movie Magic Screenwriter' Pull-Down menus can be accessed from the Main 
Menu Bar by single-clicking on any of the menu items or by pressing <ALT> + the underlined letter in
the menu item.

NOTE: To use Alt-keys to access Main Menu Bar you must have Enable Alt-keys for Character 
Name Entry box unchecked in the Program Options.

Top Speedbar - the optional Top Speedbar has several PushButtons that allow quick access to 
frequently used program functions for editing and file management, the Current Element Window 
with Change Element drop-down menu, and the Right-Left Scroll Bar. The Top Speedbar--when 
visible--is located just under the Main Menu Bar. 

Right Speedbar - has an Up-Down Scroll bar and PushButtons for Page Up/Down, and optionally 
has Element Buttons for element entry with the mouse.    The Right Speedbar is displayed at the right
side of your screen.

The Bottom Bar - contains a Hint Line, [Insert/Typeover] PushButton, the current Line and Position 
of your cursor, and the current Page Number followed by the Total Number of Pages.



Choosing a Script Format
Movie Magic Screenwriter is shipped with pre-set formats for Screenplays, 
Sitcoms, and Stage Plays, all of which can be modified if desired.

When you first run Movie Magic Screenwriter, you're normally automatically ready to write in 
Screenplay format without doing anything, so if you're writing in that format, just go ahead.    If you 
want another format, however, this is what you have to do:

Loading a Script Format:
Select the Format Menu on the Main Menu Bar, then click on Load Script Format and select the 
option you want to use.

If you select any of the preset options (Screenplay, Sitcom I, Sitcom II, or Stage Play), Movie Magic 
Screenwriter will reformat the on-screen script according to those settings.    

If you select User Defined, it will display a Menu of all the formats which you've previously saved, 
and reformat the script to the one you choose.

If you selects From a Screenwriter Script, it will display a Menu of all existing Movie Magic 
Screenwriter scripts, and reformat the script to match the settings of the one you choose -- this is 
especially useful if you're doing a lot of different sitcom formats and want to reload one you've set up 
already.



Typing the Script
One of the great benefits of Screenwriter is its capability to be used at many different levels of 
complexity.    For all your various options you should see the printed manual, otherwise simply click 
on the item below that you want more information about.

Put in FADE IN:
Start a Scene     Heading  
Put a Location into a Scene Heading (ie KIRK'S DEN)
Put the Time of Day in a Scene Heading (ie -- DAY)
Put in     Action  
Put in a New Character Name
Put in an Existing Character Name
Put in a Character Name Extension
Remove a Character Extension
Put in     Dialogue  
Put in a Parenthetical
Put in a Transition
Put in a Forced Page Break
Remove a Forced Page Break
Switching between Insert     &     Typeover Modes  
Put in a Shot
Put in Act     Information (TV Format)  
Put in Scene     Information (TV Format)  
Put in a Centered Title
Put in a Script Note
Put an Existing Character Name into Action/Dialogue
Bolding Text
Underlining Text
Italicizing Text
Put in a     Soft-Hyphen   (ie a Hyphen that will ONLY show up if it's needed to break the word over a line
end)
Put in a     Hard-Dash   (ie a Dash that is NOT used for Word wrapping)
Put in a     Hard-Space   (ie a Space that is NOT used for Word wrapping)
Putting in a Hard Return (ie Ending Lines Short)
Putting In Dual-Column     Dialogue  
Overriding the breaking of Action     or     Dialogue   
Creating a Title Page



Editing the Script
Movie Magic Screenwriter' editing features are quite extensive so you should really see the 
printed manual for full details, however, click on any of the following topics that you're 
interested in for more information.

Available Movement keys
Changing an Element from One Type to Another
Changing the Capitalization of Existing Text
Cheating the Margins of an Element
Cutting Text (for pasting elsewhere)
Copying Text (for pasting elsewhere)
Deleting Text
Getting to Index Card Viewing Mode
Merging Scripts
Pasting Text
PowerPanel
Putting in and Removing Revision     Marks  
Quick Bold & Capitalization of Previous Word
Quick Capitalization of Previous Word
Quick Lower-casing of Previous Word
Saving Portions of your Script
Selecting     Text   (for cut and paste, deletion etc.)
Switching among Documents
Turning On/Off Scene     Numbering  



Saving the Script
To save your script simply do one of the following:
· Select the Save Script item from the File Menu and if the Script already has a name, then Movie

Magic Screenwriter will save the script, automatically replacing any existing script with that name
without any further prompts.    If the script doesn't yet have a name, then you will be taken to the 
Save File Menu just as if you'd hit Save As..

· Select the Save As... item from the File Menu and you will be taken to the Save File Menu to 
allow you to change the name of the script, the format in which it will be saved (see Exporting the
Script for more details), and the drive and subdirectory if desired.    If you select a name that 
already exists, Movie Magic Screenwriter will ask if you want to overwrite the existing Script.    
You will also be able to browse through the contents of your Drives and Subdirectories, specify 
the Type of the File you are saving, Backup Script to A: or B: drive, and setup the Default Script 
Backup Options.

· Click on the [SAVE] Button (the one with the icon of a disk on it) on the Top Speedbar -- note this
button can be set to be the same as Save or as Save As... in the Misc. Page of the Program 
Options Menu

· Press <F10> for Save As... or <F7> for Save
How Movie Magic Screenwriter Saves and Replaces your Scripts
When Movie Magic Screenwriter saves a script, it checks to see if there is    an existing script with the
same name already saved.    If there is one, then it changes the suffix of that script from .SCR to .BK. 
It then saves the new script with the correct suffix.

The reason that it does this is in case of a power outage or disk error or other problem during the 
saving process, you won't lose the previously saved copy of the script.    It also has the added benefit
that if for some reason you want to go back to the most previously saved version of your script, just 
go to Load File Menu using any of the methods described below and specify Prev. Saved Script for 
File Type and you will see the list of these files. 

NOTE: (1) Movie Magic Screenwriter will not ask you to give it permission to replace an existing 
script with the same name as the current script unless you have just changed that name and by 
doing so may overwrite a different script. (2) If there is an existing file with the .BK extension when 
Movie Magic Screenwriter wants to rename the old .SCR file, it will simply delete the old .BK file 
without any prompts.



Opening a Saved Script
There are several options for opening saved scripts, including having it 
automatically opened for you when you run the program.

· Select Open from the File Menu or click on the [OPEN] Button on the Top Speed Bar (the one 
with the icon of an opening folder) and you'll be taken to the Open File Menu

· Go to the File Menu and the three last scripts you'd saved will be listed at the bottom in the order
of oldest to most recent.    Select the one you want and it will be opened

· Set the program to automatically retrieve either the last script you worked on or the entire last 
workspace on the Startup/Files Page of the Program Options Menu.

Opening the most previously saved version of a script
When Screenwriter saves a script, it automatically renames the extension of any existing script with 
that same name to .BK so if you want to go back one version, simply go to the Open File Menu, 
change the File Type to Prev. Saved Script and select the one you want.

Opening a Timed Backup
Simply go to the Open File Menu, change the File Type to Timed Backup and select the one you 
want.    Note that the Timed backups are saved as save1.tmb, save2.tmb and so on, the number 
reflecting the Window number that the autosave was performed on.



Printing the Script
Movie Magic Screenwriter gives you many options for printing your script, but first it helps if 
you getting to the Print Menu.    To get there...

Method 1:    Select Print under File Menu in the Main Menu Bar.

Method 2:    Click on the [Print] Button on the Top Speedbar.

Method 3:    Press <CTRL+P>.

Any of these methods will display the Print Menu itself.

There are also several Printing options you can change...

Printer Setup Menu - found on the File Menu on the Main Menu Bar. Once you're at the Printer 
Setup Menu, you can select which printer to use, specify the page size, orientation, and source.    For
more information on this menu, check your Windows Manual or Windows Help File.

Setup Page Layout - this screen lets you set exactly how many lines you want on the page, top 
margins, page number position, etc.

Header Setup Menu - lets you specify what text should go in the header, the frequency of printing 
the header, and its margins and justification.

Printer Page of the Program Options Menu - lets you use printer font substitution, set it to darken 
Courier New and more...



Importing Scripts
Movie Magic Screenwriter can directly open WordPerfect® 5.1/6.x, MS Word® 
DOS 5.5/Win 2.0, RTF (Rich Text format), Movie Master® for DOS, Scriptware® 
Tagged, WordStar®, Dramatica® 3.0 Export files and ASCII files in addition to 
supporting Cut & Paste Import directly from other well-behaved Windows 
programs.

However, no matter what format you are importing your script from, there are two basic constraints 
which must be followed: 1) the original file must have each script element (ie. Character Name, 
Dialogue, Action, etc.) start on its own line and 2) the script must be generally in script format... (ie 
Character Names before dialogue and so on).    As long as both these things are true, you should be 
able to painlessly import it from virtually any other program.

Cut & Paste Importing from other Windows Programs - if the script is in another Windows Word 
Processor on the same computer as Movie Magic Screenwriter, this is your ticket...

Opening any of the supported formats if your file is already in one of these above listed formats, 
this is what you want.

NOTE: If your situation doesn't match either of these previous two options, then you'll need to 
prepare your script before Movie Magic Screenwriter can import it.

Preparing a Script from Microsoft Word® (DOS) other than Ver 5.5

Preparing a script in WordPerfect® 5.0 (for DOS) or earlier

Preparing a script in WordPerfect® 7.0 or later    -- DOS or Windows 

Preparing a Script from Movie Master® for DOS -- only follow these instructions if simply opening 
it as described above doesn't work...

Preparing a Script from Movie Master® for Windows -- if it's on the same machine as 
Screenwriter use the Cut/Paste Functionality to import it, otherwise click here for instructions.

Preparing a Script from Final Draft®

Preparing a Script from Scriptware®

Preparing Text created in Dramatica® version 3.0 or later

Preparing a Script from any Windows Word Processor -- use this only if you are exporting the 
script from a computer that does not have Movie Magic Screenwriter loaded on it, or the direct Cut & 
Paste Importing was unsuccessful

Preparing a Script from any other non-Windows Word Processor

Cleaning Up Imported files

NOTE: Due to the near-infinite varieties of possible formatting, Movie Magic Screenwriter Import 
Function may require you to do some clean up after the script is imported.



To change mis-recognized elements, place the cursor anywhere in the element in question, and 
click on the CURRENT ELEMENT BOX (in the center of the Top Speed bar) and select the element 
you want it to become, and bang, it switched for you.

If the imported script was in TV format, then you may have to reset the script's formats to the 
appropriate settings (See Choosing a Script Format for more details) and you'll have to put back in 
the forced Page Breaks between scenes and redo the Act and Scene Information.    We apologize 
about this, but due to the utter lack of standardization in TV formats, the import function is unable to 
recognize all possible permutations.



The Main Menu Bar
Movie Magic Screenwriter' Main Menu Bar gives you access to nine Major Pull
Down Menus.    They are:

File
Edit

Format
Search
Goto
Spell

Production
Window

Help



File Menu
The first Menu on the Main Menu Bar:

· New - starts a new blank Script
· Open - displays the Open Menu allowing you to select the script to open or import
· Close - closes the current script, giving you the choice to save it and back it up as appropriate
· Save - saves the current script with its present name if it has one, automatically replacing any 

existing script with that name, or it takes you to the Save As... Menu if the script has not been 
named yet.

· Save As... - takes you to the Save File     Menu   where you can specify a File Name and File Type 
of the file you are saving, browse through Drives and Directories, Backup Script to Drive A or B, 
and set up the Default Script Backup Options

· Save All Open Scripts - selecting this menu item is the same as choosing SAVE for all open 
scripts.

· Backup Script to Floppy - this will take you to a sub-menu where you can select Drive A:\ or 
Drive B:\ and it will backup the current script to that drive.

NOTE: Drive B:\ will be grayed out if you only have one floppy disk drive.

· Header Setup - displays the Header Setup Menu to change the header and how it prints
· Title Page Publisher - takes you to the Title Page Publisher where you can create Title Pages in

a Graphic Environment.
· Page Layout - displays the Setup Page Layout Menu that allows to change the page margins, 

text/line spacing and more...
· Print Preview - displays a WYSIWYG print preview of the current page of the script
· Print - displays the Print Menu where you can chose what to print
· Printer Setup - displays the standard Windows' menu that allows to select which printer to use, 

in addition to setting the the paper size and orientation.

· Program Options - takes you to the Program Options Menu -- the "gateway" to configuring how 
the Movie Magic Screenwriter program looks and works

· Display Options - pops down a sub-menu and you should check or uncheck any of the items to 
have them displayed or not as desired:
· Only Show Top Menu - this menu item is a toggle, turning on or off all normally displayed 

speed and button bars, leaving a "clean screen" showing only the Top Menu.    When it 
checked, the next four of the following Menu Items will not be available.

· Top Speedbar - turns on or off the Top Speed Bar with associated Speed Buttons
· Bottom Status Bar - takes you to another sub-menu where you can select the display status

of the Bottom Status Bar and whether it displays a Running Scene Count and/or a Running 
Act Count

· Right Speedbar - turns on or off the display of the Right Speed Bar
· Right Element Buttons - turns on or off the display of the Element Buttons on the right 

speed bar.
· Ruler - turns on or off the display of a ruler in the Script Window
· Zoom Screen Text... - displays a menu that lets you zoom the size of the on-screen text 

from 50% to 150% of the standard size using a slide bar



· Show Hints - turns on and off the Hints display
· Show Format Codes - shows or hides the display of format codes (bold, italics, underline, 

etc.).
· Clear File History List - clears the list of the three files that you'd most recently saved
· Set Screen Colors - takes you to the Set Screen Colors Menu where you can set the screen

colors for Movie Magic Screenwriter
· Setup Fonts for Menus - takes you to a sample menu where you can select any available 

font to optimize the display for your version of Windows and your monitor
· Edit Top Speed Bar - runs the Top Speed Bar editor, allowing you to add, move and 

rearrange the Speed Buttons on the top speed bar. You can also accomplish this by double-
clicking anywhere on the top speed bar itself, as long as you don't double-click on a button!

· Hide Elements on Screen - allows you to hide or unhide the following elements on the screen: 
Action, Character Name/Dialogue, Scene Headings, and Script Notes in addition to globally 
turning on or off the display of non-printing text.

· Exit - this will exit Movie Magic Screenwriter.

NOTE: the File History List at the bottom of the File Menu lists the three scripts in the script 
subdirectory that you'd most recently saved, and selecting one will automatically load that script.



Edit Menu
The second Menu on the Main Menu Bar:

NOTE: The first two options Undo and Redo will ONLY be on the menu if you have Undo Levels 
on the Editing Page of the Program Options Menu set to a value greater than zero.

· Undo - will restore up to the ten most recent changes made to the script.    This option may be 
grayed-out and unselectable if Movie Magic Screenwriter has nothing to Undo.    See Multi-Level 
Undo for more details

· Redo - If you have used the Undo command and haven't yet made any new changes, you can 
restore the script to how it was prior to the last Undo by using this Redo menu item

· Cut - cuts the selected text to the Windows Clipboard for pasting elsewhere
· Copy - copies the selected text to the Windows Clipboard for pasting elsewhere
· Delete - deletes the selected text
· Paste - will paste at the cursor position whatever text was cut or copied last, even from another 

Windows' program

· Paste from - will display the a browse menu with the list of files available, merging the one you 
select at the cursor position in the current document.

· Cut To... - cuts the selected text and saves just that text to a file with the name you want
· Copy To... - copies the selected text and saves just that text to a file with the name you want.

· Select All - selects all the text in the script
· Select Special - displays a sub-menu where you can select Word, Sentence, Element, Group, 

Page, or Scene
· Turn off Block - unselects the current selection

· Add Forced Page Break - adds a forced page break at the cursor position
· Remove Forced Page - removes the forced page break that is immediately following or 

preceding the cursor position

· Add Hard Return - puts in a hard return at the cursor
· Add Dialogue Paragraph - if you're in Dialogue, it will add a Dialogue Paragraph -- that is 

another dialogue element preceded by a blank line, otherwise if you're in a Character Name or 
Parenthetical Element, it will simply start a normal dialogue element.

· Convert case - displays a sub-menu with options to convert the case of existing text.    NOTE: if 
you do not have any text selected when you choose one of these options, it will affect the entire 
element that you're currently in, otherwise it will just be applied to the selected text

· Change Text Color - displays a sub-menu with options to convert the color of existing text.    
NOTE: if you do not have any text selected when you choose a color, then it will affect the entire 
element that you're currently in, otherwise it will just be applied to the selected text



Format Menu
The third Menu on the Main Menu Bar:

· Edit Script Formats... - this will display the Edit Script Formats Menu, the "gateway" to changing
any of the script's formats

· Load Script Format - will take you to a sub-Menu which will allow you to load any preset 
formats ( Screenplay, Sitcom Version I, Sitcom Version II, Stage Play, User Defined, or from a 
Screenwriter Script) as the format for the current script, and reformat the script appropriately

· Save Script Format - will take you to a sub-Menu which will allow you to save the current script 
format as one of    the preset formats (Screenplay, Sitcom Version I, Sitcom Version II, Stage 
Play, All New Scripts, User Defined, thus redefining it.)    In the last case, you can also give this 
format a name and save it as a user defined format

· Edit User Lists - this will display the Edit User Lists Menu, the "gateway" to editing the script's 
Users Lists, where you can also set up Alias Text and Substitution Text

· Load User Lists from - loads saved User Lists from Screenwriter Scripts, ASCII Lists, 
Collaborator®    or Dramatica®    Export Files created in Dramatica version 3.0 or later, or 
restores them to the program's defaults

· Hide Names in Pop-Up List - takes you to the Hide Names in Pop-Up List Menu where you can 
hide or unhide any Character Names from the automatic Pop-Up Lists

· Hide Locations in Pop-Up List - takes you to the Hide Locations in Pop-Up List Menu where 
you can hide or unhide any Locations from the automatic Pop-Up Lists

· Cheat - takes you to the Cheat Sub-Menu where you can cheat all sorts of things like line 
spacing, length of pages, and so on.

· Reset Cheated - takes you to the Reset Cheated Sub-Menu where you can undo any previously
cheated elements

· Change Element Type - will drop-down a sub-Menu of options:
· Pop-Down List - will do just that, displaying the list of element types from the Top SpeedBar,

changing the current element's type to the one you select
· Left Column - will change the current element group to the left column    of two column (dual)

dialogue.
· Right Column - will change the current element group to the right column    of two column 

(dual) dialogue.
· Normal (Full Width) - will restore the current element group to the normal width of each of 

the constituent elements.
· Set Column Margins - will allow you to set the left and right column margins for each of the 

element types

NOTE: Although the left/right columns will not display in true dual column formats (ie next to one 
another on screen) they WILL print out correctly and all the page breaks will be calculated based on 
these columns being next to one another

· Repaginate Now - if you have set the program to not do real-time pagination, or simply don't 
want to wait for the repagination delay (set in Misc. Page of the Program Options Menu)--or want
to force a redraw of the screen, select this option and it will repaginate instantly.

· Run SmartCheck - this will run Screenwriter's SmartCheck feature
· Scene Character lists - this will take you to a submenu with the following options:



· Generate - this will take you to the Scene Character Lists Generation Menu where you can 
generate/regenerate the lists

· Remove - this will remove all existing Scene Character Lists from the script

NOTE: The Generate Rundown Sheet and Print Set List menu items that were previously on this 
submenu have been moved to the Production Menu, under Sitcom Breakdowns

· Mark all of One Character's Dialogue - this will pop up a list of all the character names, 
allowing you to select one then automatically highlighting it in Red



Search Menu
The fourth Menu on the Main Menu Bar...

· Search - this Menu item will display the Text Search Menu where you can specify what text to 
search for

· Search & Replace - this will display the Text Search Menu where you can specify what text to 
search for, and what text to replace it with

NOTE: Both the Search and Search & Replace menu Items bring up the same Text Search Menu, 
the difference is that when you select Search then the option Replace With is automatically set to 
DON'T REPLACE while otherwise it is set for you to enter text.    However once there, you can set it 
to just search or search/replace as desired.

· Search Again or Srch/Repl Again - if you've already done a search or search & replace this 
session with Screenwriter, then this Menu Item will continue whichever it was you last did--either 
search or search & replace--from the current cursor position with the settings you'd specified in 
the Text Search Menu, otherwise it will be grayed out and unselectable

· Change Character Name - this will display a special Search Menu with the Search Text 
replaced by a drop-down list of all the Characters in the script, and certain functions 
automatically selected for you.    To change a name throughout the script, simply use this 
function, select the old name, type in the new name and press OK.    It will replace it everywhere 
the old name exists in the script, matching its capitalization, and automatically updating all lists.



Goto Menu
The fifth Menu on the Main Menu Bar...

· Top - will take you to the top of the script
· Bottom - will take you to the bottom of the script
· Page - will allow you to enter a page number and will take you to that page
· Scene - will display a List Menu of all existing Scenes in your script and let you select one, 

instantly taking you to that Scene
· Act/Scene Info - will display a List Menu of all existing Act Info and Scene Info Lines followed by

their respective Scene Headings.    Select the one you want, and you'll be instantly taken there

· Previous Scene Heading - will take you to the previous Scene Heading if there is one
· Next Scene Heading  - will take you to the Next Scene Heading if there is one
· Next A-Page - will take you to the next A-Page if there is one
· Next Forced Page Break - will take you to the next Forced Page Break if there is one

· Next Speech by... - will display a List Menu of all the Characters in the script and let you select 
one, taking you to his/her next speech if there is one

· Next Script Note - will take you to the next Script Note if there is one
· Next Current Revision Mark - will take    you to the next Current Revision Mark if there is one
· Next Strikeout or Colored Text - will take    you to the next element that either has a Revision 

color or a strikeout code in it.
· Next Hidden Text - will take you to the next element that is hidden

· Last Position - will return you to the last position where you were editing text.
· Bookmark... - will display the Bookmark Menu , allowing you to set / delete / or goto any 

previously saved Bookmark.



Spell Menu
The sixth Menu on the Main Menu Bar...

· Word - will spell check the word the cursor is in.
· Element - will spell check the element that the cursor is currently in.
· Page - will spell check the page that the cursor is currently on.
· Forwards - will spell check from the top of the element that the cursor is currently in through to 

the end of the script
· Entire Script - will spell check the entire script from the top downwards no matter where the 

cursor currently is positioned

NOTE: When the SpellChecker finds a problem it will display the Spell Check Menu

· Thesaurus - will pull up the Thesaurus Menu for the word that the cursor is currently on
· WordWeb - will pull up the WordWeb dictionary/thesaurus/brainstorming program produced by 

Anthony Lewis.    It offers dictionary definitions of words, synonyms, antonyms, and related words
and concepts.    Mr. Lewis has generously produced this program as freeware, and you can 
download from it from the web at http://www.netword.demon.co.uk./wweb.    

Once downloaded, simply install it into the Screenwriter program directory and it will become 
instantly available for your use just like the normal thesaurus and spell check.    If you do not 
have access to the web, send us $15.00 to cover our costs and we'll supply you with a set of 
disks.

· Homonym Check - will pull up the Homonym Check Menu which will allow you to check the 
usage of words like THEIR/THERE/THEY'RE.

· Count Words - will count all the words in the script without spell checking them
· Pause AutoCorrection - will pause the real-time Spell Check with any associated Auto-

Correction and Auto-Capitalization to allow you to type in something that Movie Magic 
Screenwriter is trying to "correct" for you.    Once this function is paused, the menu item will be 
checked and you will have to select it again to uncheck it

· Clear Ignore List - will tell the spell check to no longer ignore any words which you told it to on 
the Spell Check Menu itself -- this does NOT affect learned words...

· Change Dictionary - allows you to change the User Dictionary
· Select Language - allows you to select a different languages -- if the one you want is not 

currently installed, call us at 800-450-9450 for purchasing information
· Edit User Dictionary - allows you to edit any of the user dictionaries to easily add words or 

remove words that you'd inadvertently added.



Production Menu
The Seventh Menu on the Main Menu Bar:

· Lock the Script... - this will take you to the Lock The Script Menu that allows you to set all the 
Locked Script Options in one step.    It will ONLY be available in a script that has neither Locked 
Pages nor Locked Scenes.

· Unlock the Script... - this will ask you to verify if this is what you REALLY want to do, and if you 
type in YES, then it will take you to the Unlock The Script Menu that allows you to set all the 
Locked Script Options in one step.    It will ONLY be available in a script that has neither Locked 
Pages nor Locked Scenes.

· Multi-Lock. - this option will be grayed out unless the script already has Locked Scenes or 
Pages, in which case it will take you to a sub-Menu with two options:

· Scenes - this option will be grayed out unless the script already has Locked Scenes, in 
which case selecting it will turn on/off Multi-Locking of Scenes

· Pages - this option will be grayed out unless the script already has Locked Pages, in 
which case selecting it will turn on/off Multi-Locking of Pages

· Start Next Revision - this option will ONLY be available in a script that has Locked Pages and, if
selected, it will remove all current Revision Marks, fix the A-Pages, increment the Revision Draft 
Color, prompt you to save the script and take you to the title page publisher to edit the color list.

· Set Revision Draft Color - this option will ONLY be available in a script that has Locked Pages 
and, if selected, it will take you to the Revision Draft Color Menu where you can change the 
currently selected Revision Draft Color and/or the entire Revision Draft Color order.

· Fix or Flex... - this option will be grayed out if your script does NOT have locked pages, 
otherwise it will take you to a sub-menu where you can change Flexible A-Pages to Fixed A-
Pages or vice-versa, and or change the locking status of Headers.

· Auto-Revision... - this will take you to a submenu with two options:
· Marks - this menu item will turn on or off the AutoRevision Marks.    When they're on, there is 

a check on this menu item
· Colors - this menu item will take you to a further sub-menu:

· Select an Auto-Revision Color: (Red, Blue, Green or User Defined)
· Turn off the Auto-Revision Color

· Remove... - this will take you to a submenu with the following options
· Current Revision Marks - this menu item will remove all the Current Revision Marks in 

the script
· Strikeout Codes and/or Text - this menu item will allow you to remove all Strikeout 

codes from the script, optionally also removing all Striked-out text in the process.
· Red, Blue, Green or User Defined Highlights - these four menu items will allow you to 

remove all of any colored highlighting.
· Scene Heading w/o OMITTED - if you are in a Scene Heading when you select this 

option, it will ask you if you really want to remove this Scene Heading without creating an 
OMITTED and if you say YES, then it will do so, renumbering any following scenes as 
appropriate.

· Locked Page Break - if you type YES to the prompt which appears, this will remove the 
closest locked page break.    This function duplicates the Remove Forced Page menu 
item on the Edit Menu, but is also here for completeness.

· Override - this menu item will take you to a sub-menu where you can override many things:



· Page's Header/Draft Color - this will take you to a menu where you can change the 
header text and/or the designated draft color of the page that the cursor is currently on.

· Page Break Type - this will take you to a menu where you can select to change the page
break type that the cursor is currently on, switching it, for example, from an A-Page to a 
Locked Page.

· Scene Heading's Numbering - you must have the cursor somewhere in a Scene 
Heading to use this features, but in that case, it will take you to a menu where you can 
select to change the Scene Heading's numbering either by changing the Scene Heading 
type or by specifying the desired number directly.    This pretty much duplicates the 
functionality of the Cheat Element Menu, but is also put here for ease of use.

· Animation Locking - this menu item will take you to a sub-menu where you can:
· Lock Current Rev. Marks - this menu item will lock all Current Revision Marks and increase 

the Revision Mark Locking level
· UnLock one Rev. Mark Level - this menu item will remove all Current Revision Marks, 

convert the previous level's locked Revision Marks to Current ones and decrease the 
Revision Mark Locking level

· Lock Dialogue Numbering - will lock the Dialogue numbering so that any new added 
dialogue will be put in with A-Numbering.    Can be repeated to increase the new dialogue 
numbering to AA-Numbering

· Unlock Dialogue Numbering - which will lower the Dialogue Numbering Locking by one 
level, so if you're at AA-Numbering it will change it to A-Numbering, otherwise it will revert it 
to normal numbering

· Adjust Dialogue Numbering - allows you to "cheat" the dialogue numbering of any specific 
locked speech

· Breakdowns - displays a sub-menu with the following options:
· Tagging Mode - turns on or off the Breakdown Tagging Mode
· Edit Categories - takes you to the Edit Breakdown Categories Menu
· Tag Items Globally - takes you to a menu where you can select to tag any text globally 

within the script
· Untag All Items - will remove all Breakdown Tags from the script
· Setup Duplicate Names - will take you to to the Setup Duplicate Names Menu where you 

can identify alternative names for the same characters (such as ABRAHMS and CAPT. 
ABRAHMS being the same character)

· Movie Magic Scheduling Export - will take you to the Production Breakdown Scene 
Selection Menu where you can select which scenes the program should export breakdown 
information for.

· Layout Breakdown Sheets - will take you to the Breakdown Sheet Layout Menu where you 
can select the catagories and layout options for the internally generated Breakdown Sheets.

· Edit Breakdown Sheets - will take you to the Breakdown Sheet Editor which you use to edit 
the text on any individual breakdown sheet prior to printing or exporting to Movie Magic 
Scheduling.

· Print Breakdown Sheets - will allow you to select a range of breakdown sheets for printing.
· Sitcom Breakdowns - this menu item will take you to a sub-menu with the following options:

· Generate Rundown Sheet - will take you to the Generate Rundown Sheets Menu where you
can define and generate by Sitcom Rundown Sheets and Set Lists

· Print Set List - will take generate a Sitcom Set List and print it out for you



· Production Solutions - displays a sub-menu with help broken down by common production 
topics and additionally gives you the options:
· Merge Text into Script - this option will be grayed out UNLESS you are in locked script.    In 

that case it will be accessible and is to be used when you have a script that's been locked but
more than one person is working on different copies of it and you need to recombine the two 
scripts into one without generating erroneous revisiong marks or page breaks.    To do so, 
open both copies of the script, then select this function and follow the on-screen instructions.

· Temporarily Disable - this take you to a sub-Menu with two options:
· Locked Pages - will temporarily disable the automatic Locked Pages management 

functions allowing you to cut and move groups of locked pages in a script without 
generating A-Pages and without the program performing its normal locked pages 
functions.

· Locked Scenes - will temporarily disable the automatic Locked Scene management 
functions allowing you to cut and move Scene Headings in a script without generating A-
Scenes and without the program performing its normal locked scenes functions.

NOTE: Use these two Temporarily Disable functions with GREAT CAUTION as you can cause 
serious disarray in the script!



Window Menu
The eighth Menu on the Main Menu Bar...

· Cascade - will arrange all open windows to overlap
· Tile - will arrange all open windows into a tiled pattern without overlapping
· Arrange Icons - will arrange any minimized window icons at the bottom of the main window
· Minimize All - will minimize all open script windows
· Maximize Window - will maximize (make full screen) the active window

· View As Index Cards - this will put you into View as Index Card Mode
· Redraw Screen - will refresh the screen

NOTE: There may be up to nine other options at the bottom of this menu, each of them being the 
name of one of the open windows.    Selecting any of them will take you to that window.



Help Menu
The ninth and final Menu on the Main Menu Bar...

· Contents - will display this help file's contents
· Search for Help On... - will run the Help File and take you directly to a search function where 

you can type in a keyword
· Quick Help - will display a graphic display of a page of the script and you can click on different 

elements to get help about how to put them in

· Memory Available - if you're in Windows 3.1, this will display the amount of memory available on
your system, including current systems resources, otherwise it will be disabled

· Calendar - will pop-up a calendar so that when producers call you for meetings, you can 
instantly see what day it falls on

· Name Bank - will pop up the Name Bank Menu which is a collection of 3,900 Male Names, 
4,950 Female Names and 22,000 Family Names designed to help you find interesting and 
unique names for your characters.

· Script Analysis - will give you fascinating and useful information about your script
· Compare Two Scripts - if you have two versions of the same script currently open, this function 

will give create a striked-out/redlined version of the script to show what's been changed between 
the two versions.    Anything new that's been added/changed will be marked in Redline (Red 
Highlight), anything that's been removed will be marked in strikeout.

· Configuration Wizard - will run the Configuration Wizard to assist you in configuring Movie 
Magic Screenwriter

· Character Set - will run the Windows program CHARMAP.EXE which gives you access to 
Extended Character Set -- however, there is an easier way of entering Accented Characters 
simply by pressing [CTRL]+the accent followed by the letter which you'd like to have an accent.

· About... - displays the About Menu with    information about your version of Movie Magic 
Screenwriter including registration and Serial Number information (if you entered it during the 
Installation) and tells you about the people who made this a reality



Configuring Movie Magic Screenwriter
Movie Magic Screenwriter is extremely flexible, and you can set many of its features on or off to 
make it work exactly how you want it to.    This section deals with setting how the program works, not 
how the script looks.    If you are looking to change something in the script, see Edit Script Formats 
Menu.

The easiest way to configure the program is to use the Configuration Wizard--gotten to from the Help
Menu--or if you want to go into more detail and really get your fingers dirty,    then you can find all of 
the program settings on the Program Options Menu found on the File Menu on the Main Menu Bar.    
Display Options such as turning on/off the top or right speed panels can be found on the Display 
Options Menu also found under the File Menu.



Using User Lists
One of the features of Movie Magic Screenwriter that makes it so incredibly flexible is its User Lists 
which allow you to specify exactly what text should go on many of the Pop-Up menus and be 
recognized when you type it as being of a certain element type.

How User Lists Work

Editing User Lists with the Edit User Lists Menu

Loading User Lists

Why Loading Character Names or Scene Body Text Lists from Screenwriter scripts 
sometimes doesn't work.

Copying Script Elements into User Lists

Reloading the Original Program Default Lists

Saving a Script's Lists as the Default Lists for all New Scripts



Setting Script Options
In addition to letting you load any of the (semi-) standard formats ( screenplay, sitcom, stage play, 
etc)    that it ships with, Movie Magic Screenwriter also lets you modify any or all of a script's formats 
to make the script look exactly the way you want it.    

You can load a new format by going to the Format Menu and selecting Load Script Format.

You can edit the script's format by going to the Format Menu and selecting the Edit Script Formats
Menu.

NOTE: You can change the Margins, Line Spacing, Font, and Text Styles (bold, capitals, etc.) for 
any given element type from the Edit Script Formats Menu, however, if you just want to change the 
Margins or Line Spacing for just one element rather than for every instance of that element, use the 
Cheat Element function instead.



Exporting the Script
Sadly, not everyone is as fortunate as you are in possessing Movie Magic Screenwriter, so you may 
run into times when you need to give your script to someone else in a format that they can use.    But 
since you are one of the lucky ones who does own Movie Magic Screenwriter, this is not a problem.

NOTE: The script that you export is designed as a working draft, and will NOT have exactly the 
same margins, page breaks, or even number of pages as the script does in Screenwriter, nor will it 
have any MOREs or CONTINUEDs because every word processor handles those kinds of things 
differently... which was one of the reasons for getting Screenwriter in the first place!    The exported 
script is designed to be an editable copy of the script with all the text in general format rather than 
an exact duplicate.

Exporting is simply a matter of saving the script with a different format.    To do so, first have 
the script you want to export on screen, and then...

Step 1: Select the File Menu, choose Save As... and the Save File Menu will be displayed.    On this 
menu, click on File Type to drop down the list of available file types and select the format you want to
export to    .If you don't see the name of the Program that you wish to export to on this list, then often 
Formatted ASCII or RTF is a good choice.

Step 2: Wait a few, and the script will be saved/exported!

Cut and Paste Exporting - if you are exporting to another Windows program on the same computer,
then you can alternatively simply select the text you want to export, cut or copy it, switch to the 
Windows program you want to export to, and paste in the exported text.

Loading an Exported Script into WordPerfect - you can load a script exported as WordPerfect or 
WordPerfect w/Styles into WordPerfect 5.1 or above just like you'd load any other file, without doing 
anything further to it.

Loading an Exported Script into Microsoft Word - try saving the script as MS Word 2.0 if you're 
exporting to a Windows version of Word, MS Word 5.5 if you're saving to a DOS version of Word and
either Word 2.0 or RTFif you're going to a Mac version of Word.

Loading an Exported into other programs - the script must have been saved/exported as a format
that they can read, and you should follow the instructions in their manuals or call their Tech Support 
for help importing scripts into these programs, though typically RTF or WordPerfect 5.1 may be your 
best bets.

NOTE: We will be only be able to give tech support on the export part of this problem, as we have 
no control over how other company's programs deal with importing.



Movie Magic Screenwriter in Production
Movie Magic Screenwriter has many features geared specifically for handling 
scripts in the middle of production and you may want to see the printed 
manual for full details.

Doing Production Rewrites
Production rewrites can be painless as long as you understand some basic concepts.    Movie Magic 
Screenwriter can automatically generate all A-Pages, A-Scenes and revision marks for you.

However, for it to do this, you MUST first tell it when to start noting the changes, and the way you do 
so is by LOCKING the Page Breaks and then any subsequent changes are put in as A-Pages, and/or
LOCKING the Scene Headings so any new scenes are put in as A-Scenes and any deleted ones are
kept as OMITTEDs.    Similarly, revision marks can be inserted/removed manually or automatically 
put in with the Auto-Revision Marks feature.

If you're in the middle of Production and are need help with revisions, go to Production Revisions - 
Trouble Shooting otherwise read the section The Production Revision Cycle.

Production Breakdowns - Movie Magic Screenwriter can produce amazingly useful Production 
Breakdowns too, including Breakdown Tagging and direct export to Movie Magic Scheduling!



Animation Production
Movie Magic Screenwriter has some great features designed specifically for Animation Production 
and they include:

Multiple (or Locked) Revision Marks
Printing Just Dialogue



Multiple Revision Marks
As most animation is being produced overseas, production companies are discovering that the usual 
multi-colored page identification of revisions does not work all that well when pages need to be faxed
to Korea or elsewhere.
To solve this problem, a multi-revision mark standard has been introduced whereby the first day's 
revisions are a single asterisk (*), the next day's are two (**) and so on.    Needless to say, Movie 
Magic Screenwriter handles this quite nicely.

It does this with a Revision Locking count which you increment by Locking the Revision Marks by 
going to the Format Menu and selecting Lock Current Rev. Marks.

If, after having locked the Revision Marks, you turn on Reveal Codes then the Locked Revision 
Marks will be displayed as [1],[2],[3], and [4] corresponding to the locking level. If, for some reason, 
you need to decrease a locking level, then simply go back to the Format Menu and select Unlock 
One Revision Mark Level and it will do so.



Printing Dialogue for Animation
Many animation production companies want print-outs of just dialogue with an incrementing number 
to the right of each speech.    With Movie Magic Screenwriter, all you need to do is select Dialogue on
the Print Menu, choose All Names or the name of the character you want, and check the Line 
Count Box and you're set!



Mandatory Keys

The following three keys are the ONLY special keys you have to know to write in Movie Magic 
Screenwriter:

· Tab Key will put in Character Names regardless of the element you are starting from...
· Enter Key will take you from one element type to another (ie pressing <ENTER> while in 

Character Name will take you to dialogue; while in Transition will take you to Scene Heading, 
etc).

· Left Parenthesis Key will put you in a Parenthetical while in Dialogue, or a Character 
Extension if pressed while in Character Name.
will put you in a Parenthetical while in Dialogue, or a Character Extension if pressed while in 
Character Name.

Everything else can be done by either just typing text and letting Screenwriter reformat it for you (eg 
type int. at the beginning of any blank line and Screenwriter will automatically reformat that as a 
Scene Heading) or by selecting options off the pull-down Menus

Control-Keys

The following keys are optional Quick Keys to speed up your inputting, but you can work perfectly 
fine without learning or using them as almost all of them have a Menu or Speed Button equivalent:

CTRL+ B - Will turn Bold on/off . 

CTRL+ C  - Pops up a List Menu of all Existing Character Names and types in whichever one is 
selected at the cursor position. 

CTRL+ E - Puts you into a Scene Heading with EXT. and a space already typed in for you. 

CTRL+ G - Pops up the Goto Page Menu.

CTRL+ I - Puts you into a Scene Heading with INT. and a space already typed in for you. 

CTRL+ L - Spell checks the preceding word. 

CTRL+ O - If you aren't in a Shot, then it puts you into one. If QuickType is on, then it will also 
automatically display a Pull-Down menu of Initial Shot Text, otherwise it won't.    However, if you're in 
a shot when you press CTRL+ O then it will pop up the Pull-Down menu of Initial Shot Text 
regardless of the state of QuickType. 

CTRL+ P - Pops up the PRINT Menu. 

CTRL+ R - Forces a repagination of your script.

CTRL+ S - If you aren't in a Scene Heading, then it puts you into one.
If QuickType is on and you aren't in a Scene Heading, then it will also automatically display a Pull-
Down menu of Initial Scene Heading Text, otherwise it won't.    
If you are in a completely blank Scene Heading, then regardless of the state of QuickType, hen you 
press <CTRL+ S> then it will pop up the Pull-Down menu of Initial Scene Heading Text. 
if you are in a Scene Heading with Initial Scene Heading Text but without a Location and you press 
<CTRL+ S> then it will pop up a List Menu of all existing locations in the script. 



If you are in a Scene Heading with Initial Scene Heading text and a Location and you press <CTRL+ 
S> then it will pop up a Pull-Down menu of Times-of-Day then put you into Action. 

CTRL+ T - If you aren't in a Transition, then it puts you into one.    If QuickType is on, then it will also 
automatically display a Pull-Down menu of Transitions, otherwise it won't.    However, regardless of 
the state of QuickType, if you press <CTRL+ T> while in a blank Transition then it will pop up the 
Pull-Down menu of Transitions. 

CTRL+ U - Will turn Underlining on/off.

CTRL+ Y - Will turn Italics on/off. 

CTRL+ ENTER - Puts you into Action. 

Shift ENTER - Puts in a Forced Page Break.

Shift Del - Cuts Selected Text. 

CTRL+ Ins - Copies Selected Text. 

Shift Ins - Pastes previously Cut Text.

CTRL+ - - Puts in a Soft-Hyphen. 

CTRL+ Shift - - Puts in a Hard-Dash. 

CTRL+ Shift ( - Puts in a "(" into Dialogue without making it a Parenthetical.

CTRL+ Alt Space -    Puts in a Hard Space

Function Keys
The following keys are optional function Keys which allow you to access features already accessible 
either through Pull-Down menus or other keystrokes.      

F1 - Pops up the HELP Menu 

F2 - Pops up the Search for Text box

Alt F2 - Pops up the Search/Replace Text box

Shift F2 - Continues the last Search or Search/Replace 

F3 - Pops up the Cheat Element Menu 

Alt F3 - Turns Reveal Codes on/off    

F4 - Drops down the Switch Element Menu 

Alt F4 - Exits Movie Magic Screenwriter 

Ctrl+ F4 - Closes Current script

F5 - Pops up the Thesaurus 

F6 - Turns Bold on/off 



Ctrl+ F6 - Switches between open Scripts 

Shift F6 - Centers current element (changes to Title Element)

F7 - Saves the script without prompting

F8 - Turns Underline on/off

F9 - Turns Italics on/off 

F10 - Pops up the Save As Menu

F12 - Instantly capitalizes the preceding word 

Ctrl+ F12 - Instantly capitalizes & bolds the preceding word

Alt F12 - Instantly lower-cases the preceding word

Movie Magic Screenwriter Files
The files with two asterisks (**) MUST be in the Movie Magic Screenwriter Program directory for the 
program to run correctly, the ones without may be deleted if you're extremely short on disk space 
though we don't recommend it.

bugslay.dll** - Problem Resolution Utility

configwz.exe - The Configuration Wizard Program

dictfile.spl - The Screenwriter Dictionary

dictfile.sup - Supplementary User Dictionary

findfile.exe - A utility to find files on your computer

scrthing.krs** - Program Resource File

wrspack.dll - Dictionary Dynamic Link Library

wrspack32.dll - 32 bit Dictionary Dynamic Link Library

dictedit.exe - User Dictionary Editor

thes.dic - Screenwriter Thesaurus

winthing.exe** - The Movie Magic Screenwriter Executable

winthing.hlp - The Online Help File

winthing.sys** - Program Resource File

winthing.wv** - Program Resource File

????????.ini** - Script Format Definition Files

The following files may be in your Script Subdirectory (C:\SCRIPTS by default):



*.scr - Your scripts

*.bk - Previously saved versions of your scripts

*.tmb - Timed Backups



Configuration Wizard - Aaahhh! Page
In the immortal words of Douglas Adams, "Don't Panic."



About... Menu
This Menu is found under the Help Menu on the Main Menu bar and displays the current Version 
Number, plus the registered owner's Name and Serial Number in addition to listing the people who 
helped make Movie Magic Screenwriter a reality.



Accented Characters
Screenwriter makes entering accented letters (such as the "é" in café) utterly 
painless by allowing you to "build" the letters rather than force you to enter 
them numerically.

The general rule is that to enter an accented letter, press [CTRL]+the Accent (or closest keyboard 
equivalent), then release them both, and press the letter you want accented.    Thus for the "é" you'd 
first press [CTRL]+ Apostrophe, release them both, then press the letter "e."    

The following is a list of all the Accent equivalents:

For the Accent Aigue:
This is the accent over the "e" in "café", press [CTRL]+the Apostrophe followed by the letter you 
want accented. 

For the Accent Grave:
This is the accent over the "a" in "à la mode", press [CTRL]+the Left Apostrophe --which is typically
found under the '~' on most keyboards and looks like "`" -- followed by the letter you want accented. 

For the Circumflex:
This is the accent over the "e" in "moi-même", press [CTRL]+[SHIFT]+[6] -- [SHIFT]+[6] being the 
key for "^" -- followed by the letter you want accented. 

For the Umlaut
This is the diacritical mark over the "e" in "Noël,"    press [CTRL]+ the Colon -- that's the one with the
two dots (':') for those of you who are typologically challenged -- followed by the letter you want 
accented. 

For the Tilde
The accent over the 'n' in "mañana" - press [CTRL]+the Tilde -- that is [CTRL]+[~] -- followed by the 
letter you want accented.

For the Cedilla
Which is the accented "c" in "garçon", press [CTRL]+the Comma and then either a small or capital 
"c".



Activity Selection Menu
You get to this Menu by pressing <ENTER> in a blank element while in a multimedia format script.    
It has three buttons on it:

· [User Activity Wizard] - click this button to pop-up the User Activity Wizard which will help walk 
you through the creation of a User Activity (ie, if the User does this then...)

· [Create Branch Point] - click this button to pop-up the Branch Point Menu to enable you to 
create a branch point.

· [Create New Branch Target] - click this button to create a new Branch Target at the cursor 
position.



Add Forced Page Break Menu
You will ONLY see this menu if you try and add a forced page break in a 
locked script.

· Forced Page Break (Act Break) - if selected, then it will put in a Forced Page break which will 
be numbered normally and will be treated as an Act Break, meaning that it will NOT print Top or 
Bottom Continueds around this page break

· Locked Page Break (Normal Numbering) - if selected, then it will put in a Locked Page break 
which will be numbered normally just as if it had been a soft page break that was "locked" by 
selecting Locked Page Breaks on the Edit Script Formats Menu

NOTE: Either of the above options WILL cause any subsequent pages to be renumbered 
accordingly!

· Fixed A-Page (A-Page Numbering) - if selected, then it will put in a Fixed A-Page which will be 
numbered as an A-Page (or B-Page or so on) and will only affect the numbering of any 
immediately following A-Pages

· Multi-Locked Page Break (Locked A-Page) - this option will only be available in scripts with 
Multi-Locked Pages and this page break will be numbered as an A-Page (or B-Page or so on) 
and will only affect the numbering of any immediately following A-Pages -- the only difference 
between this and the previous option is that if you later choose to Flex A-Pages then this Multi-
Locked Page Break will not be affected



Alias Auto-Recognition Text Menu
You get to this menu by pressing the [ALIAS] Button next to any User List 
Item on the Edit User List Menu.

· Alias Auto-Recognition Text - this is where you type in the Alias Text that you want to use 
for that User List Item

You will ONLY see the following options if you're setting up Alias Text for the Substitution Text User 
List!

· Auto - when checked Movie Magic Screenwriter will match the replacement text to the 
capitalization of the Alias text that you just typed--thus if "na" is the Alias Text for "National 
Armory" and you type "na" it will expand to "national armory," type "Na" and it will expand to 
"National Armory", type "NA" and it will expand to "NATIONAL ARMORY"

· As Entered - when checked, then when Movie Magic Screenwriter expands the Alias Text, it 
will always expand it to exactly match the capitalization that you'd actually typed in the 
Substitution Text unless you're in an element defined as all caps in which case it too will be 
all caps

· All Caps - when checked, then this text will always be expanded to all caps regardless of 
what you type in



Print Menu - Setup Animation Dialogue Page
This menu    is gotten to by going to the Print Menu, then clicking on the Setup
Menu bar at the top of the menu, and selecting Animation Dialogue.

The options selected on this page will be used when you select Dialogue on the Print Menu and 
check the box "Numbered for Animation."    It allows you to easily change the printed layout of the 
speeches for recording scripts without affecting the script itself.

Speech Numbering - this option specifies where the sequential number for each speech should be 
printed

· On Right Margin
· On Left Margin

Character Name Position - this option specifies where the Character Name for each speech should 
be printed in relationship to the dialogue.

· Above Dialogue
· To Left of Dialogue

Dialogue Spacing - this option specifies what line spacing it should use when printing the Dialogue.

· Use Spacing in Script
· Use Double Spacing

Dialogue Capitalization - this option specifies what capitalization it should use when printing the 
Dialogue.

· Use Capitalization in Script
· Always Capitalize Dialogue

Blank Lines before Printed Speeches - lets you specify how many blank lines should be put 
between each printed speech.

· Use the Normal Character Name "Blank Lines Before"
· Set to ?? Blank Lines (and you can enter in any value between 1 and 5)

Substitute Font - allows you to choose a different font for use solely in printing the recording script.

Print Script Notes - allows you to choose whether or not it should print Script Notes along with the 
Dialogue.

NOTE: The following three options will only be available if you've checked Print Script Notes.

Only when directly before selected Dialogue - when checked, then it will only print Script Notes 
which are directly before any Dialogue that is printed.

Print Notes Directly Above Speeches - if checked then it will print the script notes on the line 
immediately above the character name, otherwise it will use the line spacing set in Blank Lines 
before Printed Speeches.

Print Boxes Around Notes - allows you to turn on/off the normal Script Note Boxes.





Automated Revision Draft Colors
Each Production Script typically goes through a standard set of Revision 
Draft Colors.    Movie Magic Screenwriter can completely automate this and 
even display the colors on-screen to facilitate editing.

To Setup the Order of Revision Draft Colors:

NOTE: A) If you want to set the order for ALL NEW SCRIPTS, you can do the following in either an 
existing script or a completely blank one; B) Since you can only set the Revision Draft Colors in a 
Locked Script, either open a locked script and skip to instruction 4 below, or just follow the 
instructions normally.

1 Open the script for which to set the Revision colors
2 Click on the PRODUCTION Menu, and select LOCK THE SCRIPT if it's not LOCKED already.    

Type YES at the prompt that appears.
3 On the LOCK THE SCRIPT Menu that appears, make any changes as desired then press OK.
4 Click on the PRODUCTION Menu, and select SET REVISION DRAFT COLOR.    Make any 

changes to the color list on the SETUP REVISION DRAFT COLOR ORDER Menu    that 
appears.

5 If you want these Revision Draft Colors settings used for all new scripts, then check the Box 
SET AS DEFAULTS FOR ALL NEW SCRIPTS before pressing OK.

To Automatically Display the Revision Draft Color in the Header

1 Open the script in question
2 Click on the FILE Menu, then HEADER SETUP.
3 Position the cursor on the Header Line where you want the Revision Draft Color to be placed.
4 Either click on the    [REV.COLOR] button or manually type in "~", it makes no difference.    "~" is

the code which the program uses to automatically insert the Revision Draft Color.    If it prompts 
you about the insertion of this code, say YES.

5 Press OK to accept the changes.
To turn on or off the display of    Revision Draft Colors on-screen

1 Open the script in which you're doing revisions.    It MUST be a locked script, or you must lock it
before proceeding.

2 Click on the PRODUCTION Menu, and select SET REVISION DRAFT COLOR.    On that menu,
either check or uncheck the box DISPLAY PAGE COLORS ON SCREEN as desired.

NOTE: A) This display setting is used for ALL Scripts, not just this one, but we put it here for ease 
off accessibility;    B) You can modify how the Revision Draft Colors display simply by selecting any 
Revision Draft Color and then clicking the [SET PAGE DISPLAY COLOR] button and choosing a 
different color from the menu that appears.

    3      Press OK to accept the changes.

To Increment the Revision Draft Color

With each revision, you need to "increment" the Revision Draft Color to the next one on the list.    This
can be done "automatically" by..



1 Clicking on the PRODUCTION Menu and selecting START NEXT REVISION.    Type YES at the
prompt that appears, and it will do all preparation for the next revision, including incrementing 
the Revision Draft Color.

It can also be done "manually" by...

1 First removing all current revision marks by clicking PRODUCTION, then REMOVE, then ALL 
CURRENT REV. MARKS and typing YES at the prompt.

2 Next, you need to fix the A-Pages by clicking PRODUCTION, then FIX or FLEX..., then FIX ALL
A-PAGES.

3 Finally, click on the PRODUCTION Menu, then select SET REVISION DRAFT COLOR.
4 On that menu, select whichever color you want to be the current Revision Draft Color and click 

OK
To Print all the pages in any one Revision Draft Color

Doing so requires that you used the automatic Revision Draft Colors, but if that's the case, then it's 
very simple.

1 Click FILE, then PRINT
2 On the PRINT Menu, where it previously said ASTERISKED PGS, there will now be a Drop-

Down List with all Revision Draft Colors in the List.    Select the one you want and press OK.



Automatic Atmosphere Setup Screen
You can designate any location as always having "atmosphere" (or "extras" or whatever text you 
prefer) and whenever a scene takes place in a location which is tagged as always having 
atmosphere, the automatic character list generation function will add the selected atmosphere text at 
the end of the character list.

The first List Box on the screen contains any locations which are in the Scene Body Text User List -- 
if this is empty or the location which you want is not listed then click the [Edit Locations List] Button 
found below it.

· Atmosphere Text - this is the text which will be inserted automatically for you.    It is typically 
either "Atmosphere" or "Extras" or something of that nature.

· [Edit Location List] -    press this button to be taken directly to the Edit User List Menu where 
you can add/delete or otherwise edit locations on the Scene Body User List

· [Return to Normal Options] - takes you back to the Scene Character List Generation Menu



Auto-Revision Marks
Movie Magic Screenwriter has the ability to automatically add Revision Marks whenever you 
add/delete or change text in your script.    This is designed specifically for use when you're in 
production, but can also be quite useful if you are writing with a partner and are sending drafts back 
and forth.

It is turned on or off by going to the Format Menu and selecting the Auto-Revision Marks Menu item.  
When it is on, there is a checkmark next to the menu item, otherwise there isn't.



The Bookmarks Menu
Screenwriter's Bookmark Menu is accessed by going to the GOTO Menu, and 
selecting Bookmarks.

The Bookmark Menu allows you to save up to 15 bookmarks in any given script, and let you instantly
move to any saved position.

The Bookmark Menu has two main windows on it -- the Top Edit Window where you can name the 
bookmark.    Whenever you access the Bookmark Menu, the Top Edit Window will contain the first 25 
letters of whatever element you're currently in as a reference name.    

To Set a Bookmark - while at the position in the script where you wish to set a bookmark, go to the 
Bookmark Menu and edit the name in the Top Edit Window if desired and then press the [SET] 
button.

To Goto a Previously Set Bookmark - go to the Bookmark Menu and select the previously set 
bookmark from the Bookmark list Window and then either double-click on it, or click the [GOTO] 
button.

NOTE: Due to editing, it is possible that a previously saved and listed bookmark will no longer exists
in the script, if so, it will give you a message telling you that this is the case.

To Delete a Previously Set Bookmark - go to the Bookmark Menu and select the previously set 
bookmark from the Bookmark list Window and then click the [DELETE] Button.

The Bookmark Menu is a floating Menu that you can leave visible if desired to allow for easier 
access... thus it has two additional buttons at the bottom:

[CLOSE] - will close the Bookmark Menu, forcing you to go back to the redisplay it the next time you 
wish to use a bookmark.

[MINIMIZE] - will minimize the Bookmark Menu, allowing you to simply click on the minimized icon to 
restore it for easier access.



Branch Point Menu
The Menu is designed to allow you to painlessly build Branch Points in the 
Multimedia Script Format.

This Menu is only available when you're in the multimedia format, and it can be gotten to by pressing
[ENTER] on any blank Action Line and then selecting Create Branch Point, or by clicking on the 
Speed Button on the right speed bar with the picture of a branching tree on it.

This Menu has two list boxes (columns) on it.    The one on the left contains all the Available Branch
Targets that are in the script, the one on the right contains the Branch Targets that are available in 
this particular Branch Point.    

To move Branch Targets from one column to the other, you can Drag'n'Drop them or simply 
double-click on any Branch Target and it will move to whatever column it's not currently in.    You can 
also highlight several Branch Targets by holding down the shift key when selecting them and use any
of the arrow buttons to move them from one column to the other.

The Arrow Buttons are four buttons between the two columns.    They do the following:

· [>] will move any selected Branch Targets from the Available List (left) to the Current Branch 
Point (right).

· [>>] will move ALL Branch Targets from the Available List (left) to the Current Branch Point 
(right).

· [<] will move any selected Branch Targets from the Current Branch Point (right) back to the 
Available List (left).

· [<<] will move ALL Branch Targets from the Current Branch Point (right) back to the Available
List (left).

There are also five Buttons underneath the two columns:

· [Build the Branch Point] which will return you to the script with the branch point built with 
the Branch Targets that are in the Current Branch Point list.

· [Build the and Perform Branch Point] which will build the Branch Point with the Branch 
Targets that are in the Current Branch Point list and then perform the branch, taking you to 
the currently highlighted Branch Point.

· [Create New Branch Target] will prompt you for the text of the new branch point, then create
it in the script for you, number it automatically and then put it into the Current Branch Point 
list.

· [Cancel] will abort the creation/editing of this Branch Point.
· [Help] will display this very menu.



Breakdown Sheet Editor
This Menu is found under Breakdowns on the Production Menu, and is 
recommended to be used AFTER you've made a pass with the Breakdown 
Tagging function.

This menu shows you a graphic representation of the breakdown sheet filled out with all the tagged 
items and auto-identified information (such as characters).

You can re-categorize tagged items simply by dragging them from one box to another, and it will 
automatically change the tags for that item within the script.

You can UNTAG any items simply by highlighting them and clicking the DELETE key.

NOTE:    If the item to be untagged is in a Script Note then it will actually delete the item, otherwise it
will just remove the tagging codes, or put in an ignore flag in the case of a character name which 
was erroneously picked up in action.

You can EDIT any tagged items by highlighting them and double-clicking, though you should be 
aware that any edits you make will be made to the actual text of the script itself!

You can ADD new items by double clicking in a blank space within any category box and typing in 
the new item.    The new item will be tagged according to the main heading of the box, and it will be 
put into a Script Note right under the Scene Heading.    If there is no such script note, it will create 
one.

You can ADD/EDIT the Scene's Description simply by clicking on the [Scene Description] button to
the right of the Scene Heading.    It will also be put in the Script Note following the Scene Heading.

You can CHANGE any box's CATEGORY TEXT simply by double clicking on the category text and 
then editing it as desired.



Breakdown Sheet Layout Screen
On this screen you can change the category headings for each of the boxes 
on the Breakdown Sheets and/or move listed categories from one box to 
another simply by dragging and dropping them.

You can get to the Breakdown Sheet Layout Screen one of two different ways:

· Go to the Edit Menu, choose Breakdown Tagging, then Edit Categories then Setup 
Breakdown Sheets

· Go to the File Menu, select Print, select Production Breakdowns and click OK, select Script 
Breakdown Sheets and click OK, then click Setup Breakdown Sheets

Once on this menu, you will see a graphic representation of the breakdown sheet.    Because there 
are more categories than boxes available, Screenwriter will combine related categories into the 
appropriate boxes for you.    If you have renamed categories or changed the headings on any of the 
boxes, you may need to drag categories from one box to another to "clean" these sheets up.

After you've used the Breakdown Tagging Function to identify all the elements in the scrip, you can 
actually edit the text that will be put on any individual breakdown sheet by going to the Breakdown 
Sheet Editor.



Breakdown Tagging Function
The Breakdown Tagging Function allows you to Tag text within the script as being of a certain 
category (prop, sound effect, costume, etc.) and it can then use those tags to print out Script 
Breakdown Sheets or Export to Movie Magic Scheduling.

To turn on the Breakdown Tagging Mode:

· Go to the EDIT Menu and select Breakdown Tagging then Tagging Mode,
You will then be in a Tagging Mode -- and the top heading of the program will change to reflect that --
and in this mode, whenever you highlight text it as soon as you release the mouse or cursor, it will 
automatically prompt you with a list of categories.    Simply select the category which you want the 
highlighted text to be tagged as, and the program will insert the appropriate tagging codes for you.

On the Breakdown Tagging submenu, there are also four other options:

· Edit Categories - which will take you to the Edit Breakdown Categories Menu where you can 
change the names and or code display for most categories.

· Tag Items Globally - which will take you a menu where you can enter the text that you wish to 
be tagged (for example, GUN) specify category for which it should be tagged (such as PROPS) 
and press OK.    It will then search through the entire script and tag each instance of GUN in 
Action, Script Notes, and Shots as a PROP for you.

· Untag all Items - this will remove ALL tag codes from the script.
· Movie Magic Scheduling Export - this take you directly to the Movie Magic Scheduling Export 

Screen without having to go through the Print Menu first.



Changing Note Colors
You can have up to 25 different colors of Script Notes, assigning them to 
different categories or different people (if you're in development or production
or working with a partner, etc.) as desired.

To change the Note Color for All NEW Notes

1 Go to the Format Menu
2 Select Edit Script Formats
3 Click the    [Script Notes] Button on the right hand side of the page
4 Click the panel labeled "CLICK HERE TO SET NOTE COLOR"
5 Select a color as desired and press [OK] to accept it
6 Press [OK] to close the Edit Script Formats Menu.    It will prompt you "Should I convert all 

Notes that are in the Current Script Note Color to the New Script Note Color" - select [NO] to 
keep the existing color of all Notes that are already in the script, select [YES] to convert the 
color of all Notes that are in the script in the previous default color to the new color.

To change the Note Color for ONE SPECIFIC Note

1 Put the Cursor anywhere in the Script Note whose color you wish to change
2 Select the Format Menu
3 Select Cheat
4 Select Element
5 Click the button "Cheat Script Note Color"
6 Select the New Note Color as Desired
7 Click [OK] to accept the changes

NOTE: If you have your screen set to display 256 colors or fewer, then the program actually will only
have 16 background colors available to it, and the display of Script Notes may look somewhat odd.   
To increase your Screen Colors, go to the CONTROL PANEL, click DISPLAY and change your 
settings there.



Cheat Element
This menu allows you to cheat any or all of the formats of the current element.

You get to this menu by either clicking on the [Cheat] Button or clicking on the FORMAT Menu, 
selecting CHEAT then ELEMENT.

Once here, you can cheat the current element's:

· Line Spacing in 1/10ths of a line (both lines before and interline)
· Left & Right Margins in 1/10ths of an inch
· Text Style (Bold, Italics, Underlined, All Caps)
· Font
· Scene Number (if it's a Scene Heading)
· Character Continued (if it's a Character Name)

Use this powerful feature wisely.

NOTE:    You can also cheat the Left & Right Margins with the Ruler Bar, or cheat the Right Margin 
by pressing <CTRL+ALT+PLUS> to increase it by 1/10th or <CTRL+ALT+MINUS> to decrease it by
1/10th.



Cheat Sub-Menu
These are the options found under Cheat on the Format Menu:

· Element - which allows you to cheat margins, line spacing, text style and other element specific 
options

· Page - which will take you to a menu where you can cheat the length of just the one page that 
the cursor is on

· Script - which will take you to the Page Layout Menu to allow you to cheat the Text Line Spacing
and Blank Line Spacing, thus invisibly changing the length of the script

· Keep Element Together - which will tell the program not to break the current element over a 
page break

· Keep Group Together - which will tell the program not to break the current group (e.g. a 
Character Name and any parentheticals and dialogue following it) over a page break

· Keep With Following - which will tell the program not to put a page    break between this 
element and the one that it is following

· Mark as Non-Printing - this will mark either the current element or any currently blocked 
elements as Non-Printing.    They will display on screen grayed out with a strikeout through them 
and they will neither print nor take up any space in the script.    It is equivalent to deleting the text,
but the text is still on-screen in case you want to restore or edit it later.



Cheat the Page Menu
This Menu is gotten to by selecting the Format Menu, then Cheat and Page.

· Increase by... - if checked, then Movie Magic Screenwriter will micro-increment everything 
on this page upwards to add the specified number of lines on the page, thus in effect making 
the page longer

· Decrease by... - if checked, then Movie Magic Screenwriter will micro-increment everything 
on this page downwards to remove the specified number of lines on the page, thus in effect 
making the page shorter

· # lines - the number of lines to increase or decrease the page's length by...



Configuration Wizard - Backups Page
What you're setting here is whether Movie Magic Screenwriter should automatically prompt you 
to insert a floppy disk every time you actually close a file that you have in any way edited.    This is a 
VERY good thing as it is a wonderful way to make sure that you always have an up-to-date backup 
of all your scripts on floppy disks.

The very best way to ensure that you never lose any material is to always have your scripts in at 
least two completely separate places, like your hard disk and a floppy.    And this is the least painful 
way to do it.    Choose I'll Live Dangerously at your own peril...

Use the A Drive or Use the B Drive means that when you modify a script and close it, it will prompt 
you to insert a floppy into the drive you've specified here to make a backup of the file to.

I'll live dangerously means exactly that.    It will not automatically prompt you to backup ever though
if you go to the SAVE AS menu you can tell it to do so at that time.



Configuration Wizard - Buttons Page
What you're setting here is how the Main Movie Magic Screenwriter screen will look, whether 
the right scroll bar is the only thing on the right side of the screen or if it should only go only 
half way with the top half having buttons for Element input instead.       

These buttons mean that you can add any element to your script via clicking on a button rather than 
using the normal keyboard input methods.    Admittedly this latter option is an extremely inefficient 
method of writing as it means you constantly have to go to the mouse to add text, however it can be 
useful when you're learning and just because the buttons are displayed, it doesn't mean you have to 
use them as having them displayed doesn't disable any of the normal keyboard input.    Simply put, it 
ain't an either-or situation.    

If you DO choose to have them displayed these are the buttons you'll get:

                [C]      -    Character Name
                [D]      -    Dialogue
                [P]      -    Parenthetical)
                [A]  -    Action
                [T]  -    Transition
                [Sc] -    Scene Heading
                [Sh] -    Shot
                [Musical Note] -    Script Note

What you're setting here is whether the Top Speed Bar is displayed or not.    As you can 
(barely) see in the lovely graphic below, the Top Speed Bar offers you button access to a wide
range of functions and we    highly recommend you select Yes I've always liked Bars to enable
it.



Configuration Wizard - Bye Now Page
Neither ScriptPerfection Enterprises, the Configuration Wizard, nor Riff mean to construe this 
insidious image as in any way encouraging the imbibing of alcoholic beverages, and we've never 
seen this guy before in our lives...



Configuration Wizard - Display Page
What you are choosing here is what text Movie Magic Screenwriter will display on screen, 
though this in no way affects what it prints.    The options are:

True WYSIWYG - with this checked, you'll see all the Headers, Page Numbers, Top & Bottom 
Continueds and so on in all their glory with a correspondingly smaller amount of actual text on 
screen.    This is generally the suggested mode, as one of the great features of Windows is the 
concept of WYSIWYG, and this follows that idea.

More Text Visible on each screen -    with it checked, all those aforementioned features will still 
PRINT, but they won't be displayed on screen, thus giving you more of the editable text of the script 
visible at any one time.

What you're setting here is the size of the text on-screen and this does not affect the printing 
at all.    Also, due to the nature of video cards and screen resolution, the zooming of on-screen
text is sadly not a smooth curve--especially at lower resolutions like 640x480--and you may 
have to change several percentage points before you see any difference in size.

Zoom Size - is where you enter the value to change the size of the screen font in percentage points. 
You can go from 50% to 150% of its original size, and you should choose the smallest size you can 
comfortably view as that will afford you the most text on screen.



Configuration Wizard - Editing Page
What you're doing here is setting the level of "automation" that Movie Magic Screenwriter 
should provide you with.    Most writers prefer the most automation that they can get and as 
such, we recommend that you try the Automatic Spell Checking and select the Whole 
Shebang.

Automatic Spell Checking - This option turns on or off the real-time spell checking and 
autotypocorrection.    When you have it checked, Movie Magic Screenwriter will do the following:

· Correct letter inversion typos such as "teh" to "the" while you're typing.
· Automatically capitalize the first letter of all sentences in Dialogue, Action, and Script Notes.
· Ensures that every sentence has a consistent number of spaces (2) between it and the 

previous sentence.
· Beep when you type a word that the real-time spell check doesn't recognize.
· Support Alias Text and Substitution Text

Note: If you only want SOME of these options then go to the Spell Page of the Program Options 
Menu.

The second section on this menu allows you to configure QuickType™, Movie Magic 
Screenwriter' intuitive interface that allows it to "read your mind" and pop-up menus and put 
you into elements that you want without you having to ask for them.

There are several parts to the QuickType feature, and you can choose to use none, some or all of 
them as desired.

Whole Shebang enables the full power of QuickType, including the automatic display of pop-up 
menus with Initial Scene Heading Text, Times of Day and so on.When QuickType Entry is enabled, 
the QuickType chooses what menus to display (and when to display them) by using a hierarchy of 
elements that works as follows:

· If you type FADE IN: or any Transition then QuickType will display a Pop-Up Menu of Initial 
Scene Heading Text

· If you press <ENTER> while in a blank Action, Transition, Blank Scene Heading, Scene Info 
or End of Act then QuickType will display a Pop-Up Menu of Initial Scene Heading Text

· If you press <ENTER> while in Scene Heading without a Location then QuickType will 
display a List Menu of all the unique locations that are already anywhere in the script

· If you press <ENTER> while in a Scene Heading that already has a Location, then 
QuickType will display a Pull-Down Menu of common Times-of-Day

· If you select Initial Scene Heading Text from a Pop-Up Menu, then QuickType will 
automatically display the Pop-Up of Unique Locations and if you select one from that list, it 
will automatically display the list of common Times-of-Day

The Whole Shebang also enables SmartTab™, another unique feature of the program.    When you 
press the Tab Key followed by a letter, then Screenwriter will automatically highlight the last character
name that you entered which started with that letter.    

For example, let's say that you have MICHELLE, LARRY, LISA and LAURA in your script and this is 
a scene between LAURA and MICHELLE.    When you press <Tab L> the first time in this scene, the 
pull-down menu might have LARRY highlighted, so you'll type AU to move the highlight to LAURA 



and then press <ENTER> to have Screenwriter finish out the name for you.    

Without SmartTab enabled, you'll have to do exactly that each time you want LAURA.    

With SmartTab enabled, however, the next time you press <Tab L>, LAURA will automatically be 
highlighted for you so you simply have to press <ENTER>, saving you a whopping two keystrokes 
per name!

Some enables most of the QuickType features listed above except the automatic Pop-Up of Unique 
Location and Time-of-Day Menus, forcing you to press <ENTER> to display them.

None    - this option is (hopefully) fairly self-explanatory, meaning that none of the above listed 
QuickType features will be enabled.

Keep Settings As Is means that the Configuration Wizard will NOT change any of the current 
settings for QuickType, which can be configured even more extensively by actually going to Editing 
Page of the Program Options Menu.



Configuration Wizard - Format Page
What you are choosing here is which format Movie Magic Screenwriter will use when you hit 
the [New] Button to start a new, blank Script.    

Note that no matter what you choose here, you will always be able to access any of the other 
formats, and you can ALWAYS change a script from one format to the other as needed.    The four 
options are:

Screenplay Format, Stage Play, Sitcom Version I and    Sitcom Version II.

What you are choosing here is how Movie Magic Screenwriter should start up.    In other 
words, when you first start Screenwriter on any given day, it can do one of five things, and 
here is where you choose which one it does.    The options are:

Blank Script - pretty self-explanatory.    With this option checked, it, well, leaves you in a blank 
script...

Open Menu - with this option checked, when you start the program it will automatically display the 
Open Menu as if you'd selected Open from the File Menu, allowing you to select among the available
files or not as desired.

Full Screen File List - with this option checked, the area that is normally taken up with your script 
becomes one giant open file dialogue, displaying all the scripts in your script subdirectory and letting 
you choose the one you want with a simple double-click of the mouse.

Last Saved Script - automatically retrieves the last script you'd saved.

Restore Workspace - automatically restores the Workspace as you'd left it when you last exited 
Movie Magic Screenwriter.



Configuration Wizard - Mice Page
What you're setting here is how the Mouse handles Drag'n'Drop.

When you're Drag'n'Dropping text and you drop the text in the middle of an element, then the 
program can do one of two basic things.

No thanks, I can handle it and I want the control - If you have this option Screenwriter will insert 
this dropped text exactly at the place where you dropped it.    If they are the same element type (both 
Action, for instance) it will insert the text at the cursor position, joining the two elements together; if 
the dropped text is a different element type, it will break the element on which it was dropped and 
insert the dropped text between the two halves of the broken element.

Yes, please protect me from breaking up elements - If you have this option checked Screenwriter 
will put the dropped text before the element on which it was dropped, if it was dropped within the first 
half of the element, otherwise it will put in after the element on which it was dropped.    In neither 
case will it break the element on which the text was dropped.    This is a good choice if your mouse 
usage is on the slightly sloppy side, otherwise having the No, thanks... option checked does give you
more control.

What you're setting here is HOW the mouse selects text, whether it automatically extends the 
block selection by whole words or whether it selects it exactly letter by letter

Whole Words Please will mean that whenever you select text with the mouse it will automatically 
ensure that you do not ever select only part of a word.    The obvious drawback to this is a slight loss 
of control, but realistically, it is a fairly infrequent event that you'd want to block PART of a word and 
in that rare case you can always select text with SHIFT+ARROW keys which doesn't ever 
automatically extend the block for you.

One letter at a time, if you would will mean that the mouse selection will extend the block one letter
at a time, exactly as you move the mouse cursor.    The drawback to this is that it's easy to 
accidentally drop off letters at the beginning and ends of blocks.

NOTE: there is an additional option which you can only set on the Program Settings Menu's Mouse 
Page which allows you to specify whole words only but not for the FIRST word of the block 
selection.    This allows you to take the OUT in WITHOUT but all following words would be selected 
in their entirety.



Configuration Wizard - More Mice Page
What you're setting here is what should pop-up when you click the Right Mouse button 
anywhere in the script.

PowerPanel or Pop-Up Menu

This option lets you specify that when you click the Right Mouse button, you see our unique 
PowerPanel or if a more pop-up Menu should appear.    We highly recommend the PowerPanel as it 
offers a far easier item selection and more options than the pop-up menu. PowerPanel gives you 
access to the most common editing features with just a click of the Right Mouse button. You can 
select any of the buttons much easier than the traditional right mouse button Menus and the 
hierarchy of menus give you more options at your fingertips.



Configuration Wizard - Rulers Page
What you're setting here is whether every script starts with a Ruler displayed at the top of the 
screen.    This ruler has margin tabs that you can drag to cheat the margins of the element and
show its width in inches.    

However, with the rulers displayed you will see between 1 and 2 fewer lines of text on screen 
depending on the zoom level of the text size.    And as the only real use of the ruler is to cheat 
margins which one can also do by clicking on the [Cheat] Button on the Top Speed Bar, or by 
pressing <CTRL-ALT-PLUS> or <CTRL-ALT-MINUS> I'm not convinced it's worth the sacrifice, but of
course that's up to you.



Configuration Wizard - Saving Page



Configuration Wizard - Text Entry Page
What you are choosing here is setting what Movie Magic Screenwriter will do when you press 
[TAB] in Dialogue.

NOTE: no matter what you choose here, you will always be able to access any of the other formats,
you'll just may have to press an extra key in certain circumstances.

If you select Tab should ALWAYS put me into a Character Name then whenever you press [TAB]--
regardless of what what element you're currently in--it will take you directly to a Character Name, 
ready for input with one keystroke.    To put in a Parenthetical with this option selected, you'd merely 
press the Left Parenthesis "(" while in Dialogue.

If you select Tab in Dialogue should put me in a Parenthetical instead then whenever you press 
[TAB] in any element other than Dialogue it will take you directly to a Character Name, ready for 
input with one keystroke.    However, if you're currently in Dialogue when you press [TAB], it will 
instead take you to a parenthetical.    If at that point you want a Character Name rather than the 
Parenthetical, you'll have to press [TAB] a second time.

What you are choosing here is setting what Movie Magic Screenwriter will do when you press 
[ENTER] in Dialogue.

NOTE: no matter what you choose here, you will always be able to access any of the other formats,
you'll just may have to press an extra key in certain circumstances.

If you select Enter in Dialogue should take me to Action then when you are in Dialogue and press 
[ENTER] it will take you directly to an Action Element, breaking up the Dialogue if appropriate.

If you select Enter in Dialogue should take me to Character Name then when you are in Dialogue 
and press [ENTER] it will take you directly to a Character Name rather than Action, just as if you'd 
pressed [TAB].    To go to Action from here, you could press [ENTER] a second time or you can 
always press [CTRL+ENTER] to go directly to Action regardless of the current element type.



Configuration Wizard - Timed Backups Page
What you're doing here is setting how frequently Movie Magic Screenwriter will do a timed 
backup.

Movie Magic Screenwriter has a timed backup function that will make a Temporary Timed Backup of 
your script at the time interval you specify if you've made any changes to it since you'd saved it last.   

If you set this value to 0 or anything greater than 60 minutes, it will be changed to 60 minutes when 
you exit this menu.

NOTE:    This timed backup DOES NOT OVERWRITE your script on the hard drive and you MUST 
choose to save your script when you exit if you want to keep the changes you've made!    The Timed
Backup is designed to protect you against power failures, computer lock-up and the like.    It is NOT 
a useful back-up to protect you against hard disk problems because (1) there is only one timed 
back-up per document, so if you are working with more than one script then it will only contain the 
latest script you've been working on; and (2) because it is also on the hard drive and if you have 
hard drive problems it will also be affected.

MAKE REAL BACK-UPS ON FLOPPY DISKS!



Configuration Wizard
Movie Magic Screenwriter' Configuration Wizard is a helpful fellow who'll walk you through choosing 
among the most common features available for how the program functions.

To run the Configuration Wizard:    Simply go to the Help Menu and select Configuration Wizard 
and he'll be run automatically for you.

There are twelve pages on the Configuration Wizard and you can select among them by either 
pressing the Next or Prev PushButtons or by clicking on any of the tabs at the bottom of each page.  
They are:

Aaahhh!
Format
Display
Editing

Text Entry
Buttons
Rulers
Mice

More Mice
Saving

Backups
Timed Backups

Bye Now



Copy Protection
Movie Magic Screenwriter is copy protected, but it is done so in a way that with normal usage 
you shouldn't even notice it.    The installation diskette(s) will allow you to install Screenwriter 
three times, though you are ONLY LICENSED to run it on ONE computer at any one given 
time.

Once Movie Magic Screenwriter is loaded onto your hard drive, you can back-up your hard drive, 
optimize, defragment or do any other normal hard disk maintenance without affecting Movie Magic 
Screenwriter.    You can even backup the Movie Magic Screenwriter program directory and in the 
case of minor hard disk trouble, you can copy back these files onto THAT SAME HARD DIRECTORY
and they should run fine.    You can even copy the installation diskette with DISKCOPY and in the 
case of floppy failure, we can validate this diskette over the phone.

Basically the ONLY thing you cannot do without causing problems is moving or renaming the Movie 
Magic Screenwriter Subdirectory.    If you want to do EITHER of these things, then you MUST 
Uninstall the Program before doing them, and then reinstall it!

If you have a VALID reason for needing more installations you can call our tech support number for a
password.    Make sure you have your original installation disks and User Serial Number when you 
call, and are at a computer.    You can find your Serial Number on the back of the manual, or on the 
About... menu found under the HELP menu if you entered the Registration Information when you 
originally installed Screenwriter.

You are solely licensed to load Screenwriter for YOUR OWN PERSONAL USE and you MAY 
NOT give away, sell, or in any way distribute installations or disk(s) to other people.    If you 
have received both sizes of disks, you are still only licensed to load Screenwriter for your 
OWN PERSONAL USE and you MAY NOT give away, sell, or in any way distribute installations
or disk(s) to other people.

A Note to LAN Users: Although Movie Magic Screenwriter will load happily onto a LAN, it can only 
be run from one computer at any time, otherwise it will give you a copy protection violation error 
message.    If you need multiple installations to "validate" a number of work stations, you need to 
buy a site license which will give you a discounted rate for the additional installations.    Please call 
us at 619-270-7515 for site license pricing information.



Copy Protection Revalidation Menu
You have two options at this point:

· Call us at 619-270-7515 from this screen with your serial number handy and we can 
revalidate the installation over the phone if you have no more left on your installation diskette

· Insert the Installation diskette into Drive A: or Drive B:, select the appropriate drive letter and 
press the [USE UP A CREDIT FROM THE KEY DISK] button and it will do just that--
revalidate the copy protection on this installation and use up one installation credit.



Copy Protection Violation Menu
Movie Magic Screenwriter' Copy Protection has been violated -- this is most likely due to one of the 
following things:

· Copying the Program from one computer to another rather than installing it correctly from the 
installation disks

· Moving/Renaming the Movie Magic Screenwriter' program subdirectory
· Restoring the entire program (including the subdirectory) from a tape backup

To run just this session without using up any more installations: put your original Installation 
disk into the A:\ or B:\ drive, select the appropriate drive letter and click the [USE KEY DISK] Button.

To revalidate the installation on the hard drive: click the [REVALIDATE] Button.



Edit Breakdown Categories Menu
If you're Tagging Items for Breakdowns, then you can edit the category names and/or code display 
for each category to customize the breakdowns for the particular show that you're working on.

NOTE: If you're going to export the breakdowns to Movie Magic Scheduling, changing the category 
names will NOT affect how Screenwriter exports the breakdowns, as Movie Magic Scheduling 
cannot handle any categories other than its default ones.

To edit the categories or codes:

· Get to the Editing menu by selecting Edit , then Breakdown Tagging then Edit Categories
In the center of this menu, there is a list of all the available Categories and you can edit the Category
Name or how its codes will display in the script by simply double-clicking on the Category which 
you'd like to edit.

NOTE: You cannot edit either the Cast Members or Scene Description categories.

There are also three other buttons on this menu:

· Hide/Show Selected Category - which will turn on/off the selected category's display in the 
automatic pop-up Menu in Breakdown Tagging Mode.    "Invisible Categories" will be displayed in 
gray on this screen.

· Setup Breakdown Sheet - which will take you to the Breakdown Sheet Layout Screen so you 
can adjust how it will print the internally generated Breakdown Sheets.

· Reset to Defaults for Movie Magic Scheduling - Movie Magic Scheduling is a Scheduling 
Software program produced by Screenplay Systems, Inc. and clicking this button will set the 
categories to the default categories which Movie Magic Scheduling uses.



Edit Script Formats Menu - Act Information Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There are four additional options for Act Information...

· (Put Act Info in Parentheses) - turns on/off parentheticals around Act Information
· Center Act Info - If this is checked, then Act information will be centered within the set 

Margeins, if this is not checked, then Act Information will be flush left against its defined left-
hand margin

· Starting Number - allows you to change which number the Act Information starts on
· Numbering Scheme - allows you to choose how Act Information should be "numbered"...

· Act A - Use letters A-Z (skipping those specified in the Locked Letter Skip List found on 
the Locked Scripts Page of this menu)

· Act 1 (Numbers) - Use numbers 1-20
· Act One (Words) - Use numbers written out "One"-"Twenty"
· Act I (Roman) - Use Roman Numerals I - XX



Edit Script Formats Menu - Margins & Text Styles
The following options are available for all 11 element types:

Left is the left Margin of the element measured in inches from the left edge of the page, thus a value 
of 3.5 would mean that the element would start 3½ inches from the left edge of the Page.

Right is the right Margin of the element measured in inches from the right edge of the page, thus a 
value of 1.0 would mean that text could extend up to an inch from the Right hand side of the page.

NOTE: Both the Binding Margin value and the option Allow Words that are more than five letters 
long to extend 1 or 2 letters past the normal right-hand margin can affect the actual printed 
margins.

Line Spacing is in units of lines thus 1.0 is single spaced, 2.0 is double spaced and so on.    The 
Lines Before value sets the spacing before the element, Interline sets the spacing within the 
element.

Checking All Capitals forces all the text in that element type to become all capitals, checking Bold, 
Italicized or Underlined means that each element of the specified type will start with that Text Style, 
but the user can also turn it off midway like any other text style if desired.

Clicking the [Font] button will allow the user to select from all the truetype fonts available to Windows.



Edit Script Formats Menu - Action Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There are two additional options for Action...

· (Put Action in Parentheses) which, if checked, will do just that.
· Outdent Action will only be available if Put Action in Parentheses is checked, otherwise it 

will be grayed out and unselectable.    If it is accessible and you check it, then the left 
parenthesis will be outdented one space so that the text of the action element word-wraps 
under the first letter, otherwise it will word-wrap under the left parenthesis itself.



Character Names Page - Edit Script Formats Menu
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
Character Names have many other options on this Menu:

· Center Character Names -- if checked then Character Names will be centered rather than 
put flush left to their normal left margin, this is not the industry standard and we highly 
recommend against it.

· Character Continueds As...
· No Automatic Character Continueds - if checked then it will won't automatically put in 

any sort of Continued when a Character speaks twice in a row in the same scene
· Extension - if checked then, where appropriate, it will automatically put the text specified

as the Cont'd Text (see below) immediately to the Right of and on the same line as the 
Character Name

· Parenthetical - if checked then, where appropriate, it will automatically put the text 
specified as the Cont'd Text (see below) below the Character Name in a parenthetical

· Only when Extensions Match means that for it to automatically put in a Character 
Continued, the same character has to speak twice in a row in the same scene with only 
Action between the two speeches and the Character Extensions (if any) have to match.    
This means that if you have TOM (V.O.) then TOM (speaking aloud) it will NOT make the 
second speech continued, otherwise if this is not checked, then it will.

· Continued Separator is the letter which should be used when Character Continueds are set 
as Parentheticals and there is an existing parenthetical following the Character Name.    In 
that case, it will separate the existing Parenthetical text with this character like 
"(continuing;aloud)"

· Cont'd Text - this is the actual text that will be used for the automatic continueds described 
immediately above.    This text is used only when a characters speech is NOT broken over a 
page break.

When a Character's speech IS broken over a page break, the following two options are applicable

· More Cont'd - this is the actual text that will be used to follow the Character Name when its 
dialogue continued from the previous page.

· More Text - this is the actual text that will be put immediately following the first half of any 
dialogue that is broken over a page break

NOTE: Do NOT put in parentheses in any of the three preceding items as Movie Magic 
Screenwriter will take care of them as needed.



Edit Script Formats Menu - Dialogue Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
Aside from the normal options for Margins, Line spacing and whatnot, there are no element specific 
options for Dialogue.



Edit Script Formats - Locked Scripts Page
NOTE: When you first access the Locked Scripts Page, the options Multi-Locked for both Scene 
Headings and Page Breaks will be grayed-out and unselectable as you can only Multi-Lock Pages 
and Scenes once they have already been locked already.

Both Scene Headings and Page Breaks have three options, and they mean fundamentally the same 
thing for both...

· Unlocked (Normal) - this is the usual state, where adding text    or deleting text or scene 
headings simply causes the numbering of any existing pages or scene headings to adjust 
accordingly.

· Locked - with Scene Headings or Page breaks locked, when you add or delete material, 
instead of having everything renumbered as it would be normally, the new element's are A-
Scenes or A-Pages as appropriate with all existing scenes and pages keeping their original 
numbers. Thus, with Locked Scene Headings, if you add a scene between Scenes 23 and 
24, the first one that's added will become 23A, the second one 23B and so on.

· Multi-Locked - Once you've locked your script and added/omitted text, you may be in the 
position of wanting to keep the new A-Numbering fixed and give any new scenes or pages 
yet a new unique number.    To do so, set the appropriate element to Multi-Locked.

With Multi-Locked Scene Numbers selected, any new scene added before an existing A-
Scene will get a number added to it, thus a scene added between scenes 13A and 13B will 
be numbered as 13A1, the next one as 13A2 and so on.    If you add a new scene between 
an existing A-Scene and a Normal Scene, such as adding one between 25B and 26, it will be 
put in as a normal A-Scene, in this case as 25C.    If a new scene is added between a normal 
scene and an A-Scene, such as adding one between 103 and 103A then it will be put in using
the Multi-Locked Character (set below) thus if the Multi-Locked Character is a dash it would 
be put in as 103-1.    The same is true for Pages.

NOTE: You can change this A-Numbering Scheme as described below in A-Scene Numbering 
Scheme.

· Scene Omitted Text - if you have Locked or Multi-Locked your Scene Headings then if you 
completely delete the text of a Scene Heading but leave in the Scene Heading itself, when 
you move the cursor to another element, Screenwriter will automatically put in the text you've
specified here into that blank Scene Heading.

· Omitted "Thru" Text - if you delete a series of Scenes in a script with locked Scenes then 
Screenwriter will produce a RUN of omitted Scenes that will look on-screen something like:

3     OMITTED:5       3
THRU      THRU
5       5
...but which will print without the ":5" text following the OMITTED which is there just for manual 
override control, that is to allow you to change the ending number of the run if you ever need to.

· Scene "And" Text - is the same idea as Scene Thru Text but is used in place of the THRU 
when only two scenes are Omitted.

· A-Scene Numbering Scheme - allows you to specify how A-Scene and A-Pages should be 
numbered:
· Normal - 1A - A-Letter follows the normal number
· Flipped - A1 - A-letter precedes the normal number
· Multi-Lock is 1A1 - Multi-Locked is number following A-Letter



· Multi-Lock is 1AA - Multi-Locked is letter following A-Letter
· You also have the option as to how Multi-Locked Scenes inserted between a normal Scene 

and an A-Scene (eg between 1 & 1A) are numbered:
· 1-A - Multi-Locked is number, a dash then following A-Letter
· 1AA - Multi-Locked is number, the following A-Letter and then a Multi-Locked Letter or 

Number
· A1 - Multi-Locked is the flipped normal number and A-Letter order

· Revision Mark Text - This field lets you specify how you want Screenwriter to print and 
display all Revision Marks for this script whether as an Asterisk " * " or any other letter or 
letters such as "(X)"

· Revision Mark Right Margin - this lets you specify the position for revision marks based on 
the distance from the right hand side of the page in tenths of an inch.    Thus if you put in a 
value of 10 then revision marks will print 1" from the right hand side of the page, a value of    
5 would have them print 1/2" and so on...

· Locked Letter Skip List - due to potential confusion between the letter "I" and the number 
"1", or the letter "O" and the number "0",    many production companies skip those letters, 
going straight from "H" to "J" and from "N" to "P".    Other companies also like to skip "E" and 
"F" because they look too much alike.

However, whatever letters you don't want to use simply press this magic button and you will 
see the Skip Letter Menu with all the letters of the alphabet on it.    Check the letters you don't
want Movie Magic Screenwriter to use, and it won't.

NOTE: Movie Magic Screenwriter also uses this skip list for numbering Act and Scene Info if they 
are set to use LETTERS.



Edit Script Formats Menu
This is the major gateway to configuring how your script looks: the margins, capitalization and fonts 
of the elements, deciding how you want it to break pages and more.      It is found on the Format 
Menu and there are thirteen pages to this menu and each page is selected simply by clicking on the 
button with the name of the element whose settings you want to change.    The Pages are:

[Character Names]
[Dialogue]

[Parentheticals]
[Scene Headings]

[Shots]
[Action]

[Transitions]
[Act Information]

[Scene Information]
[Script Notes]

[Centered Title]
[Page Breaks]

[Locked Scripts]
In addition there are some general options that are available when in any of the Element Pages as 
they are not element specific.    They are:

Allow Words that are five or more letters long to extend 1 or 2 letters beyond the normal right 
hand margin which, if checked, will do just that, producing a generally more visually pleasing word 
wrap,

Save as Defaults for All New Scripts which will take all the current settings and use them 
whenever you start a new script

Use Current Font for All Elements which will take whatever the currently selected Element's Font 
is, and set ALL Elements to use it.



Edit Script Formats Menu - Parentheticals Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There are two additional options for Parentheticals:

· Outdent Parentheticals - which if checked will mean that the left parenthesis of the 
parenthetical will be outdented one space to the left of the margin so that the actual text of 
the parenthetical will word wrap correctly under the first letter.    This is the recommended 
setting.

· Parentheticals are Separate Elements - which if checked, means that it will put 
parentheticals on their own line, and if    not checked will mean that when you press the left 
parenthesis "(" in dialogue instead of it putting in a separate parenthetical element, it will put 
in both the left and right parenthesis "( )" actually within the dialogue instead of on its own 
line.



Edit Script Formats Menu - Scene Headings Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There are seven additional options on the Scene Heading Page:

· Number of Dashes w/ Time of Day lets you specify how many dashes Movie Magic 
Screenwriter should put in when it puts in the Time-of-Day from a Pop-Up Menu.    You can 
select from zero to nine, though why you'd want nine dashes...

· Number of Spaces after INT/EXT lets you specify how many spaces it will put in between 
the Initial Scene Heading Text and the location in a Scene Heading when it types in any initial
Scene Heading Text or location from a Pop-Up Menu.

· Scene Numbers
· Left - which if checked will put in Left Scene Numbers
· Right - which if checked will put in Right Scene Numbers
· Starting Number - which allows you to specify the starting Scene Number of the script 

for use in the case where you are doing something like writing a MOW and splitting it up 
between different files--a completely unnecessary thing to do, but you might have your 
reasons....

· Scene Continued Text
· Top of Pg - which if checked, will put the text immediately following it on the top of every 

page where the scene continues from the previous page.    This Top Continued will be put
at the standard left action margin, and will also pick up Left and/or Right Scene Numbers 
if you have either or both checked above.

· Btm of Pg- which if checked, will put the text immediately following it on the bottom of 
every page where the scene continues onto the following page.    This bottom continued 
will either be put two lines below the last line of text actually on the page, or on a fixed 
line just below the top of the bottom margin.    You can set which it does on the Printer 
Page of the Program Options Menu.

NOTE: If you want the Bottom Continued to be in Parenthesis--which is the preferred way--then 
unlike the Character Continued text, you do have to actually type them in here.

· Left Margin of Bottom Continued - is in inches from the left edge of the page and allows 
you to change how far in the Bottom Continued is indented.



Edit Script Formats Menu - Shots Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
Aside from the normal options for Margins, Line spacing and whatnot, there are no element specific 
options for Shots.



Edit Script Formats Menu - Transitions Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There is only one additional option for Transitions...

· Transitions are FLUSH RIGHT which, if checked, will cause transitions to be made flush 
right against their right-hand margin, otherwise they will all start flush left against their left-
hand margin.



Edit Script Formats Menu - Scene Information Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
Scene Information has seven additional options...

· Use Scene Information in Script - many dramatic TV scripts and MOWs use Act 
Information but not Scene Information.    If you check this box then Movie Magic Screenwriter 
will automatically put in Scene Information when you start a new act, otherwise it will not.

· (Put Scene Info in Parentheses) - will do exactly that
· Center S-Info - if this is not checked, then Scene Information will be flush left against its 

defined left-hand margin
· Put in "SCENE" - some formats don't want the word "Scene" in the Scene Information, using

just a letter or Number.    This turns on/off the use of the word "Scene"
· Number Scenes Continuously -some formats want each Act to start with Scene 1 (or 

Scene A or whatever) while others want all Scene Information elements to be numbered 
sequentially throughout the script regardless of Act.    Checking this will do the latter, and if it's
not checked, then at the start of each Act, the Scene Number will start again at whatever is 
defined as the starting Scene Number below

· Starting Number - allows you to set the starting Scene Information Number
· Numbering Scheme - allows you to choose how Scene Information should be "numbered"...

· Scene A - Use letters A-Z (skipping those specified in the Locked Letter Skip List found 
on the Locked Scripts Page of this menu)

· Scene 1 (Numbers) - Use numbers 1-20
· Scene One (Words) - Use numbers written out "One"-"Twenty"
· Scene I (Roman) - Use Roman Numerals I - XX



Edit Script Formats Menu - Script Notes Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
There are three additional options for Script Notes...

· Display Notes in Script - if not checked, then the Script Notes will be completely invisible on
screen, otherwise they will be displayed on screen

· Print Notes in Script - if not checked, then Script Notes will not take up any space in the 
script nor will they print when you print your script pages.    If it is checked, then they will do 
both

· Color Chart - you can click on any color and your Script Notes will be displayed on screen in 
that color, though depending on your Windows color setup you may have difficulty reading 
them with certain colors

NOTE: Whether or not your script notes are displayed or set to print within the script, you can 
always print them separately with reference page numbers on the Print Menu itself.



Edit Script Formats Menu - Centered Title Page
All of the Element Pages on the Edit Script Formats Menu start with the same options at the top - 
Click here to see them
Aside from the normal options for Margins, Line spacing and whatnot, there are no element specific 
options for Centered Titles.



Edit Script Formats Menu - Page Breaks Page
This is where you can set how Movie Magic Screenwriter' pagination routine makes its decisions 
where to put the page breaks.

There are four basic options for how it breaks Action and Dialogue, and though you can set them 
separately, I'm going to describe them here only once as they are the same for both element types:

· Do Not Break - Movie Magic Screenwriter will never break the selected element type over a 
page break; if this is selected for Dialogue, then Screenwriter will never put any (MORE)'s 
into your script.

· Sentence Ends Only - Screenwriter will only break the selected Element type between 
sentences (or in the case of Dialogue also between Dialogue and Parentheticals).    This can 
still result in short pages if you have long speeches or blocks of Action that are one very long 
sentence.

· Sentence Ends Preferred - When Screenwriter calculates where it can break the selected 
Element type, it first checks to see how many lines it can fit on the page, and if there is a 
sentence end within three lines preceding that maximum line, then it will break at that 
sentence end.

However, if there isn't a sentence end within those three lines, it will break it at the end of the 
maximum lines it can fit on the page, even though that is not at the end of a sentence.    In 
most scripts, this latter occurrence is a fairly rare event, and having Sentence Ends Preferred
selected ensures that you never get very short pages.

· Break at Maximum Lines - This tells Screenwriter to break the selected element type at the 
maximum number of lines that it can fit on a page, completely regardless of sentence ends.

In addition to the above Break Element options, there are several additional settings you can make...

· Minimum Action/Dialogue Lines on a Page - the number you specify here is used only 
when Sentence Ends Preferred or Break at Maximum Lines are chosen, and then only in the 
case where there is an Element that must be broken at a non-Sentence End.    In that case, 
Screenwriter will leave at least the specified number of lines both before and after the page 
break or it will not break up the element.

· Break After a Single Sentence - this option specifies whether Screenwriter should break 
after a single sentence that takes up only one line (ie does not word-wrap to another line).    
However, in the case of Dialogue, this is ONLY considered for the Dialogue element that 
comes immediately after the Character Name.    If a Dialogue Element follows a Parenthetical
or is a Second Dialogue Paragraph, then Screenwriter    may still break it after only a single 
One-Line Sentence, even if this selection is not checked.

· Break Two One-Line Sentences - if this box is not checked, then when you have a single 
Action Element or Speech consisting of only two sentences, each of which take up a line or 
less then Screenwriter will not break them.

· Allow Transition as 1st Line on Page - if this CheckBox is checked then Screenwriter will 
allow a Transition to be the very first line of a page.    If its is not checked and a Transition 
would normally fall at the top of the page, then Screenwriter will move the element which 
precedes the Transition (breaking it if allowed and appropriate) to the top of the page to 
ensure that the Transition is not the first line.    This is the generally accepted way of doing 
things, but can cause short pages.

· Allow Transition on CONTINUED line - this CheckBox will grayed out and unselectable if 
you don't have Bottom Scene Continueds turned on.    (You turn them on by checking the 
Btm of Page Scene Continued CheckBox found on the Scene     Heading     Page   of the Edit 
Script Formats Menu).    If you do have bottom Scene Continueds turned on, and you check 



this option, then if a Transition would normally not fit on a page, but the very first thing on the 
next page would be a Scene Heading (or Act/Scene Info) then Screenwriter will allow that 
Transition on the bottom of the page because it's replacing the bottom Scene Continued.

· Allow Scene on TOP CONTINUED line - this CheckBox will grayed out and unselectable if 
you don't have Top Scene Continueds turned on.    (You turn them on by checking the Top of 
Page Scene Continued CheckBox found on the Scene Heading Page of the Edit Script 
Formats Menu).    If you do have Top Scene Continueds turned on, and you check this option,
then if the very first thing on the next page would be a Scene Heading (or Act/Scene Info) 
then Screenwriter will place that at the same line as it would normally place the top 
continued.    Without this checked, then the first text line of every page will be the same 
regardless of whether there is a Top Continued on it or not.

· Count MORE Line in Page Breaking - allows you to specify whether or not the program 
should consider the space that an added MORE line would take up when it calculates the 
page break.

· Starting Page Number - allows you to specify the starting page number of the script.    Use 
this to set up title pages (by setting the starting page to 0) or to break up scripts into Acts and 
start each act accordingly.

· Start 1st/Forced Page on Line # - this option lets you start the first page of the script and all
pages following forced page breaks on a line greater than one.    This is most commonly used
in Sitcom formats to start each scene a third of the way down the page or so.



Title Page Publisher - Edit Text Window
This Edit Text Window is how you add/edit text in the Title Page Publisher and
is accessed within the Title Page Publisher by double-clicking anywhere on 
the WYSIWYG Title Page.

If you double-click on existing text in the TItle Page Publisher, then the Edit Text Window will have 
that text inside it, and you can edit the text, otherwise it will create a new text element for you, and 
the Edit Text Window will be blank.    

The Edit Text Window consists of a large text window where you write and edit, and seven buttons 
below it.

STYLE BUTTONS -    the first three buttons on the left are labelled B, U, I and, if pressed, will set the
text in the window to be Bolded, Underlined and/or Italicized respectively.

NOTE: You cannot mix text formats within the same text, so if you need to do so, use separate text 
elements.

FONT BUTTON - the font button allows you to select any True Type Font that's available to Windows
and lets you choose the font size as well.

JUSTIFICATION BUTTONS -    the final three buttons on the right let you set the text justification as 
follows: the left-most button will set it to Left Justified, the Middle one will center the text, and the 
right-most button will set it to Right Justified.



Edit User Lists Menu
You can get to this menu by selecting the Edit Menu from the Main Menu Bar 
and then choosing Edit User List Menu.

The buttons on the right column select the specific User List you want to edit, and depending on the 
list you're in, it will have a varying number of user list elements, and all of them except [Extensions], 
[Scene Body Text], and [Times of Day] will have Text [Alias] Buttons--those specific one's do not as 
they are never used for auto-text recognition.

Once you selected the User List you want, it will display the appropriate number of items for that 
specific User List with the current contents filled in.

Changing an Item - select the item you want and edit it as desired.    Press <ENTER> when done.    
If you delete an item, when you exit the User List the list will be consolidated and the blank line 
removed.

NOTE: The Times-of-Day User list is unique in that Items in the list may have an ampersand ("&") in
it.    Because this User List is only used for creating the Time-of-Day Pull Down Menu, and because 
there may be more than one item that begins with the same letter, Screenwriter uses this 
ampersand to tell it which letter to display as underlined in the Menu and to use as the Quick Key 
for that Item.    For example, &Morning would use MA as its Quick Key and M&oments Later would 
use O.



Edit Watermark Name List
This Menu is gotten to by clicking on the EDIT button to the right of the Name 
List field on the Watermark Security Options Menu.

The top field is where you add/edit text, and the list below it contains all the names in the list.

To Add a Name to the List simply type it in the top field and press [ENTER] or click on the [ADD 
NAME] button.

To Edit an Existing Name in the List, first highlight the name you want to edit and either double-
click on it, or click the [EDIT NAME] button.    It will copy the name in question to the top field where 
you can change it as desired, and when you're done click [ADD NAME] or press [ENTER] and the 
name will be changed in the list.

To Remove a Name from the List, first highlight the name you want to remove and then click the 
[DELETE NAME] button.    It will ask you whether it should "flag the name as deleted rather than 
completely deleting it."    If you have issued any scripts using this list then you want to answer YES 
otherwise it will screw up the correspondance between names/serial numbers.    If you answer NO, 
then it will ask you if you want to REALLY delete the name and you'll have to type YES to do so.



Faxing
To fax from Movie Magic Screenwriter, you must have a fax modem and Windows faxing software 
installed.    Assuming you have both, you can fax as easily as printing by simply pressing the [Fax] 
Button on the Print Menu instead of pressing [OK].

If the [Fax] Button is grayed out, it means that Movie Magic Screenwriter doesn't know what your fax 
software's printer driver is called, and you need to go to the Print Menu, select Setup then Fax 
Modem.



General Production Revisions
Differences Between Production and Development Scripts and the reasons why...

A Script that's in development has different needs than one in production.    Its goal is to convey the 
story and excite people about making this movie.    When the Production Company buys the script, 
it goes through a period of rewrites--alternatively called Development or Hell--until the Production 
Company either gives up on it or gives it the "Green Light."    This latter case means the company will
finance the film and is actively heading it towards production.

As soon as (or by the time) the script is "green-lighted" the following "features" are added to the 
script format:

1 Left & Right Scene Numbers
2 Top Scene Continueds

The Scene Numbers are put in to make it easier for people communicate which scene they are 
talking about.    For example:    there may be three scenes set in the same location, but only ONE will 
be labeled scene 12.

Top Scene Continueds go on the top of every page that does not start with a new scene heading.    
These Top Continueds are numbered (left and right) to let the reader know what scene any given 
page starts with, even if the actual scene heading is two or three pages previous.    This is important 
because scripts are almost invariably shot out of order, and when the Production Manager yells 
"okay, we're shooting page 5" everyone needs to easily know what scene is on page five. 

When the script has been "green-lighted" and a Production Manager and 1st-AD have been hired, 
the script moves into a "pre-production" stage.    Distribution is furious at these times as they are 
sending out copies of the script to all the potential hirees that they want to head up the different 
departments.    At some point in pre-production anywhere from one month to one day before 
shooting--the director, producer and production manager will decide that the script needs to be 
locked.

When the script becomes locked:

1 Page Numbers    are locked
2 Scene Numbers are locked
3 A Header is added with Revision Color, Revision Date, and whatever other 

Title Information is desired
4 An Initial Shooting Draft is issued to all appropriate personnel

This is typically the last full draft that is issued of the script.      It is issued on white paper, and 
becomes the "base" draft that further colored pages will be inserted into as they are issued (i.e. as 
YOU issue them) during the further course of production.

From this point on, everyone from the gaffers to the costumers up to the director are making notes 
within their copy of their script and elsewhere which are based on the current scene and page 
numbers.    Your goal as the script coordinator is to incorporate all the changes made by the writer 
and, without sacrificing accuracy, issue as few revised pages as possible in order to minimize the 
impact on everyone's existing notes and paperwork.    Detailed examples will be given later.

Standard Industry Revision Formats
Once the script is Locked, when new material is inserted such that it creates a new page, the new 
page will be numbered as an "A-Page." This A-Page may be shorter than a normal page, but will be 



issued as a "short page" so as to not affect the numbering and content of any following pages.    Thus
a new page added after page 9 would be 9A, the one following that 9B and so on.

NOTE: Most productions skip the letters "I" & "O" because they are too visually similar to the 
number "1" and "0" and some productions also skip "E" and "F" because they are also too similar to 
each other.    Check with your AD to see which letters you should not use.    When you need to skip a
letter such as "I," a scene added following 12H would be listed as 12J rather than 12I.

Any new Scene Headings that are added are likewise added as "A-Scenes" so as to not affect any 
existing scene numbering.    

Any Scene Headings (also called Slug Lines) that are completely deleted by the writer are not 
removed from the script, but are changed to OMIT or OMITTED (or some variation thereof).    
Multiple Scene Headings that are omitted in a row are often combined into a "run" of omitted like:

 25   OMITTED                                         25
THRU                                                THRU
 27                                                   27
Any full pages that are completely deleted by the writer are either printed as an OMITTED PAGE or 
not printed at all, at which point the previous page must be printed with its page number as a "run" 
e.g.: 24-25A.

Any changes in the script must be "tagged" as revised by having a revision mark--which is typically 
either an asterisk "*" or an X in brackets "(X)"-- in the right margin, lined up with the change so that 
the reader can easily see what's been changed on a re-issued page.    Depending on the production, 
if there are more than a certain number of revision marks on the page, the Header gets an asterisk 
and/or the revision marks do not print on that page as the entire page is considered to be revised.    
In most cases, the Production Manager will make the decision as to how many revision marks need 
to be on a page before the entire page is considered to be revised and in that case, whether or not 
individual revision marks on that page will printed.

New A-Pages that do not have revision marks on them often still have an asterisk on their header to 
identify the fact that it's a new page.

NOTE: Any questions about scene and page numbers in the course of production should be 
referred to the 1st AD as it is their ultimate responsibility to breakdown the script by scene and page
number.

The Revision Draft Colors
Once the Initial Production Draft has been issued on white, any new pages that are issued are done 
so on colored paper to make it immediately obvious to everyone if someone is using the wrong 
version of any given page.    The header text should contain the color--like BLUE Revision--and the 
date so that:

1 Whoever duplicates the page knows what color to use
2 When people go back later to a file copy of the final script on white, they can easily see what 

pages went where.
The colors used in revisions often vary, but unless the Production Manager or 1st AD insists on 
something different, we recommend that they be as follows: (in order of the revision draft): WHITE, 
BLUE, PINK, YELLOW, GREEN, GOLDENROD, SALMON, CHERRY, BUFF, TAN.

NOTE: Check with your Production Manager or 1st AD to verify that this is an acceptable order 



before shooting begins.

If you go though all the available colors and still have more revisions, you should start at the 
beginning again (though WHITE is often skipped) calling the revision DOUBLE BLUE, DOUBLE 
PINK etc. or SECOND BLUE, SECOND PINK, and putting that on the header.

Whenever you issue a new color, the Title Page should have a line added to it with the revision color 
information. This will be a running list of all the revision colors and what dates each were issued on.   
That way, if someone picks up a script in the midst of production, they will know whether or not that 
specific draft is current.    This list of revision colors should read something like the following:

      7/16/97                BLUE revisions
      7/17/97                PINK    revisions
                              ...
      9/1/99                    QUADRUPLE PINK revisions

The Production Revision Cycle using Movie Magic Screenwriter



The Production Revision Cycle Using Movie Magic 
Screenwriter
The Revision Cycle
Okay, you're about ready to issue your Initial White Shooting Draft, so first do the following:

1 Add Top Continueds, Scene Numbers and other Production Features as needed
2 Update the script's Headers as needed to reflect the Production Information: Revision Draft 

Color, Issue Date and so on.
3 Make sure that all your scene numbers, page breaks, and headers are locked
4 Turn on Auto-Revision Marks
5 Update the script's Title Page to reflect the correct date and add the revision date/color to the 

running list.

NOTE: You can do each of these items separately by going to the Edit Script Formats Menu, 
Header Setup Menu and Title Page Publisher, or you can have the program do them all in one fell 
swoop simply by selecting Lock The Script under the Production Menu.

Entering the Revisions
You are now ready to make your revisions, adding and deleting text as needed.    While you are doing
so, Movie Magic Screenwriter will ensure the following:

1 Each revision (either addition, deletion or edit) has a revision mark next to it
2 Any omitted scenes or pages are accounted for, either as a separate OMIT or as part of a "run"
3 All existing scene numbers remain the same, though you may be adding new A-Scenes and/or 

converting existing Scene Headings to OMITTEDs
4 All existing page breaks remain the same, with any new pages labeled as A-Pages, and any 

pages whose text is completely deleted accounted for as either full OMITTEDs or as parts of a 
run (e.g., the previous page's number being listed as 25-26).

NOTE: If, after making the day's edits, you end up with a series of short Pages (such as 12, 12A 
&12B) all of which all have revisions on them, it is often standard practice to combine them since 
you'd have to issue all three pages anyway.    To do so, simply put the cursor on the first line of the 
page which you wish to combine with the previous page, and select EDIT, REMOVE FORCED 
PAGE BREAK and select YES.    Check the the Production Manager or 1st AD if you have any 
questions.

Having made all the changes, you are now almost ready to actually issue today's revisions.    

You will be issuing ONLY those pages which have revisions on them and any newly created A-Pages
following them.    This latter is needed because if, for example, you add half a page of text to the top 
of Page 12, that would result in a new 12A.    This page 12A, however, won't have any revision marks
on it because the text that's on that page hasn't actually been changed having been merely pushed 
down from the bottom of 12.    However, this page 12A must still be issued as otherwise that text 
would be lost, as the old 12 is being replaced with a new one.    Movie Magic Screenwriter will do this
all automatically, however, before printing the revised pages, do the following:

1 Check that the Headers and Title Pages reflect the correct Revision Color/Date and other 
information

2 Save the script with a name that reflects its current revision color and date using the naming 
conventions described below

You can now print those pages that you need to issue by going to FILE, PRINT and then selecting 



either ASTERISKED PAGES, or, if you've been using the Automated Revision Draft Colors, you can 
select the current Revision Color.

Once you have a printed copy of the new revisions in hand, it is generally good practice to do the 
following, though due to the automated nature of Screenwriter, it is extremely rare that you'll find 
anything.

    1            Compare the hard copy of what the writer gave you with the new pages:

· Verify that everything "tracks"—i.e. that when the new pages are inserted in the script and a 
reader goes from an old page to a newly issued page, all the text is there without any 
doubling, and ditto for going from the newly issued page back to an old one

· Verify that you've actually made all the revisions you were given
· Verify that you're actually issuing all appropriate pages

    2            Make any corrections required based on 1a-1c, and reprint as needed

    3            You can now duplicate and issue those pages

Once you've issued the revisions you should do the following in preparation for the next revision:

1 Save the script again with a new name that reflects the next revision color according to the 
required Naming Conventions of your production

2 Remove ALL Revision Marks so that you'll start "clean" with the next version
3 FIX All Existing A-Pages
4 Change the Header Text to reflect the proper revision color
5 Change the Title Page to reflect the current date and add the date/revision color to the running 

list

NOTE: You can do all these steps separately, or you can simply select Start Next Revision on the 
Production Menu and it will do the whole series for you.

And that's the cycle.



Generate Rundown Sheets Menu
Movie Magic Screenwriter can automatically generate Sitcom Scene 
Rundowns and Set Lists for you, saving you hours of labor.

To get to the Scene Rundown Generation Menu:

Go to the FORMAT Menu, choose Scene Character Lists then Generate Rundown Sheet and you
will see the Scene Rundown Menu.    It has the following options:

· Script Title - Fill in the script's tItle.
· Production -Fill in the name of the show or production company.
· Episode # - Fill in the Episode Number or identifier, actually typing in the word "Episode" if you 

want it filled in.
· Draft Ver. - Fill in the Draft Version or identifier (ie First Draft, Rev. Final Draft), actually typing in 

the word "Draft" if you want it filled in.
· Date - This will automatically have today's date, if you want a different reported date, change it 

as appropriate.
· Font - allows you to select a font for the Rundown Sheets and Set Lists.
· Size - allows you to specify the size of the font.and Set Lists
· Box Width - the rundowns are generated with four boxes to the right of each Act/Scene for use 

in timing and writing other information.    You can specify how wide each of these boxes should 
be, ranging from 0.5 to 1.5".

· Min. Height - you can specify a minumum height for each box, anywhere from 0.5" to 2.00.    If a 
box needs to be larger than that value to contain all its information, then that box's height will 
depend solely on the amount of information in it and how that naturally word-wraps.

· Print Separate Act/Scene Column - if checked, then there will be a far left column with just 
Act/Scene information in it, otherwise the Act/Scene Information will be the first line of each Box.

· Print Separate Day/Night Count Column - if checked, and you have (DAY 1) type information 
at the end of each Scene Heading then there will be a column to the right of the major 
information box with just a D for Day or an N for night followed by the appropriate number.

· Print Separate Page Number Column - if checked, then the page numbers will be reported in 
their own column, otherwise they'll be reported in the upper right corner of the major information 
box.

· Underline Act/Scene Information - if checked, then any Act or Scene Information will be 
underlined.

· Underline Scene Headings -    if checked, then any Scene Headings will be underlined.
· Bold Act/Scene Information - if checked, then any Act or Scene Information will be bolded.
· Bold Scene Headings -    if checked, then any Scene Headings will be bolded.
· Print Total Boxes at end of page - if checked, then it will print out a set of three "Total boxes" at

the end of each Rundown Page
· Print Set List - if checked, then it will print out a set list immediately following the rundown 

sheets.
· Print Pg #'s in Set List - if checked, then it will print out a set list immediately following the 

rundown sheets.

NOTE:    If you use the Breakdown Tagging Function to tag a Scene Description, then the Rundown 
Sheets will automatically fill that Scene Description into the end of the Major Information Box for 
you.





Graphing Multimedia Scripts
This graphing screen is gotten to by clicking on the Graph Branch Points 
menu item under the FILE Menu in a Multimedia script or by clicking on Right 
Speed Button with the picture of a graph on it.

The current Branch Target is displayed in the center oval, and all Branch Points which are "owned" 
by it are displayed in rectangles below it with arrows showing the branching possibilities.    

If a branch point is within a user activity, then that branch is considered conditional and the arrow will 
be displayed in red, otherwise it will be in blue.    An example of a conditional branch point would be:

> IF USER HAS <KEY TO GATE> THEN 

  GOTO <ORCHARD>

< END IF
...as it can only be performed if the conditions of the User Activity are met.

There may also be some places in the script which will branch to the current Branch Target but to 
which you cannot branch back.    This might be a space station, for example, and once one leaves it 
in the space ship, you cannot return. These Branch Targets are displayed above the oval.

On the Graph Branch Points Screen, there is a speed bar at the top with three buttons:

[CLOSE] - the left-most button has the picture of door on it.    When pressed, it will return you to the 
script at the position where you were when you displayed the Branch Graphing.

[PRINT] - the middle button with a picture of a printer on it.    When pressed, it will display a menu of 
all the Branch Targets and allow you to select starting and ending Branch Targets and then will print 
the graphs for that range of Branch targets.

[HELP] - will bring up this very help file.

To the right of the buttons there is a Drop-Down List of all the existing Branch Targets. If you click 
on this list and select one, it will set that Branch Target as the Current Branch Target and graph it for 
you.

Moving around in the Graph Screen
You can "walk" through the branches by simply double-clicking on any Square Branch Target, and 
that Branch Target will immediately become the current Branch Target and the graph will adjust to 
reflect that.    

You can also return to the script at any Branch Target merely by Right-Clicking on the one you want 
to go to.

Adding New Branches/Branch Targets
Simply double-click anywhere on the graph where there is not a boxed Branch Target.    Do so and 
the Branch Point Menu will appear, allowing you to add new unconditional Branches and new Branch
Targets as desired.

NOTE: any new branches added in this fashion will be added as a Branch Position at the very end 
of the Branch Target's text.    The potential drawback to this is that if you have a conditional branch 



point with an OTHERWISE statement that also contains a branch point -- so that no matter what the
user choose they'll branch somewhere -- then these branch points added in the graphing screen will
never get hit.



Header Setup Menu
You can get to this menu by choosing Header Setup found on the File Menu.

Header Text - you can specify up to two lines of Header Text, and you define them using certain 
codes to tell Movie Magic Screenwriter what text to put in.      For example if you want a Header with 
Act & Scene Number in it, plus the Date and Page Number, you might put in the following line as 
Line 1 of the Header Text.

Act @, Scene $    - Revised %        Pg #.

When Movie Magic Screenwriter printed, this would translate to something like the following (varying 
of course on the actual Act, Scene, Date etc.)

Act 1, Scene Two - Revised 3/9/94    Pg 8.

Codes - To put in the codes, while in Header Line 1 or 2, simply press the corresponding button in 
the Codes line or type in the code displayed on the button.

NOTE: (1) When you are constructing your header, you can always view a sample of what it's going
to "translate to" by pressing the [Preview] Button, however if you're in a blank document or are on 
page one and have told it not to print the header on page one, you might not see anything!    (2) If 
you do not have any text in Header Line 2, then Movie Magic Screenwriter will not print it.    
However, if there is any text there, including just spaces (which is the default), then Screenwriter will
print it, causing there to be one more blank line between the page number and the starting line of 
actual text.

Put Date As... - This lets you specify how you want the Date to print if it is included in the header.    
Month/Day/Year is the standard American format; Day/Month/Year is the normal European Format 
and you can also have dashes ("-") rather than slashes ("/").

Put Act Information As.../Put Scene Information As...
These menus allow you to select the format you want.

Print Header On...
This section lets you select when you want the Header(s) to be printed.    The options are: 

Not Page One - which means exactly that, no header will be printed on Page One although they will 
be printed on every other page.    This is the standard for Screenplays.

Every Page - pretty obvious what this means.

Every Page Except First Page of Scene - some TV formats don't want the headers on any pages 
where the Act & Scene Information is already at the top of the page, so this option won't print the 
headers in those cases.

Align Headers
Movie Magic Screenwriter by default aligns the headers as Flush Right. If you would rather have your
headers aligned flush left at the selected margin, then select Flush Left at Margin and specify the 
margin you want.
You can also split the Headers so that half is aligned left and half is flush right by checking the Flush 
Left at Margin and then inserting a Flush Right Code (^) anywhere in the text.    For example, if you 
enter the following line into the Header Line 1:



"My Script" by Me ^ #.

...it would print as...

"My Script" by Me 1.

Blank Lines following Header
This is fairly self-explanatory, being the number of blank lines between the header and the first line of
text or Top Continued.

NOTE: Spec scripts' headers do not usually contain anything other than a page number and a 
period, and this is also true for most TV scripts.    The Date is also generally to be avoided, as it tells 
readers how old your script is, and you always want them to think it's new and exciting... even if it 
really is four years old.



Hide Locations in Pop-Up List
This Menu allows you to "hide" certain Locations so that they don't appear on
the automatic pop-up lists of Locations used when entering Scene Headings . 
You would generally use this function to "get rid off" the Locations that you 
aren't going to use again in the script.

To get to the Hide Locations Menu - go to the FORMAT Menu and choose Hide Locations in 
Pop-Up Lists

To hide a Location - simply double-click on any Location in the left column (Locations to be 
Displayed) to move it to the right column (Hidden Locations), or alternatively select it and click on the
[>] button

To hide all Location - click on the [>>] button and it will move all the Locations from the Locations to
be Displayed List to the Hidden Locations List.

To unhide a Location - simply double-click on any Location in the right column (Hidden Locations) 
to move it back to the left column (Locations to be Displayed), or alternatively select it and click on 
the [<] button

To unhide all Location - click on the [<<] button and it will move all the Locations from the Hidden 
Locations List back to the Locations to be Displayed List.



Hide Names in Pop-Up List Menu
This Menu allows you to "hide" certain Character Names so that they don't 
appear on the automatic pop-up lists of Character Names.    You would 
generally use this function to "get rid off" the names of minor characters who 
are only in one or two scenes.

To get to the Hide Names Menu - go to the FORMAT Menu and choose Hide Names in Pop-Up 
Lists

To hide a name - simply double-click on any name in the left column (Names to be Displayed) to 
move it to the right column (Hidden Names), or alternatively select it and click on the [>] button

To hide all name - click on the [>>] button and it will move all the names from the Names to be 
Displayed List to the Hidden Names List.

To unhide a name - simply double-click on any name in the right column (Hidden Names) to move it 
back to the left column (Names to be Displayed), or alternatively select it and click on the [<] button

To unhide all name - click on the [<<] button and it will move all the names from the Hidden Names 
List back to the Names to be Displayed List.

· Don't Hide Names in Scenes Where they Speak - when you check this option, it will show any 
normally hidden names ONLY when you are entering a character name in a scene in which that 
character is already speaking.    This is really useful when you're going back and editing so that 
BAKER, for example, will ONLY show up when you're in a scene with the baker already in it.



Hiding/Displaying Non-Printing Text and Script Notes
You can hide or display any Script Note or Non-Printing Text individually or 
turn on/off the display globally.

When you have a Script Note or text marked as non-printing displayed on screen, then there will be a
small green box to the left of it with an H in it.    This H stands for "hide" and if you double-click on this
box it will hide the note.

When you have hidden text in your script, there will be a Blue box with an S in it which signifies that 
there is hidden text before this element.    Double-clicking on this box will display that hidden text.

You can turn on or off the display of ALL Script Notes or Non-Printing Text by going to the FILE Menu
and selecting Hide Elements on Screen.



Highlighting with Colors
Movie Magic Screenwriter gives you several ways you can use colored 
highlighting in your scripts:

· You can manually add/remove colors like any other text format (ie bold / Italics / Underline / 
Strikeout) if you have the colored buttons available on the Top Speed Bar or by selecting 
Change Text Color from the edit menu.    (If they are not available, run the SETUP MENU BAR 
utility to edit the Speed Bar and make them available.)    To do so, simply select the text you want
to highlight and click on the appropriate colored speed button, or go to the EDIT Menu, choose 
Change Text Color, then select the color you want.

· You can have it automatically mark any new text revisions you make with a color by going to
the FORMAT Menu, choosing Auto-Revision Color and selecting among the available colors.

· To stop it automatically marking revisions in a color, go to the FORMAT Menu, choosing 
Auto-Revision Color and then select Turn Revision Color off.

· You can have it automatically highlight all of one character's dialogue in RED so that the 
actor can easily pick out their lines.    To do so, go to the FORMAT Menu, choose Auto-Revision 
Color, select Mark One Character's Dialogue, then select the name who's dialogue you want 
highlighted and it will do it for you.

To Remove all of one color's Highlighting - go to the FORMAT Menu, choose Remove 
Strikeout/Rev. Color and select the color you want to remove.

Printing the Colored Highlights - you have the option as to whether the colored highlights will print 
or not, and you set this on the Printing Options Page of the Program Settings Menu.

Searching for Colored Text - you can "walk" your way through all the colored revisions in a script by
going to the GOTO Menu, and selecting Next Strikeout or Colored Text which will find the next 
element that has any color highlighting in it (or Strikeout code).



Homonym Check Menu
This Menu allows you to check your script for the correct usage of any 
homonyms or other easily confused words such as "their : there : they're."    It
will scan the script and point out each instance of the selected words and 
allow you to verify that it is correctly used.

To get to this menu, simply go to the Spell Menu, and choose Homonym Check

To add a new set of comparison words, simply type them in the Words To Check field with each 
word separated by a colon.    If the word has different forms such as "pair : pare" and "pairs : pares" 
you must put in each case individually.

Once all the words you want it to check for are entered -- and you'll only have to do this once at it 
saves this list automatically -- you should click either the [Check Forwards] or [Check Script] buttons 
to check from the current cursor position downwards or to check the entire script respectively.

When it finds any one of the words listed it will point it out and ask you if this is the correct usage.    If 
you say NO and there is only ONE other option -- such as in the case "its : it's" then it will simply 
replace this text with the other option, otherwise it will pop-up a list of alternatives.



How Users Lists Work
While you write, Movie Magic Screenwriter can recognize when you've typed a Scene Heading, Shot,
Transition and so on, and format it appropriately without you having to tell it to do so.    Furthermore, 
it also can pop-up menus with options such as Initial Scene Heading Text (INT., EXT., etc) or Times-
of-Day (DAY, NIGHT, etc.) so as to enable you to put in that text without having to type it.    It does 
both of these things through its User Lists.

For example, you want Movie Magic Screenwriter to know when you type INT. or EXT. that you're 
starting a Scene Heading.    The way it does that is by checking everything you type against the text 
in the Scene Heading Text User List--thus when you type "INT.", it finds that as an item in the Scene 
Heading Text User List, knows that this should be a Scene Heading, and formats it appropriately.    
It's that simple.    If you want Screenwriter to recognize and format text you type as being a certain 
Element, then put that text in that Element's User List by going to the Format Menu and choosing 
Edit User Lists.

NOTE: The one exception to this rule is in the case of Transitions where Movie Magic Screenwriter 
will automatically recognize any text that ends with TO: as being a transition, whether or not the text 
is in the Transition User List.

Movie Magic Screenwriter also has Alias Text, which are short versions of the text in the user list so 
you can type fewer letters and have it expand it out for you. This means that if you assign "I" as a text
alias for "INT." you can type either "I" or "INT." and it will automatically recognize either as "INT." 
expanding it if necessary 

Also, when Movie Magic Screenwriter displays a pop-up menu with Text Items (such as Times-of-
Day) to put into your script, it builds that Menu from the items in that Element's User List.    For 
example, if you want the Transition Pull-Down menu (gotten by pressing <Ctrl T>) to have an option 
of say, FLIP TO:, simply add that to the Transitions User List and when the menu pops-up, that Text 
will now be on it.

Due to the different needs of the various User Lists, different Element's Lists have different numbers 
of possible items.    They are as follows:

Character Names: 15 items*
Extensions: 5 items
Initial Scene Text: 10 items
Scene Body Text: 10 items*
Shot Text: 6 items
Times of Day: 12 items
Transitions: 8 items
Act/Scene Info: 3 items
Prologue Text: 5 items
Tag Text: 1 item
End of Act Text: 1 item
FADE IN: Text: 1 item
Substitution Text: 12 items

NOTE:    The Item Act/Scene Info Text in the User List is different from the others in that Movie Magic 
Screenwriter will ONLY use their ALIASES for auto text-recognition and uses the actual text for pop-
up menus and for replacing the Alias Text.    The first item Alias is normally set to    "NEWACT" and it 
will use this item for starting a new ACT, changing the element to ACT INFORMATION and 
incrementing it to the next Act.    The second item Alias is normally "SAMEACT", and it will also 
change this to ACT INFORMATION but will stay in the same Act.    And the third item Alias is normally
"NEWSCENE" and will be changed to Scene Information, incremented or not depending on whether 



it follows a New Act and your settings in SCRIPT FORMATS MENU.

The two asterisked User Lists (Character Names & Scene Body Text) are also somewhat unique in 
that they are only used as a supplement to what Movie Magic Screenwriter puts on its Pull-Down 
menu and uses in its Auto Text Recognition.    This is because every time you put in a new Character 
Name or Scene Body Text (the Location part of a Scene Heading--after the INT. or EXT. but before 
the Time-of-Day) into your script, Movie Magic Screenwriter automatically scans the script and uses 
all the existing text that it finds to build the List menus and aid in its Auto Text Recognition.    It then 
adds whatever additional items that you added to the User List to those lists.

Thus, the only time you'd be likely to want to add anything to either of these User Lists is if you're 
writing multiple scripts with the same Characters or Locations and wanted to have them available on 
List Menus before you type them in the first time, or if you want Alias Text for specific Character 
Names so that you could type "BJ" for example and have it expand it to "Benjamin" for you.
The other time you might want to use these two User Lists is if you've already typed in lists of this 
text elsewhere, such as in an outline or separate Story Development software program and want to 
make use of this work.



Index Card Viewing Mode
Movie Magic Screenwriter allows you to see your Script as if it were on Index Cards, with 
each scene on its own card, the Scene Heading on the top bar of the card, and the initial text 
of the scene (including dialogue) within the card itself.    This lets you see your script in more 
of a gestalt, in addition to allowing you to shuffle the scenes around as desired.    

To get into Index Card Viewing Mode select View As Index Cards under the Window Menu on the 
Main Menu Bar or click the [Index Card View] Button on the Top Speedbar.

Scrolling the Scenes in Index Card Viewing Mode - Use the [Up] and [Down] Scroll Buttons at the 
bottom of the Index Card View Screen, or press <PGUP> or <PGDN>.

Shuffling Scenes in Index Card Viewing Mode - Select the Shuffle Mode by clicking on Shuffle in 
the Mode Menu at the bottom of the Card View screen, then select the card (Scene) you want to 
move by clicking on it with the mouse. This will highlight the shuffled scene and the mouse cursor will
change from being a hand to being a a hand holding a card.    Now scroll the cards (if needed) until 
the one that you would want the shuffled scene to precede is on screen and click on it.    The cards 
will then be reordered, and when you press the [Exit] Button, so will the actual scenes in the script.

NOTE: If you want to shuffle more than one card at once, simply hold down the <SHIFT> key when 
making your card selections and when your ready to shuffle them, click on the card you want the 
group to precede while not holding down <SHIFT>.

Going to a Scene in Index Card View Mode - Get the scene you want to Go To displayed in the 
upper left card and press the [Exit] Button.

Zooming the Index Cards (i.e. changing the number of Cards displayed and Printed) - Click on 
any of the [four], [six], [nine] or [twelve] buttons on the bottom bar and that number of cards will be 
displayed.

Switching between Vertical and Horizontal View Modes - Click on the buttons labeled [Horiz] or 
[Vertical] at the bottom of the Index Card View Screen.

Undoing Selections - If you want to cancel a selection you have made, click the same card again.

Printing Index Cards - Click on the [Print] Button at the bottom of the Index Card View Screen and 
you will be taken to the Index Card Printing Menu.

Exiting the Index Card Viewing Mode - press the [Exit] Button at the bottom of the Index Card View
Window to save and process any shuffling, or press the [Cancel] Button at the bottom to have it 
discard any shuffling.

Switching between Outline and Shuffle Mode - you will ONLY have the option to go to Outline 
Mode if you have nothing other than Scene Headings and Action in your script, because otherwise 
Movie Magic Screenwriter would not be able to maintain the formatting correctly between the script 
and the cards.    If it is available, simply click on the [Outline] Button in the right side of the bottom Bar
and you'll be in outline mode where you can write and edit on the cards themselves.

NOTE: In Outline Mode, the Scene Headings will NOT be numbered in the cards as Movie Magic 
Screenwriter would not be able to distinguish between the text of the Scene Heading and the 
numbering when it writes-back from the cards to the script.



Installation
Movie Magic Screenwriter has an automated, installation program which will install and configure 
Screenwriter onto your hard drive.    You must use this installation program, as simply copying from 
the disks or another computer will not work.

At the end of the installation program, you'll be taken to the Configuration Wizard - a special program
that helps you configure Movie Magic Screenwriter the way you want.

To Install in Windows 3.1: Pull down the FILE menu from the Program Manager, select RUN and 
type A:SETUP or B:SETUP (whichever is appropriate) and then press the <ENTER> key.    

To Install in Windows95: Click on the [START] Button, select RUN and type A:SETUP or B:SETUP
(whichever is appropriate) and then press the <ENTER> key.    

From that point on, simply follow all the on-screen prompts and it will quickly install Movie Magic 
Screenwriter onto your hard drive, copying all the files and automatically creating an initialization file 
called WINTHING.INI and putting it in your WINDOWS subdirectory.



Load Script Format Menu Item
This Menu Item is found on the Format Menu, and when selected will take you to a sub-Menu which 
will allow you to load any preset formats ( Screenplay, Sitcom Version I, Sitcom Version II, Stage 
Play, User Defined, from a Screenwriter Script) as the format for the current script, reformatting the 
script automatically for you.



Loading User Lists from ASCII List
You will see this menu if you select Load User List From... ASCII List on the 
Format Menu and it is here where you specify which User list you wish to load
the ASCII List into.

· Character Names - what more can I say?
· Locations (sets) - also called Scene Body Text as it is the body of the Scene Heading
· Clear Out List First - if checked, then the User list you've selected will be cleared out, then the 

ASCII list put in, otherwise the ASCII list will be added to whatever is already there if there's still 
room.



Lock The Script Menu
This Menu is gotten to by clicking on Production, then Lock the Script... and 
is used to prepare an unlocked script for Production Revisions.

NOTE: Several items on this menu will typically be grayed out and inaccessible, this is due to that 
item having been already selected in the Edit Script Formats Menu, and not being an issue at this 
point.

TURN ON the following:

· Top Scene Continueds - these are the CONTINUED: lines that will go on the top of each 
page that does not start with a Scene Heading.    They are "place holders" for Scene 
Numbers and are almost invariably used in Production Scripts

· Bottom Scene Continueds - these are the (CONTINUED) lines that will go on the bottom of 
each page where that scene continues onto the next page.    Although they are of less real 
production value than then Top Scene Continueds, they are almost invariably used in 
Production Scripts

· Left & Right Scene Numbers - these are the Scene Numbers that that will on either side of 
the each Scene Heading, and which are used by the entire production staff to uniquely 
identify each scene.    They are almost invariably used in Production Scripts, though SOME 
rare productions use only Left or Right ones.

· Auto-Revision Marks - having this item checked means that the program will go into Auto-
Revision Mark mode, such that any additions, deletions, or changes will automatically get a 
Revision Mark next to it to identify that it is new or changed material.      Without having this 
checked, you would need to marks such changes manually.

LOCK the following:

· Scene Headings - by having this item checked, any new Scene Headings that are added will
be numbered as A-Scenes and any Scene Headings that are deleted will automatically be 
tracked as OMITTEDs.

· Page Breaks - by having this item checked, all existing page breaks will be preserved in their
current numbering and positions regardless of future edits.    New pages that are 
subsequently created by added text will be numbered as A-Pages and pages that are deleted
will automatically be tracked as OMITTEDs.

· Headers - by having this item checked, any all existing page breaks will be have their 
Headers preserved with their current date, text and Revision Draft Color until a revision is 
made on that page, at which point it will automatically be updated to the current Header Text, 
Revision Draft Color.    This means that all pages in the script will reflect the Header for the 
most current version of that page at all times.

NOTE: If you have it set to display the Revision Draft Colors on-screen, then you MUST lock the 
Header Text for it to maintain them correctly.

SET HEADER...

· Allows you to specify the text for the Locked Script's Header, which is often quite different 
from the development script's header.    The Production header will typically contain the 
Revision Draft Color--the code "~" is used to handle this automatically--, the Revision Date--
the code "%" is used to handle the date automatically--in addition to the page number. 



For example, the default locked Script header "~ Revision    -    %^#." would produce the 
following script header on page 4 of the WHITE draft printed on March 9, 1998:

     WHITE Revision - 3/9/98                            4.
· Print on Every Page - turns the Header on for EVERY PAGE including page 1.



Locked Headers in Production
Movie Magic Screenwriter can support Locked Headers in Production Scripts, 
thus maintaining the latest header text for each individual page.

You rarely need to concern yourself directly with the Locked Headers, as they are maintained 
automatically as part of the normal revision process, however should you want to do so, you can 
handle them "manually."

Locking the Script's Headers

You can lock the script's headers ONLY once the page breaks themselves are locked--as otherwise 
the concept is meaningless.

1 If you lock the script's Page Breaks from the Edit Script Format Menu, as soon as you exit that 
menu, the program will automatically prompt you "Lock the Headers?" and if you respond YES, 
it do it for you right then

2 If you lock the script's Page Breaks by using the Lock The Script Menu found under 
PRODUCTION, then one of the automatically checked options is ALL HEADER TEXT and 
unless you deliberately uncheck it, then when you press OK, it will lock the headers for you.

3 Finally, you can always MANUALLY lock the Script's Headers by clicking on the PRODUCTION
MENU, selecting FIX OR FLEX... then FIX (LOCK) HEADERS

Turning on or off the Auto-Update of Locked Headers

Once the headers are locked you typically want them to be automatically updated on only those 
pages where you have made a revision.    To have Movie Magic Screenwriter do this on-screen in 
real-time, simply ensure that the option AUTO-UPDATE LOCKED HEADERS ON REVISION is 
checked on the REVISIONS PAGE of the PROGRAM OPTIONS MENU.

If this option is not checked, then the program will not automatically update the headers when you 
make a revision.    However, when you go to print, it will ask you if you want it to update the headers 
of all those pages with revision marks on them, and if you choose yes, it will do it at that point.    
Generally, the only reason you'd ever want this situation is if you want to Cheat the Header Text on 
pages that have revisions on them, an extremely rare case!

I just changed my Header Text but it hasn't changed in the script!    What's going on?!

This simply means that you've locked the script's header text BEFORE changing the header so none
of the changes are beeing applied.    To fix this...

1 Okay, first change the Header Text by selecting FILE, then HEADER SETUP and changing the 
text as desired.    Press OK to accept the changes.

2 Now, click on PRODUCTION, then FIX OR FLEX... and select UNLOCK HEADERS.    Type 
YES at the prompt to accept.

3 Now, click on PRODUCTION again, then FIX OR FLEX... and select FIX (LOCK) ALL 
HEADERS.    Type YES at the prompt to accept and all the headers will be locked wIth the new 
text.

I just issued my revisions and need to set up for the next revisions, do I need to re-lock the 
Header?



If you use either the REMOVE ALL CURRENT REVISION MARKS or the NEXT REVISION 
functions, then the program will automatically re-lock the header text for you and you don't need to 
worry about it at all.

However, if you want to do it manually then...

1 Click the PRODUCTION Menu, select FIX OR FLEX then FIX ALL A-PAGES to convert any 
FLEXIBLE A-PAGES to FIXED A-PAGES.

2 Click the PRODUCTION Menu again, select FIX OR FLEX then FIX (LOCK) ALL HEADERS 
and they'll all be updated to the Locked Header.

I need to change the locked header text on an existing page, how do I do it?

NOTE: You can ONLY change (ie cheat) the text on a page that starts with a Locked Page break 
and which either has no revisions on it, or if the option AUTO-UPDATE LOCKED HEADERS ON 
REVISION is not checked on the Program Options Menu.    The reason for this is that if you did 
cheat the header on a page with revisions, your cheat would be overriden by the current header!

1 Given that you're in a situation where you CAN cheat the Header's text, place the cursor 
anywhere on that page

2 Click the Production Menu, then select Override then Page's Header/Draft Color and adjust 
it as desired.

3 Click OK to accept any changes and return to your script.



Megalex Macquarie Concise Dictionary
Movie Magic Screenwriter is proud to support the Megalex Macquarie Concise Dictionary, 
available from:

Eurofield Information Systems
PO Box 305
NORTH RYDE    NSW    2113

                            Australia

or on the web at:
 
                            http://www.eis.com.au

Once the Macquarie Concise dictionary is installed then a new option for it will automatically appear 
on the Spell Menu under the Word Web item.



Multimedia Run-Time Player
The Multimedia Run-Time Player is a separate program called RTPLAYER.EXE
which can actually "play" Multimedia scripts created in Screenwriter.

It is not copy protected and is a stand-alone program, allowing you to give a copy of the Run-Time 
Player and your script to anyone with access to Windows and they can play the game and even print 
out sessions as desired.    You are licensed to freely distribute the Run-Time Player along with your 
multimedia scripts as long as no fee is charged for such distribution.

Running the Multimedia Run-Time Player 
You can run it either as stand-alone by running the RTPLAYER.EXE directly or, if you're in a 
Multimedia script in Screenwriter, you can run it by selecting Play Multimedia Script on the FILE 
Menu or by clicking on the top speed button on the right speed bar, the one with the picture of two 
animated frames.

The Multimedia Player Screen
There is a Pull-down Menu at the top of the screen with two menu headings: FILE and DISPLAY.    
The File Menu has three sub-headings:

· Open - this option will be grayed out if the Run-Time Player was loaded automatically from 
within Screenwriter, otherwise clicking it will allow you to select which among all your existing 
multi-media scripts to open.

· Print Session - if you click this option, then it will print the session as you play the game until
you click it again or select STOP.    On the print-out It will show you the choices you made 
and give you the final results of all variables at the end.

· Exit - exits the Run-Time Player returning you to Screenwriter or Windows as appropriate.
The DISPLAY Menu also has three sub-headings:

· Current Variables - if checked, then it will display two windows at the bottom right of the 
screen, Variables which are True and Variables which are False.    As Variables are set, it 
will automatically move then from one window to another as appropriate, and you can also 
"cheat" them by dragging them from one window to the other.      This allows you to set up 
circumstances and play sections later in the game where the player already has certain 
possessions or knowledge.

· Variables to be Set - if checked, then it will display a floating Window which contains the 
variables (if any) that will be affected by the current user activity.    This allows you to see 
what's variables are going to be affected by any given choice.    You can roll this menu up by 
double-clicking on its heading which starts "IF USER CLICKS YES...".    It can also be 
displayed as a vertical or horizontal menu by right clicking on it.

· Select Display Font allows you to change the font/size used to display the active text in the 
main window.

The Main Window
This is immediately below the Pull-Down Menus and takes up slightly more than half of the Run-Time
Player's screen.    It is where the text of the script is displayed.    In the rare cases where the text runs 
off the bottom of the Main Window, a vertical scroll bar will appear so that it can be scrolled, and a 
prompt will inform you that there is more than one screen of text.

Control Buttons
There are four control buttons at the left under the Main Window which allow you to control the play 
of the script.    They use the standard video player button pictures and are:



· [PLAY] - this plays the script from the currently selected position in the script.
· [PAUSE] - this pauses the play, allowing you to cheat variables.    When you reselect PLAY, it 

allows you to start from the beginning of the Branch Target so that you can pause the script, 
change some variables then resume play at the beginning of the previous branch.

· [STOP] - will stop the play, resetting all variables to false, and displaying the list of available 
Branch Targets in the User Selection Box.    This can be extremely useful when you want to 
start from a specific point in the script.    To do so, press STOP, set the variables as desired, 
choose where to start playing and then press PLAY.

· [DISPLAY SOURCE] - will show the underlying "source" script so you can more easily see 
what's going on when the script isn't playing as you intended.

User Selection Box
This box will contain all the user choices -- either listing available Branch Targets or prompting the 
user with a User Activity.    In the first case, to perform a Branch, simply double-click on the Branch 
Target you want to branch to and it will perform that Branch and continue playing the script from 
there.      In the second case, click on YES or NO as desired and it will play the script from there as 
appropriate.



Multimedia Script Format
A script for a Multimedia project (CD ROM, Interactive Game, etc.) has to solve
a difficult problem, that of putting what is basically a non-linear process into 
an inherently linear form.

Movie Magic Screenwriter accomplishes this through a format designed specifically for Multimedia 
projects.    It is loaded by going to the FORMAT Menu, selecting Load Script Format and then 
Multimedia format.    See the section Typing the Multimedia Script for details on text entry.

Once the Multimedia formats are loaded, there will be several new options on the various menus and
three new element types that are unique to this format: 
BRANCH TARGETS, BRANCH POINTS and USER ACTIVITIES.

The New Menu Options are:

On the FILE Menu:

· Graph Branch Point which will graphically display the Branch Points for each Branch Target,
allowing to move through the script in a graphic environment in addition to actually 
adding/removing Branch Points and Branch Targets.    See Graphing Multimedia Scripts for 
more details.

· Play Multimedia Script which will load the Multimedia Run-Time Player and allow you to 
play your script as if it were a text adventure.

On the FORMAT Menu:

· Renumber All Branch Targets which will do just that.
Since each Branch Targets is numbered sequentially when it was added, if you add a new Branch 
Target between two existing Branch Targets then the numbering will get out of order.    

This is purely cosmetic as the numbers have no real meaning beyond functionning as a link between 
Branch Points and Branch Targets... however, if you find it confusing to have them out of linear order 
then run this function and it will re-order them from first to last, adjusting all the Branch Points' 
references as needed.

On the GOTO Menu:

· Branch Targets which will display a list menu of all currently available Branch Targets and 
instantly take you to the one you select.



Name Bank Menu
The Name Bank is a collection of 3,900 Male Names, 4,950 Female Names and 
22,000 Family Names designed to help you find interesting and unique names 
for your characters.

To Run the Name Bank

· Simply select Help, then Name Bank...
You can have lists of your personal favorites so that as you're looking through the names, if one 
strikes your fancy you can add it to a personal favorites list so that you won't forget it.

· Adding a Name to the Personal Favorite List - while on any of the Name Pages (Male, 
Female or Family) simply drag the name that you want to keep from the left Window into the 
Window labeled Personal Favorites.

· Removing a Name to the Personal Favorite List - while on any page simply 1) select the 
name you want to remove by clicking on it; and then 2) either dragging the name out of the 
Window labeled Personal Favorites and dropping it anywhere else, or simply pressing 
<DELETE>.



Omitting Pages/Scenes in Production
Movie Magic Screenwriter handle all the omitted Pages and Scene 
automatically, so it is rare that you'd ever need to modify them yourselves, 
however, should you need to do so, you're always in control.

If you're already in the middle of production and need help Trouble-shooting Omitteds, then please 
see that section, otherwise continue reading below:

Setting Movie Magic Screenwriter to track Omitted Pages and Scenes

Before Screenwriter can track all Omitteds, it must have that script's page breaks and Scene 
Headings Locked.    To do so:

1 Simply click the PRODUCTION MENU and select LOCK THE SCRIPT and click OK.    This, in 
one step, will lock the Scene Headings and Page Breaks.

...or, alternatively, do the following:

1 Click FORMAT then EDIT SCRIPT FORMATS
2 On the EDIT SCRIPT FORMATS Menu that appears, click the [LOCKED SCRIPTS] button
3 Under SCENE HEADINGS, click LOCKED
4 Under PAGE BREAKS, click LOCKED
5 Make any other changes as desired then press OK

Your script is now LOCKED, and any deleted Scene Headings and/or pages will now be 
automatically tracked as an OMITTEDs.

Changing the Automatic Scene Omitted Text

You can easily change the automatic Scene Omitted text from its default of "OMITTED" to "OMIT" or 
anything else you want.    To do so:

1 Click on the FORMAT Menu, then EDIT SCRIPT FORMATS
2 Click on the [LOCKED SCRIPTS] button
3 Edit the SCENE OMITTED TEXT as desired
4 Press OK to accept the changes and return to your script

NOTE: Changing the SCENE OMITTED TEXT will NOT affect any existing OMITTEDs, so if you 
have any already in the script, you MUST do a SEARCH and REPLACE to change them to the new 
text!!!

Setting the Program to either print Full Separate Omitted Pages or combine the numbers into 
a Run

Movie Magic Screenwriter gives you the option of having it print Omitted Pages with the words "THIS
PAGE IS OMITTED" or not printing that page but having the previous page's number being reported 
as a "run", (ie "23-24A). You select which of these options you want on a programmatic basis by 
doing the following:

1 Click FILE then PROGRAM OPTIONS



2 Click the [REVISIONS] tab at the bottom of the Program Options Menu that appears.
3 Check or uncheck the option PRINT SEPARATE FULL "PAGE OMITTED" PAGES as desired.
4 Press OK to accept your changes and return to the script



Open File Menu
Depending on the version of Windows that you're running, you'll see a slightly different menu:

Open File Menu in Windows 3.1
Open File Menu in Windows 95



Open Menu (Windows 3.1)
This Menu is where you go to open (or retrieve) scripts that you previously 
saved in Movie Magic Screenwriter, in addition to where you select any files 
that were written in other programs for importing.

Select Script - is where you can type in the name of the script and when you press the [OK] Button it
will retrieve it.

· Underneath that is a listing of all the scripts in the current subdirectory and you can scroll through
that list and double-click any of them to retrieve that script

File Type - lets you choose among the formats that Movie Magic Screenwriter knows how to read.    
If you choose anything other than a Screenwriter format, then it will automatically import it... see 
Importing Scripts for more details.

Path - allows you to change the subdirectory where it is looking for files

Drive Path - allows you to change the Drive where it is looking for files

There is a white rectangle underneath FileType and Drive which, when a file is selected, will display 
that file's Long File Name (if any) and the Date and Time that file was saved.



Open Menu in Windows 95
This Menu is where you go to open (or retrieve) scripts that you previously 
saved in Movie Magic Screenwriter, in addition to where you select any files 
that were written in other programs for importing.

· The long Edit Box at the top of is where you can type in the name of the script and when you 
press the [OK] Button it will retrieve it.

· Underneath that is a File List, listing of all the scripts in the current subdirectory and you can 
scroll through that list and double-click any of them to retrieve that script

· To the right of the File List is a Directory Tree where you can change directories
· Underneath the File List is File Type drop-down list where you can choose among the formats 

that Movie Magic Screenwriter knows how to read.    If you choose anything other than a 
Screenwriter format, then it will automatically import it... see Importing Scripts for more details.

· To the right of the File Type list is a Drive Selection Box where you can change the drive



Open Menu
The Open Menu has some different options if you're in Windows 95 versus 
Windows 3.1 select the appropriate operating system below for more details:

Open Menu in Windows 3.1
Open Menu in Windows 95



Override Page Break Type
This Menu allows you to change the page break type of the current page in a 
script with Locked or Multi-Locked Pages so as to change the current 
numbering.    It is gotten to by clicking on the Production Menu, selecting 
Override, then Page Break Type.

There will be four options on this menu, each of which will have a number following it.    That number 
is what the page break's number will become if you select that specific option.

· Flexible A-Page - this will convert the page break which starts the current page into a Flexible A-
Page,that is an A-Page which is not locked and which may actually be placed higher than the 
current page break if the preceding page is a short page.

· Locked-Page - this will convert the page break which starts the current page into a Locked Page
which is numbered normally without any A-Letters

· Fixed A-Page - this will convert the page break which starts the current page into a Fixed A-
Page, that is an A-Page which is locked and which will be placed exactly where the current page 
break is regardless of whether the previous page is "short" or not.

· Multi-Locked    Page - this will convert the page break which starts the current page into a Multi-
Locked Page which is numbered accordingly depending on the previous and following pages.



Override Scene Heading's Numbering
This Menu allows you to change the current Scene Heading's numbering.    It 
is gotten to by clicking on the Production Menu, selecting Override, then 
Scene Heading's Numbering.

There will be six options on this menu, the middle four of which will each have a number following it.   
That number is what the Scene Heading's number will become if you select that specific option.    The
first and last options do not have numbers because they are "No Numbering" and "Specify Manually"
respectively.

· No Numbering - this will convert the current Scene Heading to a Shot, thus taking it out of the 
numbering scheme and removing the numbers on either side of it

· Normal - this will convert the current Scene Heading to a normally numbered Scene Heading 
without any A-Numbering

· Locked - this will convert the current Scene Heading to a Locked Scene Heading (or A-Scene) 
so that it will be numbered accordingly

· Flipped Locked - this will convert the current Scene Heading to a Locked Scene Heading (or A-
Scene) so that it will be numbered accordingly, but with the numbers/letters flipped from the 
usual order

· Multi-Locked - this will convert the current Scene Heading to a Multi-Locked Scene Heading 
which will be numbered according to the previous and following Scene Heading types

· Specify Manually - this allows you to specify exactly what Scene Number you want this Scene 
to have and the program will correctly select the appropriate type to give it that number.



Overriding the Real-Time Spell Check
There may be some circumstances where you may want to override the real-
time spell check's autocorrection of capitalization, spelling, or sentence 
spacing and you have several ways of doing it:

If it's erroneously "correcting" the spelling of a word:

· Pause the real-time correction functions by going to the Spell Menu and selecting Pause Auto-
Correction, type the word as you'd like it spelled, then run the normal spell check and tell it to 
learn the word and then resume the auto-correction.    It will not "correct" this word in the future.

· Or, if this is not a word that you want the dictionary to learn, simply put the cursor at the 
beginning of the word and press <CTRL+DASH> which will put in a code that tells the real-time 
spell checking to ignore this one instance of this word altogether.

If it's erroneously "correcting" the capitalization of a word, or adding spaces between two 
words that should only have one space between them:

· Put the cursor at the beginning of the word (or the second word in the case of added spaces) 
and press <CTRL+DASH> which will put in a code that tells the real-time capitalization/spacing 
to ignore this one instance altogether.

· Or, if this isn't the first word in the element, put the cursor at the beginning of the word and press 
<BACKSPACE> to remove the leading space.    Now press <CTRL+ALT+SPACE> to put in a 
Hard Space instead.    This will tell the capitalization/spacing routines to treat this all as one word 
and not capitalize the initial letter.



Working with Page Breaks in Production
This section is designed for Trouble Shooting Page Break Problems in a 
production script, if you need more general information, see the section 
Movie Magic Screenwriter in Production

Something has happened and the Page Count is now wrong...

What most likely happened to cause the problem:

1 Someone inadvertently deleted a locked page break.    This can happen by pressing backspace
when the cursor is immediately following a page break and responding YES to the prompt that 
appears.

2 Someone made edits without first Locking or Fixing the script's page breaks, thus new text was 
added or deleted and it changed the page breaks, affecting all following numbers.

3 Someone inserted a Forced or Locked Page break--most likely by pressing [SHIFT+ENTER] 
and that affected the following page breaks.

What to do to fix it:

1 Find the LAST page in the script that is still being reported with its correct page number.
2 Go to the NEXT page break and determine what exactly the problem is.

NOTE: If possible, using a PRINTED COPY OF THE SCRIPT can be an invaluable tool in 
determining where, in fact the numbers get out of sequence.

Here are the most common problems:

· The Page Break is the wrong type - for example, it's an A-Page when it should be a normal 
page or vice versa.    To fix it, simply:

1 With the cursor anywhere ON the page whose number/page break type is to be changed, 
click on the Production Menu

2 Select Override then Page Break Type
3 Select the new appropriate Page Break Type and press OK

· The Page Break is in the wrong place.    This is typically caused by making edits without 
FIXING ALL A-PAGES first, Error #2 above.    To fix it...

1 If the bad page break is a FLEXIBLE A-PAGE, skip to step 4, otherwise...
2 Position the cursor on the first line of the page that starts with the bad page break
3 Click the Production Menu then select Remove then Locked Page Break and type YES 

at the prompt that appears
4 Position the cursor where you want the correct page break to go...
5 Click on the Edit Menu then Add Forced Page Break (or just press [SHIFT+ENTER])
6 Select the page break type that you need
7 Now verify that the following pages are in the right order and repeat as needed

· The Page Break skips a number, e.g. what should be page 46 is reported as 45.    This is 
typically caused by Error #1 above (deleting a page break).    To fix this...

1 Position the cursor at the beginning of the page whose number you need to fix
2 Click on the Edit Menu then Add Forced Page Break (or just press [SHIFT+ENTER]) 

and then select the page break type that you need to insert



3 Repeat as needed until the desired number is acquired
4 Now verify that the following pages are in the right order and continue as needed

· A Page Number is wrong, either too high or too low.    This is typically caused by having a 
page break being the wrong type--ie, either an A-PAGE when it should be a NORMAL Page or 
vice versa, and is actually symptomatic of other problems.    To fix it...

1 Find the last GOOD PAGE in the script
2 Working from a printed draft if available, compare the following pages until you determine 

where the problem actually starts
3 Now determine the real problem and go back to the top of this trouble-shooting section for

a solution
· I just locked my page breaks and I have a bunch of short A-Pages!    This is caused by 

Locking the Page Breaks and, at the same time, either changing the margins and/or line 
spacing of one or more elements and/or adding TOP CONTINUEDS.    You have two options as 
to how to fix it:

1 If it's important to keep the page breaks exactly as they're currently positioned, 
then go to FILE, SETUP PAGE LAYOUT and change the Top and Bottom MARGINS 
and/or the TEXT/BLANK LINE SPACING in order to accommodate the increased amount 
of text on each page.    Otherwise...

2 Simply go back to the EDIT SCRIPTS FORMAT MENU, select LOCKED PAGES and 
select UNLOCKED then OK, typing YES at the prompt that appears.    Now go back and 
LOCK the Page Breaks again.

· I have an FLEXIBLE A-PAGE that has just a couple of lines on it.    Is there anyway to 
squeeze it to the previous page?

NOTE: You should only follow this procedure if you haven't cheated the length of the same page 
earlier and if there are fewer then 5 lines on the A-Page, otherwise the previous page may become 
EXTREMELY cramped.

1 Put the cursor anywhere on the page IMMEDIATELY PREVIOUS to the Flexible A-Page
2 Click the Format Menu, select Cheat then Page
3 Select the number of lines needed to combine the page with the previous one.    Press OK

to accept the entry
4  If the number of lines you chose were insufficient to squeeze the text on the previous 

page then click the EDIT MENU then UNDO to undo the cheat.    Now go back to step 1 
above and try a larger number.

NOTE: If, after having cheated the Page Length, you find that the previous page is printing out too 
cramped, you can undo the cheating as follows:

1 Put the cursor anywhere on the page that is printing out too cramped
2 Click the FORMAT MENU, select RESET CHEATED then PAGE
3 On the Reset Cheated Menu, uncheck everything except LINE SPACING and then press 

OK to accept your changes.    It will then restore the previously cheated A-Page.



Pasting from Other Windows Programs
When Movie Magic Screenwriter interprets text produced by another program 
(such as when you open most non-Screenwriter files or cut & paste from 
another Windows Program), you'll see this menu.

· Import Text in Script Format - this will cause Movie Magic Screenwriter to interpret the pasted 
text as a script, and interpret all the elements accordingly

· Import Text as Action Only - this will cause Movie Magic Screenwriter to interpret all the pasted
text as just Action and not try and put it into script Format

Text Only (Non-RTF) - many programs pass text in the Windows clipboard in both Rich Text Format 
(RTF) and straight text--if you check this box, then Movie Magic Screenwriter will use the straight text
in the clipboard instead of the preferred RTF, and in some cases may produce a cleaner import but 
you will lose any bold, italics or underlining.    You'd generally only use this option if you'd tried to 
import the RTF and had problems.

Interpret Style Sheets - this option will only be available if you're reading an RTF script which has 
Style Sheets, such as one produced by Final Draft.    By checking this box, Screenwriter's importing 
routines will use any style sheet tags to identify any given paragraph rather than using its normal 
importing routines which may result in higher accuracy if the script is consistantly formatted with 
Style Sheets.    You will be prompted to identify any Style Sheets that are used which it can't figure 
out what element type they represent.

Use most agressive interpretation of the source text... - you almost ALWAYS want this box 
checked unless you are importing the cleanest ASCII format in the world as most scripts contain 
some inconstistancies, either from the way the script itself was entered or due to the export from the 
word procesor.    However, you can always try it once without it checked if desired, and if the results 
are unsatisfactory, try it again with it checked.

Don't use Capitalization Information for Element Identification.... - check this box if you know 
that in the source script Character Names are not capitalized when they have dialogue, or if you've 
tried to import a script and discovered that many names were not capitalized and it caused 
erroneous element identification.

Ignore Margins for Element identification - check this box if you know that in the source the 
margins were inconsistent or everything is flush left.    Also, if you try to import a script and get 
unsatisfactory results, trying it again with this box checked will often vastly improve the element 
identification.

Action is in Parentheticals "(" + ")" - check this box if you know that the action in the source script 
has parenthesis around it, a common sitcom format.

Import this Script with Locked Page Breaks - check this box ONLY if you are in the middle of 
production and need to have the imported script exactly match the original script's page breaks.    
This option will only work if the page break information was actually exported in the source text, 
typically done by printing the file to an ASCII Fiel.



Print Menu
This Menu is gotten to by pressing <CTRL+P> or by selecting Print on the File
Menu.

· Setup - at the very top of the Print Menu is a pull down menu which allows you to select the 
Windows Printer, configure your Fax Modem Software, set some specific Screenwriter Printing 
Options, setup Watermarks for Script Serialization, and setup Animation Dialogue printing 
formats.

Instead of the meager ALL or RANGE of pages that most programs offer, Movie Magic Screenwriter 
has twelve different options (plus several sub-options), each of which is selected by simply clicking 
on the option itself, at which point its radio box will get a dot in it.    These Twelve options are:

· Current Page - which prints the page that your cursor was on when you called up this Print 
Menu.

· Forwards - which prints all pages starting from with the page that your cursor was on when you 
called up this Print Menu through to the end of the script.

· Entire Script - which (much to your surprise I'm sure) prints all pages in the script, regardless of 
where the cursor was when you started.

· Blocked Text - prints only the text that was selected (ie blocked) when the Print Menu was 
selected.    Note that this option will be grayed out and unselectable if there wasn't any blocked 
text when the Print Menu was started.

· Selected Pages - prints the pages that you select.    Note that when entering in the page 
numbers, separate individual pages with commas, and use dashes to indicate runs (ie, if you 
want to print pages seven, nine, and eleven through fifteen, you'd enter 7,9,11-15) and you can 
end a run with the word end (like 79-end) which will cause it to print from the page that you 
specify through the end of the script.

· Selected Scenes - prints the scenes you select.    Like with Selected Pages, if you type in the 
scene numbers then separate each scene with commas, and use dashes to indicate runs.    You 
can also select the scenes from a list by clicking on the [List] Button and--needless to say--a list 
of all the scenes in your script will appear.    Click on the one(s) you want and then click on the 
bar that says "Click Here When Done".    Yeah, I know you'd have been able to figure that out 
yourself, but hey this IS a help file...

· Dialogue - when you select this option, you will immediately be taken to the Dialogue Printing 
Options Menu where you can select what dialogue to print and how to print it.    You can print the 
dialogue of either all characters in the script (ALL NAMES) or of a specific selected    character 
only.    In the latter case, it will also print out reference page numbers and statistics about the 
number of words and sentences that this Character speaks.    Select among (ALL NAMES) and 
the existing Characters in your script on the Pull-Down Menu to the right of the Dialogue Option.

NOTE: many writers find this feature useful to check consistency of language, and to ensure that 
the Character is not over-using certain words or phrases.

· Numbered for Animation - if checked then the Dialogue will print out in the formats 
specified on the Animation Dialogue page of the Setup Menu (described above);

· Asterisked Speeches Only - will cause it to only print those speeches which meet the 
selection criteria under Dialogue and which have a revision mark somewhere in them.

· Production Breakdowns - with this RadioBox selected, when you press [OK] or [FAX], it will 
take you to a Production Breakdown Menu where you can choose what type of Breakdowns you 
want.

· Asterisked Pages or Revision Color - if you have Locked the Script using the internal revision 
colors, this item will change to a drop-down menu with all available revision colors, and the 



current one selected.    Selecting any revision color then clicking [OK] will cause it print out all 
pages that are currently in that revision color, selecting Asterisked pages then [OK] will cause it 
to print all pages that have any Current Revision Marks anywhere on the page and any A-Pages 
immediately following them.

· Script Notes - when you click [OK], this will take you to a new Print Script Notes Menu where 
you can select which Script Notes to print and how to print them.

· Character List - when you click [OK], this will print an alphabetical list of all the characters in the 
script.

· Unique Location List - prints out all the scene locations in the script.
· Print Title Page - this option will only be available if you have created (or loaded) a title page in 

the Title Page Publisher.    When checked it will print that Title Page at the same time as the rest 
of the print job.    If you want to just print the title page without any text of the script, then you 
should do it directly within the Title Page Publisher itself.

Print Selection should Print in... - allows you to select the order in which the pages will come out of
the printer:

· Normal - print in normal order
· Reversel - will print in the reverse order of the print job, thus if you say print pages 1-10 it will

print pages 10 through 1. Use Reverse order for printers which typically require you to shuffle
the pages after printing such as the HP Deskjet or Canon BubbleJet, use double sided when 
you want to print on both sides of the pages.

NOTE: If you select Reverse Order, you should still enter the range of pages in normal order (eg 1-
7) and let the program take care of reversing them.

· Double Sided - this will print all the ODD pages first in normal order, then prompt you to 
reinsert the pages and it will then print all the EVEN pages in reverse order.    It expects that 
you'll reinsert them into a sheet feeder, but depending on how your specific printer handles 
the paper, you may have to do some experimenting to get it to work correctly.

Run SmartCheck before this Print Job - check this box to run SmartCheck before the print Job.    
(You can set whether this box is normally checked or unchecked on the Printer Page of the Program 
Options Menu.)

Create PrintThing Printer File instead of Printing Directly - see PrintThing for details.



Print Menu - Setup Fax Modem
This menu is gotten to by going to the Print Menu, selecting SETUP from the 
top of the Menu and choosing Setup Fax Modem.

You should FIRST install your Fax Modem and Windows Faxing Software prior to getting to this 
menu, however, once having done so, you should select the faxing software's print driver from the 
displayed list--it will typically be something like WINFAX ON FAXMODEM though depending on the 
software, it could be something compelete different--and press [OK].

FAX VIA INTERNAL SPOOLER - you should very rarely--if ever!--need to uncheck this option, 
especially if you are are using Windows95, as the internal spooler (FAXTHING.EXE) ensures that the
print job is sent to the faxing software in the most efficient manner, however, you CAN frequently 
uncheck this in Windows 3.1 without experiencing problems.



Print Preview Menu
The Print Preview Menu can be gotten to by clicking the [Preview] Button on 
the Print Menu, or by selecting Print Preview from the File Menu.

 The top bar of the Menu includes the following buttons:

[Print] - will print the displayed page (or the left page if you have it set to display two pages side by 
side).

[Prev] - will take you to the previous page in the script.    If you don't have the previous page this 
option will be grayed out.

[Next] - will take you to the next page in the script. If you don't have the next page this option will be 
grayed out.

[Close] - will close the Print Preview Window.

[1 Page] - will display one page at a time.

[2 Pages] - will display two pages side by side.

[Setup Page Layout] - will take you to Setup Page Layout Menu described later in this section.

[Zoom in] - zooms in on the previewed page in 1 Page Mode.    You can also left click on the 
previewed page to zoom in.

[Zoom out] -    zooms out on the previewed page in 1 Page Mode.    You can also right click on the 
previewed page to zoom out

The Bottom Status Bar displays the Current Page of the Document, the 
Current Zoom Level (100%=normal), and HintLabel that displays information on the object you point 
with the mouse.



Print Script Notes Menu
This Menu is gotten to by selecting the Print Menu then selecting Script Notes
and clicking either [FAX] or [OK].

There are two fundamental ways you can print your script notes:

· Print Notes Sequentially with Reference Page Numbers - which will print one or more pages 
with just the script notes on them in the order in which they appear in the script along with 
reference page numbers, so you can find the page on which the note was placed.

· Print Notes on facing pages of script (already printed script) - which will print the notes on 
the backs of the facing pages lined up with the element which the note preceded.    Thus if you 
have a note half-way down the page on page 4 of the script and you select this option, it will print
the note on the back of page 3, several inches down the page so it lines up with the element 
which follows the note in the script.    Any notes on page 1 will be printed on the back of the Title 
Page.

Depending on how many notes you have in the script, you can choose one of two additional 
options
· Have it prompt you to insert each page as needed - this is useful if you don't have that 

many notes, and it will simply prompt you to insert whichever pages are needed.
· Print without prompting - If you have a LOT of notes in the script, then choose this option, 

insert the entire printed script so that the title page is the first page to be fed, and the program
will print all the notes on the backs of appropriate pages, "printing" blank pages on those 
pages where there are no notes.

Select which note colors to Print:

· Since you have the option to have up to 25 different colored notes in the script, you can select 
which colored notes should be printed, and which should be skipped simply by checking or 
unchecking the available note colors.

See Changing Note Colors for additional information



The Print Menu's Setup Pull-Down Menu
(Found at the top of the Print Menu) has three options:

Printer - will take you to Windows' standard Print Setup Menu, where you can specify the printer you
are using, page orientation, paper size and source. For more information on this menu, check 
Windows Manual or Windows Help File.

Fax Modem - will allow you to select the fax modem that you have installed on your system.    
However, before you do this, you MUST have (A) a fax Modem installed in your computer and (B) a 
Windows faxing program (like WinfaxPro) installed and correctly configured before Movie Magic 
Screenwriter will be able to fax.    However, once these things are set up, then this Menu will allow 
you to tell Movie Magic Screenwriter what your Fax Setup is...

Printing Options - will open up the Printer Page of the Program Options Menu.



PrintThing™ - Your Portable Printing Solution
PrintThing is a program that ships with Movie Magic Screenwriter that allows 
you to view and print scripts on any computer that has Windows 3.1 or 
Window 95 without having to install the Movie Magic Screenwriter program!

To use PrintThing for Windows, you first have to "print" your script to a special PrintThing file
which you do as follows:

Step 1: Run Movie Magic Screenwriter and Open the script that you want to use with 
PrintThing.

Step2: Go to the Print Menu just as if you were going to print the script.    Select Entire 
Script (you can select just a range but since you can choose which pages to print from within 
PrintThing, this just limits your options).

Step 3: Check the CheckBox Create PrintThing Printer File Instead of Printing Directly 
and press [OK].

When it is done creating the PrintThing Printer File it will tell you the name and subdirectory of the 
file--which will be in the default Script Subdirectory and have the same first name as the script and a 
number    as the extension--and you can exit Movie Magic Screenwriter at this point.

Using PrintThing for Windows on another computer - because PrintThing for Windows uses the 
standard Windows' print drivers and is a self-contained program, the ONLY files need to use it are 
the PRINTHNG.EXE file itself and the PrintThing Printer File (created as described above) that you 
want to view/print.

Running PrintThing for Windows -    select the FILE Menu from the Program Manager (or click the 
[START] Button if you're in Windows 95), select RUN and type in PRINTHNG (specifying the drive 
and path as appropriate) and press <ENTER>.

PrintThing will load, and display a file/directory list which initially displays the subdirectory that 
PrintThing was run from.    Change subdirectories as needed and select the PrintThing Printer File to 
view and/or print and either double-click on the file name or click the [VIEW/PRINT] button to get to 
the PrintThing Viewing Window.

The PrintThing Viewing Window - has two bars, the top one with buttons for the following features:

· [PRINT] - displays the standard Windows Printing Dialog where you can select what pages to 
print--either ALL or a RANGE (ie 1-5)--and change the printer if needed

When selecting a range of pages, the page numbers refer to the "physical" page of the PrintThing 
file which may not correspond to the printed page number if the PrintThing file contains less than a 
full script or starts on a page number other than 1!

· [PREV] - if the first page of the PrintThing file is not already displayed, then you can click on this 
button to display the previous page, otherwise it will be grayed out.

· [NEXT] - if the last page of the PrintThing file is not currently displayed, then you can click on this
button to display the next page, otherwise it will be grayed out.

· [ZOOM IN] - will increase the zoom of the on-screen page--clicking the left mouse button on the 
page will also zoom in



· [ZOOM OUT] - will decrease the zoom of the on-screen page--clicking the right mouse button on
the page will also zoom out

· [CLOSE] - will exit the current PrintThing Printer File and return you to the file selection menus
· [1]/[2] - switch between single and double page display modes -- note that with two pages 

displayed, you cannot zoom in/out
· Top Margin Buttons [+]/[-] - the next two buttons allow you to increase or decrease the top 

margin to accomodate the differences between printer's minimum top margins
· Left Margin Buttons [+]/[-] - the next two buttons allow you to increase or decrease the left 

margin to accomodate the differences between printer's minimum left margins
On the bottom of the screen, there are an additional five buttons:

· [<<] - will take you to the beginning of the PrintThing file
· [<]      - will take you to the previous page of the PrintThing file
· [>]      - will take you to the next page of the PrintThing file
· [>>] - will take you to the end of the PrintThing file
· [#]      - will pop up a Goto Page Menu which allows you to go to any specific page of the 

PrintThing file



Production Breakdown Menu
You get to this Menu by selecting Production Breakdowns on the Print Menu 
and then pressing either FAX or OK.

NOTE: The production breakdowns will list each Scene with its Scene Number, Scene Heading 
Text, Starting & Ending Page Number, and Page Count in Eighths of a Page, and optionally a listing 
of All Characters in the scene to aid in your scheduling of the shoot.

Sort Breakdown Primarily by...

· Script Order - means that it will print the breakdown listing all the scenes in the order of the 
script without any sorting nor do any Time-of-Day Normalization

· Interior VS. Exterior - means that it will sort all the scene headings to group all the 
INTERIORS and EXTERIORS together.

· Location - means that it will first group all the scene headings that use the same location, 
then sort those Location groups into alphabetical order so it will first print all the scenes in the
ALLEY, then those in the BARBERSHOP and so on.

· Time of Day - means that it will first group all the scenes that take place in the same Time of 
Day, then sort those Times of Day groups into alphabetical order so it will first print all the 
DAYS, then all the NIGHTS...

· Character Names - means it will sort the scenes by which Characters are in them, listing the 
Character Names in alphabetical order followed by all the scenes that each Character is in.
· All - will print this Character Name breakdown for ALL Characters in the script
· Some - when you press OK, it will let you select which Characters it should generate this 

breakdown list for
· Movie Magic® Scheduling(File) - will generate a breakdown file in the '.SEX' (Scheduling 

Export) format which can be directly imported into the Movie Magic Scheduling program.    It 
will translate all the normal breakdown data including any items which you've tagged for 
Breakdown Export.    When you select this option and then click the OK button, you'll be 
taken to a screen where you can select to export the data for either all the scenes or only the 
ones you desire.

NOTE: This Movie Magic option will be grayed out if you're doing a print preview as it's not a 
prevewable format...

· Script Breakdown Sheets - will print script breakdown sheets with all the normal breakdown
data including any items which you've tagged for Breakdown Export.    It will layout the sheets
as you've designed them in the Breakdown Sheet Layout Screen. When you select this 
option and then click the OK button, you'll be taken to a screen where you can select to 
export the data for either all the scenes or only the ones you desire.

Secondary Sort by... (allows you to specify how you want the scenes sorted within the primary 
groupings -- note if you select Script Order, or Movie Magic as the Primary Sort, you won't be able to 
select a Secondary Sort)

· Script Order - the default secondary sort which doesn't reorder anything within the primary 
grouping

· Interior VS. Exterior - will sort the primary groups by Interiors and Exterior so that if your 
primary sort is location and your secondary is this, it will sort all the EXT. BARBERSHOPS 
together and the INT. BARBERSHOPS within the primary group BARBERSHOP...

· Location - will sort the primary groups by location



· Time of Day - will sort the primary groups by Time of Day
Calculate Eighths by... (allows you to specify how you want Screenwriter to define an 1/8th of a 
page.    Historically, an 1/8 was always an inch (6 lines), but as most people nowadays are allowing 
more than 48 lines on a page, Screenwriter gives you a choice between the standard 1/8th or a 
"truer" 1/8th.)

· Standard - 6 lines = 1/8th - this option, if selected, will tell Screenwriter to define an eighth 
of a page as that good old historical standard of 1" (6 lines).    If you have more than 8" of text
on a page, however, it then becomes possible for a page to be longer than 8/8ths and this 
may produce some inappropriate results.

· Adjusted - 7 lines = 1/8th - this option, if selected, will tell Screenwriter to define an eighth of
a page as the total allowable lines on a page divided by eight which, when rounded, becomes
7 lines.

Display Eighth Totals by... (lets you specify how you want Screenwriter to calculate the totals for 
each grouping, because if it simply adds up the displayed totals for each scene, it accumulates 
rounding).

· Totals of All Rounded Eighths - Screenwriter will simply add up the displayed length of 
each scene in that group.

· True Total of All Lines - Screenwriter will add up the actual number of lines in each scene, 
then convert that total into eighths, thus producing a more accurate total.

Miscellaneous Options...

· List Characters in Each Scene -which, if checked, will cause it to list all the characters that 
are in any given scene (whether they have dialogue or not!) directly underneath the Scene 
Heading in the breakdown.
· Sorted Alphabetically - will list all the characters in any given scene in alphabetical 

order.
· Script Order - will list all the characters in any given scene in the order in which they 

appear in that scene.
· Speaking Characters First - will list all the characters in any given scene in the order in 

which they speak in that scene, then followed by any Characters who are there but have 
no dialogue.

· User List Order - will list all the characters in any given scene by first listing any 
Character who is in the User List (and those in the order that they are listed in the user 
List) then followed by any other Characters in alphabetical order.

· Each Group on New Page - this option will be grayed out if you've selected Script Order as 
your primary sort, otherwise, if checked, will start each group at the head of a new page.

· Graph Breakdown - when checked, this will cause Movie Magic Screenwriter to print out the
selected Breakdown in a bar chart layout rather than just as text.

NOTE: This option will be grayed out if you're doing a print preview as the graphs are not a 
prevewable format...

· Print Tagged Items - this Radio Button will only be available when you've tagged items in 
the script, and then, if checked, will cause it to print or export all tagged items in addition to 
the normal breakdown information.

NOTE: Although you CAN check the Print Tagged Items when sorting by Character Names, we 
don't recommend it as you will get a lot of duplicated information.



Production Breakdown Scene Selection
You will be taken to this menu if you select the Movie Magic Scheduling Export (found under 
Breakdown Tagging on the Edit Menu), or select either Movie Magic Sceduling (file) or Script 
Breakdown Sheets on the Production Breakdown Menu.

If you've gotten to this menu because your printing Script Breakdown Sheets there will be two 
additional items at the top of the screen:

· Production Company - where you can enter the name of the production company or producing 
entity

· Prod. Title / No. - where you can enter the name of the script and any production number
In the main section of the menu, there will be a list of all the scenes in the script followed by two radio
buttons:

· Selected Scenes Only - this radio button will be checked automatically if you select scenes in 
the main scene list of the menu (which you do simply by clicking on them) and, if checked, then 
the program will only print / export the breakdown information for those scenes.

· All Scenes in Script - this radio button will be checked automatically if you have no selected 
scenes in the main scene list of the menu    and, if checked, then the program will print / export 
breakdown information for all scenes in the script.

If you've gotten to this menu because your printing Script Breakdown Sheets there will be an 
additional button at the bottom:

· [Setup Breakdown Sheets] - click this button to be taken to the Breakdown Sheet Layout 
Screen where you can edit the category headings and groupings for the Breakdown sheets.



Production Manual Override Control
You can override most anything in Movie Magic Screenwriter, so select the 
appropriate option below:

NOTE:    The first three options below, Page Breaks, Scene Numbers, and Locked Header Text 
can all be directly overriden by going to the Production Menu, and selecting the Menu Option 
OVERRIDE and letting the program do the "dirty work," or you can handle it a little more manually if 
desired and the information to do that is below:

Page Breaks
Scene Numbers

Locked Header Text
Individual Character Continued

Individual Page Length
Total Script Length



Scene Numbers in Production
This section is designed for Trouble Shooting Scene Number/Heading 
Problems in a production script, if you need more general information, see the
section Movie Magic Screenwriter in Production

Something has happened and now my Scene Numbering is wrong...

What most likely happened to cause the problem:

1 Someone inadvertently completely deleted a Scene Heading.    This can happen by pressing 
backspace when in a Scene Heading and    completely deleting the entire text of the scene 
heading then pressing backspace again.    It will then prompt you, asking if it should completely 
remove the Scene Heading and if you respond YES, it will do so.

2 Someone made edits without first Locking or Fixing the script's Scene Headings, thus new 
Scene Headings were added, or old ones deleted and it affected all following numbers.

3 Someone converted an existing Scene Heading from one type to another--changing an A-
SCENE or a NORMAL ONE or vice versa, thus affecting all existing numbers.

4 Someone cheated an existing Scene Heading's number, and that cheat affected all existing 
numbers.

What to do to fix it:

NOTE: If possible, comparing the on-screen version with a PRINTED COPY OF THE SCRIPT can 
be an invaluable tool in determining where, in fact, the problem is, as often a number out of 
sequence may be caused by something happening to the previous Scene Heading rather than the 
one in question.

If you're sure you know where the problem is then just skip to Common Problems below, otherwise...

1 Find the LAST Scene Heading in the script that is still being reported with its correct scene 
number.

2 Go to the NEXT Scene Heading and determine which of the following cases is the problem:
Common Problems:

· The Scene Heading is the wrong type--either an A-SCENE (eg 34A) and it really should be the
next normal number in the sequence (eg 35), or it is a NORMAL SCENE and it should be an A-
SCENE.    This is usually caused by someone deleting a Scene Heading (Error #1 listed above) 
and then attempting to put it back in.    It can be easily fixed by...

1 Positioning the cursor anywhere within the Scene Heading in question
2 Click Production, then Override then Scene Heading's Numbering
3 Select the option that sets the number to the desired Scene Number
4 Click OK and the number will all following Scene Headings will be re-numbered 

accordingly.
· The Scene Heading is the right type--either an A-SCENE (eg 34A) or a NORMAL SCENE 

(eg 35)--but it has the wrong number. This can be caused in several different ways: by 
someone erroneously changing a previous Scene Heading's type (Error #3 listed above), by the 
complete removal of a previously existing Scene Heading, by the addition of a Scene Heading of 
the same type before this Scene Heading, or by the cheating of the Scene Number of either this 
Scene Heading or one previous.



1 The first step is to determine which of these possible events caused the problem.    To do 
so, go back to the Scene Heading(s) immediately previous to this one and make sure that
(A) They are all actually there; (B) They are all of the correct type (ie A-SCENES or 
NORMAL SCENES); C) That their numbers are all in sequence

2 If you find any errors in 1A-1C you should correct them and then repeat, verifying that you
still have a problem--as fixing an error in 1A-1C will most likely clear up your problem 
here.

3 If there were no errors in 1A-1C or you fixed all such errors and you still have a problem, 
then the Scene Heading in question either has a cheated number, or the number of a 
previous scene has been cheated.

4 The quick solution at this point is to put the cursor anywhere in the Scene Heading in 
question

5 Click on FORMAT, then CHEAT, then ELEMENT--or simply press [F3]
6 If Override Scene Number already has a checkmark in it, then try UNCHECKING it and 

pressing OK.    If that doesn't solve the problem go back to Step 5 and continue onwards.
7 Check Override Scene Number and set it to the desired number then press OK
8 Verify that you have not messed up the following Scene Headings' numbering.    If you 

have, then either cheat the following Scene Heading's number to get it back into 
sequence or verify that you REALLY needed to cheat this one at all, and uncheat it if you 
determine that this is the case.

· I need to remove an Scene Heading (typically an A-Scene) that was accidentally put in 
without creating an OMITTED

1 Place the cursor anywhere in the Scene Heading
2 Click on the Production Menu
3 Select Remove, then Scene Heading w/o OMITTED
4 Type YES at the prompt that appears.

· I need to move an existing Scene Heading, but when I try to do so, it creates an OMITTED 
and puts it back in as an A-SCENE!    You have two options:

1 Having moved the Scene Heading normally, (A) Delete the OMITTED Scene Heading that
was produced as described immediately above in "I need to remove...", and then (B) 
Convert the new Scene Heading back to its correct type by following the instructions in 
"The Scene Heading is the wrong type" listed above; or...

2 Select the entire Scene Heading and nothing else, then, using the mouse DRAG'N'DROP 
the Scene Heading to its new position.    For this to work, you MUST select the Scene 
Heading in its entirety and no other text, and you MUST use the Drag'n'Drop function not 
cut and paste.

· I need to flip the ordering of the A-Scene Number from 12A to A12 (or something like that),
for just this one scene.

1 Click on FORMAT, then CHEAT, then ELEMENT--or simply press [F3]
2 Check Override Scene Number if it's not set already
3 Check Flip Numbering for this One Scene, and/or change the Number/Letter of that 

Scene as needed then press OK
4 Verify that you have not messed up the following Scene Headings' numbering.    If you 

have, then cheat the following Scene Heading's number to get it back into sequence via 
steps 1-2 above.



Setup Page Layout Menu
You can get to this Menu by selecting Page Layout from the File Menu from 
Main Menu Bar.

Top Margin - the number in this field is the distance in units of inches that Movie Magic Screenwriter 
should put between the header (see Header Setup below for more information) and the top of the 
page.

Bottom Margin - the number in this field is the distance in units of inches that Movie Magic 
Screenwriter should put between the last line on the page and the bottom of the page.    

Binding Adjustment (Binding Margin) - due to the variation in paper position among printers, this 
value is given to allow you to shift all of the printed text to the left or right to allow for binding.    Like 
all the other values on this screen, the units for this are also in units of inches, although unlike the 
others, this can go to a negative value.

Text Line Spacing/Blank Line Spacing - this unique feature allows you to stretch or shorten your 
script by increasing or decreasing Text Line Spacing/Blank Line Spacing value from 85% to 115%. 

Approx # of Lines on Page - this number is automatically calculated depending on the adjustments 
you make but is only approximate as you can cheat line spacing and fonts and so on

Current Total Page Count - this number is also automatically calculated depending on the 
adjustments you make.

Stretch Short Pages to Fill - this check box allows you to stretch short pages specifying what is 
considered to be a short page (Short by a min. of) and by how many lines it should be stretched 
(Stretch by max. of) to make short pages look better. 

Save as Defaults for New Scripts - this check box let you save the current options to be used as the 
settings for all new scripts.



Production Revisions - Trouble Shooting
The following items will take you to specific trouble-shooting suggestions:

Page Breaks in Production
Scene Numbers in Production

Omitting Pages/Scenes in Production
Revision Draft Colors in Production

Locked Headers in Production
Production Manual Override Control

Once you solve your immediate problem, we also SINCERELY RECOMMEND 
that you read the following sections for a full understanding of Production 
Revisions using Movie Magic Screenwriter.

Movie Magic Screenwriter In Production
The Production Revision Standard

The Production Revision Cycle
Automated Revision Draft Colors



Program Options Menu - Editing Page
Text Entry/Editing

· Allow Typeover - if checked then you can toggle between Insert and Typeover modes. If this
item in not checked, you will always be in Insert mode and pressing the <INSERT> key will 
not change it.

· Undo Levels - allows you to set how many levels of Undo the program should support.    
Values can range from zero (0) which means no Undo support to ten (10) which means that 
at any moment you can undo up to the last ten text changes.    The only reason to set it to 
less than ten is if your computer has a marginal amount of memory for running Windows or 
Windows 95 and you want to maximize the available memory.

· Enable Alt-Keys for Character Name Entry - if checked, when you press <ALT>+ a letter it
will put in the first Character Name that starts with that letter and leave you in Dialogue.    If 
the name it puts in is not the name you want, then simply press <ENTER> and a list of all 
existing names that begin with that letter will pop-up.    Select the one you want and from then
on--until you change it--that selected name will be the one that pops up when you press 
<ALT>+ that Letter.    The drawback to this is that you will NOT have access to the Main 
Menu Bar with the normal Windows Alt-Keys and will have to use the mouse to select Menu 
Items.

· Selecting Bold, Italics or Underline turns off Block - if checked, then when you select text
and then press one of the Text Style keys or buttons, the selected text will have that style 
applied and then the block will be turned off.    If you want to select multiple text styles for the 
selected text (such as Bold and Italics) then you can hold down the <SHIFT> key when 
making the first text style selection and the block will not be turned off.    With this 
unchecked, then selecting text styles will never turn off the block selection and you'll have to 
turn off the block yourself.

Element Movement

· Enter in Dialogue takes you to Character name - when checked, then if you press <ENTER> 
when in Dialogue, it will take you to a new Character Name instead of action.    At this point you 
can start typing in the name you want or if you DO want to go to Action, then simply press 
<ENTER> again and you'll be taken there.    When this option is not checked, then pressing 
<ENTER> in dialogue will take you directly to action.

· Enter in Script Note adds Hard Return - when checked, then if you press <ENTER> when in a 
Script Note then it will add a Hard Return rather than take you out of the Note.    To exit the note, 
you'd need to either press <CTRL+ENTER> or <TAB> or any other explicit new element key.    
When this option is not checked, then pressing <ENTER> in a Script Note will take you directly to
action.

· Tab in Dialogue takes you to Parenthetical - when checked, then if you press <TAB> when in 
Dialogue, it will take you to a new parenthetical instead of a Character Name.    At this point if you
want to go to a Character Name, simply press <TAB> again and you'll be taken there directly.    
When this option is not checked, then pressing <TAB> in dialogue will take you directly to a new 
Character Name.

· When Parsing Scene Headings for Location Lists, only strip Known Timest - when this is 
checked and the program pops up the lists of unique locations, it will ONLY remove Times of Day
that are in the Time of Day User list, otherwise it will strip everything following the appropriate 
number of dashes.    Only check this option if the program is stripping more than you want on the 
pop-up list.

· Display ???? on screen in place of Courier New (TrueType) Font - allows you to select 
another font that should be used in place of Courier new in the display of text on-screen only.  
This does not affect the printed page at all, and you can use this if you have trouble reading 
Courier New on the screen.





Program Options Menu - Keyboard Page
Keyboard Options

As the biggest difference between most word processors are their editing keys, Movie Magic 
Screenwriter lets you configure them to the ones you are most used to pressing.

Deletion Keys

· Delete Word - allows you to choose among the available keystrokes to delete the word that 
the cursor is currently on.

· Delete Left Word - allows you to choose among the available keystrokes to delete the word 
to the left of the one that the cursor is currently on.

· Delete to End of Line - allows you to choose among the available keystrokes to delete from 
the cursor position through to the end of the line.

Movement Keys

· Go to Top of Script- allows you to choose among the available keystrokes to choose the 
ones that should take you to the top of the script.

· Go to Bottom of Script- allows you to choose among the available keystrokes to choose the
ones that should take you to the very bottom of the script.

Cut and Paste Quick Keys are... (allows you to choose among the two "competing" standards for 
Windows Cut & Paste)

· Shift+Del & Shift+Ins - if checked then cut is <SHIFT+DEL>, copy is <CTRL+INS> and 
paste is <SHIFT+INS>

· Ctrl+X & Ctrl+V - if checked then cut is <CTRL+X>, copy is <CTRL+C>and paste is 
<CTRL+V>

NOTE: if you select this latter option, then <CTRL+V> will obviously no longer change to View As 
Index Card Mode, and to select it you'll have to use its Speed Button or the menu item on the 
Window Menu.

Alt+Ctrl Keys - Will Override ALL other settings

This option allows you to set any <CTRL>+ Letter or <ALT>+Letter key combination to virtually any 
common editing function simply by selecting the key combination on the left hand window as desired,
then selecting what that combination should do on the right hand window.

[Clear Out All Alt/Ctrl Key Overrides] - pressing this button will clear out any existing Alt/Ctrl Key 
overrides if you type YES to the verification prompt that appears.



Program Options Menu
This Menu is where you configure how the program itself looks and works and is found under the 
Edit Menu.    If you want to change how the script itself looks, then go to the Edit Script Formats 
Menu found under the Format Menu

There are ten Pages on the Program Options Menu, though you may have to click the right arrow at 
the far right side of the tabs to view the last tab:

Editing
Startup/Files
SmartCheck
SpellCheck

Misc.
Revisions

Printer
Keyboard

Mouse
Multimedia



Program Options Menu - Startup/Files Page
The first option on this page allows you to specify what Movie Magic Screenwriter should do when 
you first run the program on any given day:

At Startup of Screenwriter it should...

· Leave You in a Blank Script - which, surprisingly enough, does just that.
· Display Screen-Sized Retrieve List - which will use the entire screen and display all the 

scripts in the default Script Directory allowing you to load the one you want simply by double-
clicking on it.

· Display Open File Menu - which will automatically show the Open File Menu just as if you'd 
selected Open from the File Menu.

· Retrieve Last Script you worked on - which will automatically retrieve the last script you 
actually saved.

· Restore Last Workspace - which will restore all windows that were open when you last 
closed Movie Magic Screenwriter, restoring their size and position in the process

[Setup Script Directory] Button - click here and it will display the Set Directory Menu, where you 
can set the directory that Screenwriter will use for saving and retrieving scripts unless you specify 
otherwise.

[Setup Backup Drive] Button - click here and it will display the Setup Backup Drive Menu, where 
you can set the drive that Screenwriter will use for backup up scripts when you save/exit after having 
made changes.

Timed Backup Frequency - allows you to set how frequently Movie Magic Screenwriter should do a
Timed Backup.    If you set this value to 0 or anything greater than 60, it will be automatically reset to 
60 minutes.

NOTE: This timed backup DOES NOT OVERWRITE your script on the hard drive and you MUST 
choose to save your script when you exit if you want to keep the changes you've made!      The 
Timed Backup is designed to protect you against power failures, computer lock-up and the like.    It 
is NOT a useful back-up to protect you against hard disk problems because (1) there is only one 
timed back-up per open Window, so if you are working with more than one script then it will only 
contain the latest script you've been working on; and (2) because it is also on the hard drive and if 
you have hard drive problems it will also be affected.

Password Protect Scripts - when this options is checked, then Movie Magic Screenwriter will 
prompt you for a password when you Save/Retrieve scripts.    This can be dangerous, as if you forget
a password, you will not be able to open, read, print or otherwise access your script.    Use this 
function at YOUR OWN RISK!!!!    When you check this box, you will be required to type YES to verify
that you understand the potential consequences.

When Opening a script, start at last saved Position - when you open a script (or Screenwriter 
does it automatically for you) it can either leave you at the top of the script--which is what it will do if 
this is not checked--or it can leave you exactly where you were when you last saved it--which is what
it will do if this is checked.

Use    ".SCR" Extension or Use ".STW" Extension - this option allows you to specify what the 
default extension for scripts should be.    It won't affect the functionality of the program at all, just how 
it names the files.





Program Options Menu - SmartCheck Page
SmartCheck™    Options

Automatically Run SmartCheck before Printing - if checked then whenever you go to the Print 
Menu, the option Run SmartCheck before this Print Job will be checked, otherwise it won't be.    In 
either case, you can always check or uncheck it at that time to have it run or not run SmartCheck.

Beep on Found Formatting Error - turns on/off a beep sound when SmartCheck finds something 
you should be aware of.

Delete WITHOUT prompting...

· Single Starting Blank Space - if checked then whenever SmartCheck finds an element that
starts with a single blank space--a common typing error--it will automatically delete the space

· Completely Blank Elements - if checked then whenever SmartCheck finds a completely 
blank element, it will automatically delete the entire element

· Character Names without Dialogue - if checked then whenever SmartCheck finds a 
Character Name followed by anything other than Dialogue or a Parenthetical, it will 
automatically delete the entire Character Name element.

· Second Character Name when he/she speaks twice in a row with nothing between the 
two speeches - if checked then whenever SmartCheck finds a Character who has two 
speeches separated by only Action or by nothing at all, then it will automatically delete the 
second Character Name element.

NOTE: if SmartCheck finds any of the above errors and you don't have the respective "Delete 
WITHOUT prompting..."    option checked, then it will display a prompt with helping hands pointing to
the error and ask whether it should fix it.    Also, when SmartCheck is run automatically as part of the
printing process, if it doesn't find any errors (or is told to skip or fix the ones it does find), when the 
check is finished, it will simply start printing without any additional message.    If it was run from the 
Format Menu, however, then it will tell you that it has completed the format check when it is done.

· Ignore Blank Lines which have Revision Marks - if this option is checked then if 
SmartCheck finds a blank line but that blank line has a revision mark, it will NOT stop and try 
and fix it.

· Combine OMITTEDS that are Widowed on page - if this option is checked and you're in a 
script with locked page breaks, then if SmartCheck finds a page that ONLY has an SCENE 
OMITTED and it is either followed or preceding by another Scene Omitted, then it will ask 
you if it should combine them so that you won't have to issue a page with only an omitted 
Scene Heading on it.



Program Options Menu - SpellCheck Page
Spell Check Options

Correct Double Capitals (eg "MIstake") - when checked then both the Real-Time Spell Checking--
if enabled--and the normal spell function will find and correct capitalization errors where the first and 
second letters are capitalized but the rest of the word is not

Spell Check as you Type & Edit (Required for the use of Character Name Aliases & 
Substitution Text) - with this checked, you can turn on/off any or all of the following options: Auto-
Correction of Typos, Auto Sentence and Character Name Capitalization, Auto-Spacing of Sentences,
and use Alias Text and Substitution Text.    If this is NOT checked, however, then the normal spell 
checking function can still auto-space and auto-capitalize sentences, and fix capitalization errors if 
desired.

Auto-Correct Typos as you type (Real-Time Spell Checking) - if checked, then an auto-correction 
function will auto-correct letter inversion typos, so if you type "wnat" it will correct it to "want" but if 
you type "wnt" it will not correct it for you.    You can also set the Maximum Length of a misspelled 
word to auto-correct if you're finding that it's creating too many incorrect "corrections".

Auto-Capitalize

· Sentences - will automatically capitalize the first letter in the first letter of all sentences in 
Dialogue, Action, and Script Notes,    both in the real-time and normal spell check functions.
· Except Immediately Following Shots - with this option checked, the auto-sentence 

capitalization won't capitalize the first letter of action lines following shots, a form used by 
some writers.

· Character Names - will automatically capitalize the first letter all Character Names in the Real-
Time Spell Checking functions only.
· All Caps - with this option checked, then it will make Character Names ALL CAPS rather 

than just capitalize the initial letter.

NOTE:    For a character's name to be autocapitalized the character has to have some prior 
dialogue or it has to be in the Character Name User List.

Auto-Space Sentences to ?? Spaces - if checked then it will enable auto-spacing of all sentences 
both in the real-time and normal spell check functions, and allows you to set the number of spaces 
that it should maintain between sentences that the program formats automatically.

Treat ")" as a Sentence End in Dialogue for the purposes of Auto-Capitalization and spacing - 
if checked and you have Parentheticals as part of dialogue rather than as a separate element, then 
when you press the right parenthesis ")", it will treat that as a sentence end, spacing and 
capitalizating the next    word according to the other settings on this menu.

Correct Capitalization/Spacing when run normally - when this option is checked and you run a 
normal (ie, non-Real-Time) Spell Check, then it will still find and correct capitalization and spacing 
errors at the beginning of sentences according to the rules specified elsewhere on this page.

Ignore Capitalization when checking words - when this option is checked the spell check will NOT
prompt you on capitalization errors like "california" instead of "California".



Program Options Menu - Misc Page
Miscellaneous Options

Disable Warning Prompts (Expert Users Only) - Movie Magic Screenwriter will normally put up a 
prompt warning you when you try and do things like exit scripts without saving to make sure you 
know what you're doing--if you're brave and don't want these prompts then simply check this box.

Show Open/Save Progress - when checked shows the box with a bar indicating the progress from 
0-100% when you open or save a file, however, displaying this progress slows down process so you 
can uncheck this for the fastest retrieving/saving possible but in that case, you'll just see a "Please 
Wait" box until it's done.

Show Cut/Paste Progress - when checked shows the box with a bar indicating the progress from 0-
100% when you cut or paste large chunks of text, however, displaying this progress significantly 
slows down the process so you can uncheck this for the fastest cutting/pasting possible but in that 
case, you'll just see a "Please Wait" box until it's done.

Display Headers/Footers on Screen (WYSIWYG)    - when this is checked you will see a 
WYSIWYG display of all Headers, and Top & Bottom Continueds (as selected) in your script with the 
result of somewhat less of the actual text visible. With it not checked, the Headers and Top & 
Bottom Continueds will not be displayed on screen though they will still print.

Display Page Break Type on Screen - with this option checked, Screenwriter will display the 
current Page Break Type if it is anything other than a normal page break (ie it's Locked, Forced, a 
Flex A-Page, etc.) on that page break itself.    This does not affect printing at all.

Clicking on Right Scroll Bar Moves by Screen - with this option checked, when you click above or 
below the scroll tab (the square in the middle) of the Right scroll bar (the up/down one) it will move 
you up or down by a screen--with this option not checked, it will act as if you'd dragged the scroll tab 
to that position, giving you instant Random Access Scrolling to anywhere in the script with a single 
click.

NOTE: Whichever option you choose, if you press the <CTRL> key when clicking on the right scroll 
bar, it will do the opposite choice.

[Diskette icon] Button on SpeedBar saves the script without prompting you for a name - when 
checked this option will act exactly like Save on the File Menu, otherwise, with it not checked, it will 
act like Save As...

Pagination Delay (in Seconds) - lets you specify how long you have to pause in your typing before 
Movie Magic Screenwriter will repaginate your script (when needed). You would only want to change 
this if you have a slow computer and you find that your typing is interrupted by the program 
repaginating.    In this case, increase the pagination delay until you no longer experience an 
interruption.

Not Real-Time - if checked, will completely turn off the normal real-time pagination... a useful thing to
do if your computer is very marginal, speed-wise, for running Movie Magic Screenwriter.    When the 
pagination is turned off, it won't paginate the script until you:

· Choose Repaginate Now from the FORMAT Menu (or press [CTRL+R])
· Print any portion of the script
· Use any goto function such as Goto Page



Allow Page Breaks at Ellipses... - if checked, then the program will treat an ellipses ("...") as being 
equivalent to a sentence end, otherwise it will not.

Allow Normal Word Processor Mode - if checked, then the program will allow you to go into a 
Normal Word Processor mode where pressing <TAB> will simply insert 5 spaces, and pressing 
<ENTER> will move you down only one line.    When this is NOT checked, it will now allow you to go 
into this mode.



Program Options Menu - Revisions Page
Revision Marks

After ?? Revision Marks on the page, put a Revision Mark on the Header - allows you to specify 
the number of revision marks needed on a page for it to consider that the entire page is revised and 
at which point a revision mark will BE PRINTED on the header (it will not be displayed on the 
screen).

Use an Asterisk in the Header instead of the Normally Defined Revision Mark - If you defined a 
revision mark to be something other than a simple asterisk (which you can do on the Locked Scripts 
page of the Edit Script Formats Menu) then this option will tell it to put a simple asterisk on the 
header--when needed--rather than the defined revision mark.

Put the Header Revision Mark on the line under the header rather than to the right of it - which 
will do just that if checked.

Don't print Revision marks on each line for pages which have reached or exceeded the 
threshold number of Revision Marks as defined above - when checked, if the number of revision 
marks are greater or equal to the number specified in the first item of this menu, it will ONLY print the
revision mark on the header and NOT print ones to the right of each individual element.

Asterisk Headers of NEW A-Pages that don't have any revisions on them - when checked, then 
when a New A-Page is created, if it doesn't have any revised lines on it (as all the revisions were on 
the previous page) then put an Asterisk on its header to identify that it's a new page.

Print Separate full "PAGE OMITTED" pages - if checked, then when a page is completely omitted 
and the script printed, the program will print as an otherwise blank page with the words "PAGE 
OMITTED" on it.    If this is NOT checked then it won't print a blank page but will report the previous 
page number as a run, ie Page 6-7 to save on paper.

Mark Element following complete deletion - if checked, then when autorevision marks are on and 
you completely delete an element, it will mark the following element with an asterisk to denote that 
something's been completely removed.    Otherwise it will not mark anything as there is nothing left to
mark.

Consider A-Pages in Numbering Top Continueds - if checked, then when Screenwriter numbers 
the top continueds to show how many pages this has been continued--ie CONTINUED: (4)--then it 
will count any A-Pages in this continued Number.    If this is NOT checked, then this number will not 
reflect any A-Pages.

Auto-Update Locked Headers upon Revision - if checked, then when you're in a script with 
Locked Headers and make a change that gets a revision Mark, Screenwriter will automatically 
update the header on that page to the current header.    If this is not checked, then it will not update 
any headers until you go to print and verify that you want it to update the headers.



Program Options Menu - Printer Page
Printer Options

Print Bottom Continued on    Fixed Line - when checked, the Bottom Continued will print one line 
below the top of the Bottom Margin (set on the Setup Page Layout Menu), if it is not checked, then 
the Bottom Continued will print two lines below the final line of text on the page, thus "floating" up 
and down depending on the individual page.

Print (MORE) at page end even when dialogue isn't broken but character is the first to talk on 
the next page - when checked, and a Character has two speeches in a row separated only by action
and the first is on one page and the second is the next page, then the program will print a (MORE) 
following the first of those two speeches even though they were not broken by a page break.

NOTE: (1) this is not a standard format and we don't recommend it for spec scripts and (2) this 
(MORE) will not display on screen but will appear both on the print preview and the actual printing 
itself.

· Substitute ??? for Courier New - allows you to select a different font to print when you have 
selected Courier New.    This allows you to choose the printer's own built-in Courier Font, our 
supplied Courier Old TrueType Font, or any other font to be used in place of Courier New.

NOTE: When you substitute another font for Courier New here, all page breaks and line breaks are 
still calculated based on Courier New, so if you chose something really different, it may print weirdly. 
If you want to really change the font--both on screen and in printing--then go to the Edit Script 
Formats Menu and change it there.

· Darken Courier New (TrueType) Font - if checked, then when you print, it will overprint the 
Courier New    font to make it darker, how many times depending on the darkness setting you 
choose.

NOTE: This may slow down printing especially on Windows 95, and depending on the resolution of 
your printer may look better or worse than other options.    Experiment to see what works best for 
you.

Setup View Index Card Printing - takes to the Setup Index Card Printing Menu to configure the 
defaults for printing index cards.

Print Color Text Highlight (grey on B&W printers) - when checked and you have highlighted text 
with colors in the script, then those colored highlights will print as color on a color printer or as a 
grayed background on a black and white printer.    If this is not checked then the printing function will 
ignore all colors though it will still print any text that was highlighted in a color.

Always compress PrintThing files - when the program creates a PrintThing file, it can compress 
the file for added file security and easier e-mail over the internet.    If this item is checked here, then it
will automatically compress the PrintThing file without prompting, otherwise it will ask if this is what 
you want ever time.

When printing by Scenes print entire pages - when you select it to print a range of scenes, it can 
either print the entire text of each page--which is what it will do if this item is checked--or it will only 
print the text of that specified scene, which will result in a blank space at the top of the first page and 
at the bottom of the last one.    This is what it will do if this item is NOT checked.





Program Options Menu - Mouse Page
Text Entry/Editing

The following options are found in this menu.

Drag'n'Drop should break Elements in middle - when checked and you drop some text in the 
middle of the element Screenwriter will insert this dropped text exactly at the place where you 
dropped it.    If they are the same element type (both Action, for instance) it will insert the text at the 
cursor position, joining the two elements together; if the dropped text is a different element type, it 
will break the element on which it was dropped and insert the dropped text between the two halves of
the broken element.      If you don't have this option checked, then in that case Screenwriter will put 
the dropped text before the element on which it was dropped, if it was dropped within the first half of 
the element, otherwise it will put in after the element on which it was dropped.    In neither case will it 
break the element on which the text was dropped.    This is a good choice if your mouse usage is on 
the slightly sloppy side, otherwise having this option checked does give you more control.

Mouse Selects text by Whole Words - if this option is checked, then when you select text with the 
mouse, it will automatically ensure that you only select whole words, extending the block as needed.  
This makes for easier text selection but you do lose some slight amount of control.

· Including First Word of Block - if this option is unchecked, then the whole word selection 
will not be enforced for the first word of the block allowing you to take "out" in without for 
example, otherwise, if it is checked, then the mouse will always only select by whole words.

Hide Mouse when Typing - if checked, then when you're typing, the mouse cursor will vanish so 
that it doesn't get in the way of you seeing your text.    As soon as you move the mouse again, 
however, it will reappear.

Move Mouse Cursor to Menu Default Button - if checked, then whenever a menu pops up with just
a Yes/No/Cancel type response, the mouse pointer will automatically be moved to the default button, 
enabling you to accept the default by just clicking rather than having to find the mouse pointer and 
move it to where you want.    Without it checked, the mouse pointer won't move unless you moves it...

Right Mouse is...

· PowerPanel™ - if checked then when you click your right Mouse button the PowerPanel will 
appear

· Pop-Up Menu - if checked then when you click your right Mouse button a more "standard" 
right Mouse Pop-Up Menu will appear

PowerPanel

· Make selection when you release Right Mouse button - if checked then when the 
PowerPanel is displayed, if you release the right mouse button over one of the Power Panel's
buttons, then it will acts as if you'd clicked on that button.

· Display Block Editing Panel when you choose any Block Selection Button - when you 
select text with the PowerPanel it can (A) return you to your script with the text highlighted, 
ready for drag'n'drop or other manipulation--which is what it will do if this is unchecked-- or 
(B) automatically display the PowerPanels block editing functions--which is what it will do if 
this is checked.

· Move Cursor to Right Click Position - when this is checked and you right click the mouse, 
the text cursor will be first moved to under the mouse cursor just as if you'd Left Clicked, and 
then the PowerPanel will be displayed.    If it is not checked then the text cursor will not be 



moved first.



Program Options Menu - Multimedia Page
Multimedia Script Options
Use Smart Activity Arrows - when checked, Movie Magic Screenwriter will display a different 
number of angle brackets (arrows) next to activities to denote their nesting level and make it easier to
read.    If NOT checked, then all activities will simply have "->" to denote that their an activity.

Automatically Pop-Up Variable List when typing "<" in a User Activity - when checked and you 
type the left angle bracket "<" in a User Activity, it will automatically pop-up a list of existing variables 
to make entry easier.    If not checked, then it won't and you'll just have to muddle through without it.

When Printing Branch Points, print the page number of each referenced Branch Target - if 
checked, then when you print the script, after each line of every Branch Point it will automatically 
print the page number where that Branch Target is located, making it much easier to flip through the 
printed script in a non-linear fashion.

Start Each Branch Target at the Top of a Page - if checked, it will do just that.



Program Options Menu - QuickType™ Page
When Entering Character Names, sort the list...

· By Last Name used - SmartTab™ - this is the standard SmartTab functionality and when 
selected and you're entering a Character Name with the <TAB> key, when the list first pops 
up, the last name that you'd entered which began with the same starting letter will 
automatically be highlighted.

· By Last Name used in Scene - SmartTab™ Plus - this is the extended SmartTab function, 
and when it is selected and you're entering a Character Name with the <TAB> key, when the 
list first pops up, if there is a character that starts with the beginning letter anywhere earlier in
this scene, then that name will be first first one automatically highlighted, otherwise, if there 
isn't one, then the last name that you'd entered which began with the same starting letter will 
automatically be highlighted.

· Alphabetically (User List Order) - when this option is selected and you're entering a 
Character Name with the <TAB> key, if there is a character name in the Character Name 
User List that starts with the beginning letter then that name will be first first one automatically
highlighted, otherwise, it will be the first name in the list sorted alphabetically.

· Enable QuickType Entry - turns on/off the QuickType feature

Auto Pop-Up...

· Character Names Box on Character Entry - turns on/off the pop-up box of Names when 
entering a Character Name.    If this is not checked, then it will still perform the same type of 
letter matching, but will display the results on the bottom status bar instead.

· Locations After INT./EXT. Selection - if checked, then Screenwriter will automatically 
display the List Menu of Unique locations when you select an Initial Scene Heading list off a 
Menu. Otherwise, if it is not checked, then you'll have to press <ENTER> to have the list 
displayed.

· Time of Day List after Location Selection - if checked, then Screenwriter will automatically 
display the menu of Times of Day when you select a Unique Location list off the list. 
Otherwise, if it is not checked, then you'll have to press <ENTER> to have the list displayed.

Show Running Lists for entry of the following:

· Shots - if checked, then when you put in a shot, Screenwriter will automatically display a list 
menu of all the Unique Shots already in the script (plus those in the Shot User List).    
Otherwise if it is not checked, then it will only display those items in the Shot User List.

· Transitions - if checked, then when you put in a Transition then, Screenwriter will 
automatically display a list menu of all the Unique Transitions that are already in the script 
(plus those in the Transition User List).    Otherwise if it is not checked, then it will only display
those items in the Transition User List.

· Character Extension - if checked, then when you put in a shot, Screenwriter will 
automatically display a list menu of all the Unique Character Extensions already in the script 
(plus those in the Character Extension List).    Otherwise if it is not checked, then it will only 
display those items in the Character Extension User List.



QuickType™
QuickType is Screenwriter's intuitive interface that allows it to "read your mind" and pop-up the 
menus and puts you into the element that you want without you having to ask for them.    

It does this by using a heirarchy of elements that works as follows:

If you Type... It will display...
FADE IN: or Any Transition Pop-Up Menu of Initial Scene Heading

Text

If you Press <ENTER> while at... It will...
Blank Action, Transition, Blank 

Scene Heading, 
Scene Info or End of Act

Display Initial Scene Heading Text 
Menu

Scene Heading without a 
Location

Display a List Menu of    all unique 
locations already in the script

Scene Heading    with a Location Display a Pop-Up Menu of common 
Times-of-Day

The end of an Action line with 
text in it

Add a following Action Element

Character Name If the next element is Dialogue or a 
Parenthetical, it will move to the 
beginning of that element, otherwise it 
will add a Dialogue Element

First letter of Dialogue under any
Character Name

Display a List Menu of Alt-Key Names 
and allow you to assign the Alt-Key 
Name for that letter

Press <ENTER> while in End or 
middle of Dialogue

Add an Action Element, breaking the 
Dialogue and adding a New Name 
Continued if needed

Press <ENTER> while in Parenthetical If the next element is Dialogue then it 
will move to the beginning of that 
element, otherwise it will add a 
Dialogue Element

You can turn on/off QuickType and further customize the QuickType entry on the Program Options 
Menu, Editing Page.



Random Access Scrolling
Is when you click on the Right Scroll Bar and it immediately jumps to that position just as if you'd 
dragged the Scroll Tab there, thus accessing anywhere in the script with a single mouse click.

You can choose between having it scroll up/down by a screen or using Random Access Scrolling 
when you click above or below the Scroll Tab on the Misc. Page of the Program Options Menu by 
checking    or unchecking Clicking on Right Scroll Bar Moves by Screen.    

However, no matter which of these options you have checked, holding down the <CTRL> key while 
clicking on the scroll bar will make it do the opposite.    Thus if you have it set to normally use 
Random Access Scrolling and you hold down the <CTRL> key when you click above or below the 
Scroll Tab it will move up/down by a screen instead, if you have it set to normally move up/down by a
screen, holding down the <CTRL> key will make it scroll using Random Access Scrollling.



Remove Current Revision Marks
A Menu Item found on the Format Menu which will remove ALL Current Revision marks from the 
currently open script.    It is typically used in production after newly revised pages have been issued 
so that any future revisions will only have new revision marks.

Generally used with the Auto-Revision Marks feature.



Renumber All Branch Targets
This menu item, found under the FORMATS Menu when in a Multimedia 
Script, will renumbering all Branch Targets to sequential order in the script.

Renumbering Branch Targets does NOT affect the script or any of the branching linkages as all of 
them are adjusted accordingly and may done for purely aesthetic reasons.    

However, if other people have done any sort of breakdowns of the script based on these linking 
numbers, it may not be a wise idea to run this function.



Reset Cheated Menu
This Menu, gotten to by selecting the Format Menu, then Reset Cheated and 
selecting either Page or Script, allows you to choose among all of the 
possible cheating options which you wish to undo...

· Line Spacing - if checked, then it will undo any element's cheated Lines Before or Interline 
Spacing but will NOT undo any Text Line Percent or Blank Line Percent cheating set on the 
Setup Page Layout Menu

· Left & Right Margins - if checked, then it will restore any element's cheated margins to the 
default for that element type

· Character Continueds - if checked, then it will remove any overrides on Character Continueds
· Scene Numbering - if checked, it will remove any overrides on Scene Numbering
· Text Formats - if checked, then it will restore any element's Text Style including capitalization to 

the default for that element type
· Kept Together Elements - if checked then it will remove any Keep Together Protection, allowing

those elements now to be broken



Reset Cheated Sub-Menu
These are the options found under Reset Cheated on the Format Menu:

· Element - which resets the margins, line spacing, text style and other element specific options 
for the current element to the default for that element type

· Page - takes you to the Reset Cheated Menu where you can select which of the possible cheats 
it should reset for the current page

· Script - takes you to the Reset Cheated Menu where you can select which of the possible 
cheats it should reset for the entire script

· Unmark as Non-Printing - this will unmark either the current element or any currently blocked 
elements as Non-Printing, restoring them to their normal status



Revision Marks
There are two types of Revision Marks available in Movie Magic Screenwriter, Current Revision 
Marks and Locked Revision Marks.
 
Current Revision Marks are the ones that are put in automatically (or by pressing *) and which will 
not be visible if you turn on reveal codes.    These Current Revision Marks are the only ones which 
will be removed by selecting Remove Current Revision Marks from the Format Menu; they are the 
only ones that will be found when you select Next Current Revision Mark from the GOTO menu; and 
finally, they are the only ones used to select pages to print when you select Asterisked Pages on the 
Print Menu.

Locked Revision Marks are ex-Current Revision Marks which have been Locked by selecting Lock 
Current Revision Marks from the FORMAT Menu on the Main Menu Bar.    What it does at that point 
is (1) convert all Current Revision Marks into a code appropriate for the Revision Locking Level, (2) 
embed this code in the text everywhere there had been a Current Revision Mark, and (3) increment 
the Revision Locking Level.    

See also the Revisions Page of the Program Settings Menu for more options, and the Locked Scripts
Page of the Edit Script Formats Menu for setting the Revision Mark Text and position on the page.



Ruler Bar
You have the option of having each script have a ruler at the top of the script with the current margins
marked, allowing you to cheat the left/right margins of the current element simply by dragging the 
margin marker.    To either turn on or off the display of this ruler, click the [Ruler SpeedButton] (the 
one with the Icon of a ruler on it) on the Top Speed Bar, or choose Display Options on the File 
Menu, and click Ruler.



Save File Menu
This is where you can save your script with a new name, change the format in 
which it's saved (ie Export it), in addition to changing where it's saved (ie the 
Drive and subdirectory)

True File Name - this field contains the actual 8 letter DOS/Windows file name that the script will be 
saved under.    When you first save the script and it does not have a name yet, this option defaults to 
auto which means that the program itself will generate the 8 letter DOS/Windows Name based on 
the Longer Name you type into the name field below, or alternatively you can enter here one 
yourself.

Underneath the True File Name Field (or the very first line if True File Name isn't displayed) is the 
Name Field where you can enter the name of your script--as an up to 50 letter name if you're 
running in Windows 95

Underneath the Name Field is a File List displaying all the files in the current subdirectory with the 
extension of the current File Type.    Double-click on any of them to use that name for the current 
script.

File Type - is a drop-down list which enables you to tell Movie Magic Screenwriter what format it 
should save the script in to allow for exporting to other programs.    There are currently eight file types
(formats) available, and depending on which one you choose, Movie Magic Screenwriter will 
automatically append the appropriate File suffix (such as .SCR, .RTF and so on).    The available file 
types are:

· ZapSave (Win) - this is Movie Magic Screenwriter native script format and should be normally 
used as it will maintain all the formatting exactly from writing session to writing session.

· ZapSave Format (DOS) - this is ScriptThing for DOS's ZapSave format which you should use 
for compatibility with ScriptThing for DOS (versions 2.10 and later).    Although it maintains the 
margins and formatting, it will NOT maintain font information, line spacing cheating, and the 
margins and page breaks may be slightly different between the two versions due to the 
differences in the way they handle things.

· Old ScriptThing format - is the original ScriptThing for DOS' script format and is used for 
maintaining compatibility with versions of ScriptThing for DOS prior to 2.10.    It shares the same 
file compatibility issues as the ZapSave Format (DOS) listed above.

· Formatted ASCII - a plain text (ASCII) format with all the text of the script indented correctly with
spaces for use in importing into programs which cannot handle any of the other file formats.    
Obviously you loose any bold, italics and underlines in the transition.

· WordPerfect® - a WordPerfect® 5.1 (or greater) compatible file with margin sets, tabs, and soft 
returns.

· WordPerfect® w/Styles - a WordPerfect® 5.1 (or greater) compatible file with the Style Sheets 
in place of margin sets and tabs.

· MS Word® (RTF Format) - an RTF File (Rich Text Format) that is compatible with all versions of 
Microsoft Word prior to version 6.0.    For exporting to Word 6.0 or greater, as odd as it 
sounds, use either of the WordPerfect formats!

· Scriptware® Tagged - a format designed for efficient and accurate importing into the 
screenwriting program Scriptware®, produced by Cinovation, Inc.

To the right of the File List is a Directory Tree where you can change the directory to which the script
will be saved.



Underneath the Directory Tree is a Drive Box where you can change the drive to which the script will
be saved.

If you ARE NOT USING WINDOWS 95/NT with the 32 bit version of Movie Magic Screenwriter then 
you will see the following options:

Backup Script To... - lets you specify a drive to backup the script to in addition to saving it on the 
hard drive.    Note if you change the Drive Box to be either A:\ or B:\, then this option will be grayed 
out.

· No Backup - doesn't backup the script to a floppy right now
· Drive A: - prompts you to put a disk into drive A:\ and backs up the script to that disk.
· Drive B: - prompts you to put a disk into drive B:\ and backs up the script to that disk.
[SETUP] - Press this button to display the Setup Backup Options Menu where you can set the 
default back-up setting for Movie Magic Screenwriter -- ie whether it should prompt you for backups 
all the time and if so, which drive it should use.



Scene Character List - Generation Menu
This Menu is gotten to by selecting Generate under Scene Character Lists on 
the FORMAT Menu.

On this menu you can select how you would like the Character Names Lists generated for each 
scene:

· Sort the Character Names: there are three options as to the order in which the character 
names should be listed under each Scene Heading:
· Alphabetically - the names will be listed in alphabetical order
· In Script Order - the names will be listed in the order in which they actually appear in that 

scene regardless of whether they are speaking or are merely described in Action
· In Script Order but Speaking Characters 1st - the names will be listed in the order in which

they speak in that scene, however if there are characters who are in that scene but do not 
have dialogue, they'll always be listed after the speaking characters even though the action in
which they are described may appear before any given speaking character

· In User List Order (Alphabetical) - all names will be listed first in the order in which they 
appear in the User List (if they're in that scene), and any additional names that are not in the 
user list will be listed following them in alphabetical order

· In User List Order (Speaking Order) - all names will be listed first in the order in which they 
appear in the User List (if they're in that scene), and any additional names that are not in the 
user list will be listed following them in the order in which they speak in that scene

· [Setup User List Order] - press this button to be taken directly to the Edit User List Menu where
you can add names to the User List, reorder the names or in any other way edit the Character 
Name User List

· [Setup Locations for Automatic "atmosphere"] - you can designate any location as always 
having "atmosphere" (or "extras" or whatever text you prefer) and whenever a scene takes place 
in a location which is tagged as always having atmosphere, the automatic character list 
generation function will add the selected atmosphere text at the end of the character list.        
Press this button to be taken to the Automatic Atmosphere Setup Screen.

· Include Non-Speaking Characters Names - when checked then any character who is 
described in Action but who does not speak in that scene will still be listed as being in that scene,
otherwise he/she will not be.    Checking this option will slow down slightly the generation of these
Character Lists but will produce more useful and accurate lists.

· Generate Character List in ALL CAPS - when checked the names in each list will be in all 
capital letters, otherwise they'll be upper/lowercase.

· Generate Character List in BOLD - when checked the names in each list will be all bold, 
otherwise they'll be normal.

· Only After 1st Scene Heading in Scene - this option will be grayed out and inaccessible if you 
do not have the option Use Scene Information in Script checked on the Scene Information 
Page of the Edit Script Formats Menu. However, when it is available and checked and there are 
multiple locations in one scene (ie, there are more then one scene heading under the auspices of
the same scene infomation) then they will all be treated as one scene and all the names will only 
be reported under the first Scene Heading



Scene Character Lists
Found under the FORMAT Menu, this option generates lists of all the 
characters in each scene and puts that list immediately under each scene 
heading, a format used frequently in sitcom production.

There are two sub-options under the Scene Character Lists Menu Item:

Generate - this will display the Scene Character List Generation Menu .
Remove - which will remove any previously generated Scene Character Lists.

NOTE: When you have generated lists, each time you go to the Print Menu, it will ask you if you 
want to regenerate your lists.    Select YES when you've added/removed characters from any 
scenes, otherwise you can select NO.



Scriptware® Tagged Import Menu
You will only see this Menu if--when opening a Scriptware® Tagged file--it hits a code that it doesn't 
know how to interpret.    In this case the code will be displayed at the top of the Menu and you should
select the format type which it should be interpreted as...



Select Backup Drive
This Menu allows you to select which drive the program will use to 
automatically backup each script to when you save & exit a script on which 
you've made changes.

To get to this Menu...

1 Click on the File Menu
2 Choose Program Options
3 Click the    Startup/Files Tab
4 Click the    [Setup Backup Drive] Button

Simply select one of the available drives and press OK.    From that point on, any time you make 
changes to a script and then close it, it will prompt you to insert a disk into the drive you've selected 
and backup the script to that drive.

If, for some reason you don't want it to automatically prompt you to back up your scripts you can 
check the box Don't Prompt for Automatic Backups and then you'll have to do any backups 
manually.



Set Column Margins
Movie Magic Screenwriter suports Dual-Columns, and although they display on-screen sequentially 
like below:

            MARK
This is a left column speech
which is really happening at
the same time as the right
column speech.

                                        LARRY
                             This is a right column speech
                             which is really happening at
                             the same time as the right
                             column speech.
They will actually print directly next to one another and you can verify that by going to the print 
preview.

Setting the Two Columns Margins:

· Go to the Format Menu, choose Change Element Type then Set Column Margins
This menu has two radio buttons at the top:

· Left Column
· Right Column
And the values in the fields below the radio buttons are displayed for the selected column.    The 
margin values are all in 1/10ths of an inch -- thus a value of 15 if is 1.5" -- and they are ALL based 
from the left hand edge of the page.    There are four categories, each having a left and right margin:

· Character Name - the left/right margins for Character Names
· Dialogue - the left/right margins for Dialogue
· Parenthetical - the left/right margins for Parentheticals
· Other - the left/right margins for any other element type such as Action or Scene Heading



Set Directory Menu
This Menu is displayed by hitting the [Setup Default Script Directory] Button 
on the Startup/Files Page of the Program Options Menu.

You can either select an existing directory by double-clicking on any of the ones listed in the 
Directory Tree, or you can create a new one by typing in the name yourself in the Directory Name 
Field and if it doesn't exist, when you click [OK] or press <ENTER> it will ask if you want to create it.   
Say Yes to do so.



Set Screen Colors Menu
Movie Magic Screenwriter normally uses whatever screen colors are defined 
by Windows, but this Menu allows you to override them just for Screenwriter.

To get to the Set Screen Colors Menu, go to the FILE Menu, choose Display Options then Set 
Screen Colors.

To set the Screen Colors just for Screenwriter, first get to the Set Screen Colors Menu.    To set a 
color, first click on the appropriate Radio Box of the screen element that you want to set (Window 
Background, Text Color, Highlight Color, or Highlighted Text) and then click on the color you want 
that to be.    Repeat as needed and press OK when done.

To reset Screenwriter to use the Windows' Default Colors,first get to the Set Screen Colors 
Menu.    Now click on Use Windows Colors.

Movie Magic Screenwriter supports two different ways of showing colored (highlighted) text -- with 
either the color as background (like a normal pen highlighter) or with the letters of the text itself as a 
color.

To Set how Colored (or Highlighted) text is displayed within the script, first get to the Set 
Screen Colors Menu then select either Show the Color as the Background or Color the Text Itself
as desired.

NOTE: this selection will affect the display on-screen of all programs and the printing of colored text 
on colored printers only.



Setup Backup Options Menu
You get to this Menu by pressing the [SETUP] button on the Save File     Menu  .

· No Floppy Backup - when you get to the Save File Menu the option No Backup will be checked,
and it will not prompt you to backup your script, neither when you save nor when you close the 
script.    Use this option at your own peril as hard disks DO crash and without floppy 
backups you can lose your scripts!!!!!

· Backup to Drive A: - with this checked, then whenever you close a script having made changes 
to it, it will prompt you to put a disk into Drive A:\ and make a backup of the script to that disk.    At
that time, you can cancel the backup if desired, but we HIGHLY recommend checking either 
Drive A: or Drive B: as its a painless way to ensure that you have current backups at all times.

· Backup to Drive B: - the same as Backup to Drive A:\ but using the B:\ Drive on your computer.



Setup Duplicate Names Menu
This Menu allows you to identify alternative names for the same characters 
(such as ABRAHMS and CAPT. ABRAHMS being the same character) so that 
the breakdowns and other functions will know not to list them as separate 
characters.

You can get to this menu by...

· Selecting the Production Menu, then Breakdowns, then Setup Duplicate Names
· Selecting the Help Menu, then Script Analysis, then clicking the [Setup Duplicate Names] 

button
This menu will have a list of all the characters in the script, with those identified as being duplicates 
on the same line, separated by a colon:

ie                  ABRAHMS : CAPT. ABRAHMS

Underneath that there are four ACTION BUTTONS:

· [Combine] - this will only be accessible when you have exactly two names highlighted, and 
when clicked it will combine the names to one line with a colon between them.    This will tell 
the program that any instances of the SECOND NAME (in this case CAPT. ABRAHMS) 
should be reported as the FIRST NAME in all breakdown information.

· [Clear Selections] - this will clear the highlighting on any currently selected names.
· [Break Apart] - this will only be accessible when you have one name highlighted and that 

one name is already a combined name with a colon separating the two (or more) names.    
When clicked, it will break apart the line so that each name is now individually reported.

· [Undo] - this will undo the last Combine or Break Apart actions.



Index Card Printing Menu
This Menu, gotten to by either selecting Print on the Index Card Viewing Mode
screen, or by clicking the [Setup View as Index Card Printing] button on the 
Printing Page of the Program Options Menu, allows you to configure how 
Index Cards Print.

There are four general layout options, the first three of which are pre-formatted layouts.      To 
select the one you want, simply click on it and a dot will appear in that option's radio box to tell you 
it's selected.

· 3x5 Sparco - which was designed to print on perforated card stock produced by Sparco 
Corporation and which prints three 5" x 3" cards on a page oriented as Portrait

· 5x3¾ Landscape - which prints four 5" x 3¾" cards on a landscape oriented page
· 3¾x2½  - which prints six 3¾" x 2½" cards on a portrait oriented page
· Define Your Own - which lets you do just that.
The Define Your    Own Settings - You have the option of Portrait or Landscape --and the picture of 
the page shows which is which--in addition to specifying how many cards across and down you want.
Based on what you tell it, Movie Magic Screenwriter will then auto-calculate the appropriate card 
size.

NOTE: Across and Down always refer to the width and height of the page, respectively, in the 
selected orientation.    Thus in Landscape, Across refers to the 11" width of the Landscape page, 
while in Portrait it refers to the 8½" width.

Options:

· Draw Boxes - when checked, then each index card will be printed with a box around it, 
otherwise they won't be

· Bold Headlines - when checked, then each index card's scene heading will be printed as Bold, 
otherwise it won't be

· Top/Btm Margins - allows you to set value used for both the top and bottom margin of the page 
when printing

· Lft/Right Margins - allows you to set the value used for both the left and right margin of the 
page when printing

NOTE: Like Across and Down the Top/Btm and Lft/Rght Margins refer to the page in its current 
orientation.

· Inter-Card Margins - allows you to set the spacing between each card
Font - takes you to a menu where you can change the font of the printed Index Cards

Save As - takes you to a menu where you can save this layout with a name for future use

Open - takes you to a menu where you can open (ie load) previously saved Index Card Printing 
Layouts

NOTE: The following four options will ONLY be available if you have gotten to this menu by 
pressing the [Print] Button while in Index Card Viewing Mode!!!



Save as the Default Layout - if checked then the currently selected layout will be automatically set 
every time you get to this menu

Print All Cards - will do just that...

Select Range of Cards to Print - will return you to the View as Index Card Mode and the cursor will 
say Select 1st Card to Print and you should click on the first card to print, and the cursor will change 
to say Select Last Card to Print and you should do that, and it will then print that range of cards



Setup Menu Bar Utility
This Utility allows you to edit the Top Speed Bar, changing which buttons are 
available on it, and their order and size.    

To use the Setup Menu Bar Utility you must first exit Movie Magic 
Screenwriter if you're in it then run the utility from the Program Manager or 
Windows 95 desktop!



Setup Revision Draft Color Order Menu
This menu lets you select the order and names of the revision colors in 
addition to allowing you to specify how they display on screen, whether in 
color or not and if so, which colors.      It is accessed by selecting Production, 
then Set Revision Draft Color.

The list on the left of this menu are the script colors in the order in which they'll be used.    Above this 
list is an Edit field where you can add or change color names.

To Add a color simply type it in at the edit field above the list and press <ENTER> to add.

NOTE:    It will be added following the currently selected color.

To Remove a color simply highlight it and press the [Delete Color] button.

To Edit a color simply highlight it and press the [Edit Color] button.    The current color will be placed 
in the Edit Field and you can change its name or spelling as desired.

To change how a defined color will display on screen simply highlight the color in question and 
press the [Set Page Display Color] button.    A color Menu will appear and allow you to select among 
the range of available colors...

NOTE: We HIGHLY recommend that you have your monitor set to display over 256 colors because 
although that is 256 different foreground colors, there are still only 16 different background colors 
and that doesn't give the program much leeway in terms of differentiating page colors on screen.

After the Last Color is Used, it should...

· Don't Loop Colors - if this item is selected then you can only have as many revision draft 
colors as are entered on this list

· Loop to "DOUBLE BLUE" - this means that after it passes the last revision draft color in the 
list, it will start over with the second color in the list (which is almost invariably BLUE) and 
loop through them again, listing it as "DOUBLE BLUE", "DOUBLE PINK" and so on... all the 
way up to QUINTUPLE if needed.

· Loop to SECOND BLUE" - this means that after it passes the last revision draft color in the 
list, it will start over with the second color in the list (which is almost invariably BLUE) and 
loop through them again, listing it as "SECOND BLUE", SECOND PINK" and so on... all the 
way up to FIFTH if needed.

· Loop to 2ND BLUE" - this means that after it passes the last revision draft color in the list, it 
will start over with the second color in the list (which is almost invariably BLUE) and loop 
through them again, listing it as "2ND BLUE", "2ND PINK" and so on... all the way up to 5TH 
if needed.



Skip List Menu
This menu is gotten to by pressing the [SKIP LIST] button on the Locked 
Scripts Page of the Edit Script Formats Menu.

Locked Letter Skip List - due to potential confusion between the letter "I" and the number "1", and 
the letter "O" and the number "0",    most production companies skip those letters, going straight from
"H" to "J" and from "N" to "P".    Other companies also like to skip "E" and "F" because they look too 
much alike, and with the power of Movie Magic Screenwriter, you can set it to skip whichever letters 
you want!

So, simply check the CheckBoxes of all letters that you don't want Movie Magic Screenwriter to use 
for A-Pages and A-Scenes, nor for Act and Scene Information, and it won't.



SmartTab™
SmartTab is Screenwriter's special Character Name entry function that 
ensures that selecting the Character Name you want involves the fewest 
keystrokes possible.    It is turned on/off on the Editing Page of the Program 
Options Menu.

It does this by automatically highlighting the last character name that you had entered which started 
with any given letter when you press the <TAB> key and start typing a Character Name.

For example, let's say that you have MICHELLE, LARRY, LISA and LAURA in your script and this is 
a scene between LAURA and MICHELLE.    When you press <TAB> <L> the first time in this scene, it
will pop up a list of all the names that begin with L in the script with LARRY highlighted, so you'll type 
<A><U> to move the highlight to LAURA and then press <ENTER> to have Screenwriter finish out 
the name for you and take you directly to Dialogue.    

Without SmartTab enabled, you'll have to do exactly that each time you want LAURA.    

WITH SmartTab enabled, the next time you press <TAB> <L>, LAURA will automatically be 
highlighted for you so you simply have to press <ENTER>, saving you a whopping two keystrokes 
per name!



Spell Check Menu
This Menu is displayed when the Spell Checker finds a word that it doesn't 
recognize...

· Word - this field initially contains the word it doesn't recognize. If you select a word from the 
Suggestions list, then the [REPLACE] button is enabled, and the unrecognized word is 
substituted with the selected word.    When you click the [REPLACE] button, it will use whatever 
text is in this field as the replacement text

· Suggestion - displays a list of all the suggestions the spell check has to offer -- double-click on 
any of them to select that spelling as a replacement for what's in the text, or edit the text in the 
Word field as desired

· Add Words to: - lets you change the User Dictionary to which all learned words will be added
· [REPLACE] - this button will be grayed out until you either edit the text in the Word field or click 

on one of the suggestions (which will then change the text in the word field itself).    At that point, 
clicking [REPLACE] will do just that...

· [AUTO-CORRECT] - this button will be grayed out until you either edit the text in the Word field 
or click on one of the suggestions (which will then change the text in the word field itself).    At 
that point, clicking [AUTO-CORRECT] will put the original mispelled word on an Auto-Correct 
List, automatically replacing it with the newly selected spelling in both the real-time spell 
checking and further normal spell checks.

· [LEARN] - will cause it to add the unknown word to the currently selected User Dictionary
· [SKIP ONCE] - will cause the Spell Check    to skip this one instance of the unknown word, but 

stop on any subsequent instances
· [IGNORE] - will cause the Spell Check to not stop on this unknown word for the rest of this 

writing session (or until you Clear the Ignore List) but to not learn it for future writing sessions
· [SUGGEST] - will give you a list of suggestions based on whatever is currently in the text of the 

Word field -- use this if none of the original suggestions are correct and you want to edit the 
edited text in the Word field yourself and check that spelling against the dictionary.

· [CANCEL] - cancels the spell check and leaves you at the currently questionable word.    Use 
this if you need to actually edit the text in question. You can then resume the Spell Check, by 
clicking on the SPELL Menu then selecting FORWARDS

· [ADD WORDS TO...] - allows you to select where it should add any learned words.    The 
USER_?? dictionary is the standard user dictionary used by all scripts in addition to any script 
specific dictionary.    All Auto-Correct words are added to this dictionary.

· [SETUP OPTIONS] - Takes you to the Spell Check Page of the Program Options Menu so you 
can select how the Spell Check Functions

· [SELECT LANGUAGE] - Allows you to select among the available language dictionaries.    If you
do not have the dictionary you want already installed, it can be purchased by calling us at 800-
450-9450.



Substitution Text
Substitution Text is a User List whose sole purpose in life is to allow you to 
use Text Aliases for text in Action and Dialogue.

Say, example, that you have an organization in your script called "Council on Aging" and you don't 
want to type that in a million (give or take) times.    To avoid having to do this, simply go to the 
Substitution Text User List, type in "Council on Aging" and hit the [Alias] button.    

You will see the standard Alias Auto-Recognition Text Menu with three additional options.    These 
options are Auto, As Entered, and ALL CAPS, and the one you select will determine how the 
expanded text will be capitalized. 

If you select Auto then it will match the capitalization of the Alias you type in, thus if you type "coa" it 
will expand to on "council on aging", if you type "Coa" in then it will expand to "Council On Aging", if 
you type in "COA" it will expand to "COUNCIL ON AGING".

As Entered means that no matter how you type in the alias text, it will always be replaced with the 
exact capitalization that you entered into the Substitution text (unless, of course, you're in an element
which is defined as all caps in which case it will be put in as all caps).

ALL CAPS means that it will be put in as, well, all capitals, again regardless of how you typed in the 
alias text.



Text Aliases
Text Aliases are a powerful new tool in Movie Magic Screenwriter which allow you to type as 
few as a two letters and have Movie Magic Screenwriter automatically expand it to the full text
for you, as you're writing, changing the element type if appropriate.

You can set Aliases for Character Names, Initial Scene Heading Text, Shot Text, Transitions Text, all 
the Act & Scene Info Texts in addition to Substitution Text.    Aliases for Character Names and 
Substitution Text do not cause the element type to be changed, while the others do.

For example, if you set the alias for "INT." in the Initial Scene Text to "I." then you can simply type "I." 
at the beginning of a blank line and it will expand it for you while also changing it to a Scene 
Heading.

Or if you add the name BENJAMIN to the Character Name User List and then assign it an alias of 
"BJ" when you type "bj" followed by a space or appropriate punctuation, it will expand it to "Benjamin"
or if you type "BJ" it will expand it to "BENJAMIN" matching the capitalization of the alias!    Pretty 
nifty, eh?

NOTE: To use Aliases for Character Names and Substitution Text you MUST have the option Spell 
Check as you Type & Edit checked on the SpellCheck Page of the Program Options Menu, though 
the other User Lists do not require this for the use of their Aliases as they are also used in auto-text 
recognition.

To Setup Text Aliases:

Step 1: Select the Format Menu from the Main Menu Bar, then select Edit User Lists and click the 
button labeled with the element type for which you want to set up Alias Text.

Step 2: If the User List does not have text items in it yet, type or copy them in as needed, then click 
the [Alias] Button to the left of the item you want and you will see a Alias Auto-Recognition Text Menu
where you will fill in the text you want to use as an Alias.

Step 3: Actually type in the Alias Text and press [OK].

Step 4: Repeat Steps 2-3 as desired.

Press [OK] when done and you're set!



Text Search Menu
This Menu is gotten to by selecting either Search or Search & Replace from the
Search Menu on the Main Menu Bar.

· Search For: - enter the text that you're searching for
· Replace With: - if this is set to DON'T REPLACE then Movie Magic Screenwriter will do a simple

search, otherwise it will use whatever you put in here as replacement text where appropriate.    
Note that if you leave this completely blank, Movie Magic Screenwriter WILL replace the 
designated text with nothing, ie simply remove it...

· Whole Words Only - check this box if you want it to find the searched for text only when it is a 
whole word.    If you have this checked and tell it to search for "MAN" then it will not stop on 
"WOMAN", otherwise if you don't have this checked, it would.

· Search Backwards - means that it will search from the designated starting point up to the top of 
the script, otherwise it will search down to the bottom

· Find with Same Capitalization as Search Text ONLY - means that it will only find a match if the
text has exactly the same capitalization as you'd typed in the Search for field

· From Cursor Position - means start the search from the Cursor Position
· Entire Script - means move to either the top or bottom before starting the search, depending on 

whether you're searching forwards or backwards.

NOTE: The following two options will be grayed out and unselectable if Replace With: is set to 
DON'T REPLACE

· Prompt On Replacement - if checked, will cause Movie Magic Screenwriter to stop at each 
instance of the found text and ask you whether it should replace it, otherwise it will replace all 
instances of the found text without prompting

· Match Case of replaced word - if checked, then when Movie Magic Screenwriter replaces an 
instances of the found text, it will match the capitalization of the text it's replacing, regardless of 
whatever capitalization you typed into the Replace With: field, otherwise it will use the exact 
capitalization you typed in



Thesaurus Menu
This Menu is gotten to by selecting Thesaurus from the Spell Menu...

· Head Word - is the word for which it is displaying synonyms.    If you edit this word, you must 
press the [SYNONYMS] button for it to update the Synonyms list

· Synonyms List - are all the synonyms in the thesaurus for the currently selected Head Word - 
double-clicking on any of them will cause it to replace the original word in your script with the 
selected synonym.

· [REPLACE] - will replace the original word in your script with the text currently in the Head Word 
field

· [PREV WORD] - if you get synonyms for another Head Word or get synonyms for a suggested 
synonym, then the [PREV WORD] button will be enabled and you can use it to back up to the 
previous Head Word



Title Page Publisher
The Title Page Publisher is accessed under the FILE Menu, and is designed 
for easily creating Title Pages in a WYSIWYG environment.

It displays a WYSIWYG page on the left hand side of the screen and has various controls/options on 
the right hand side.    The page size is automatically adjusted to the current page size of the selected 
printer so if you have 8½ x 11" page or A4 paper, the WYSIWYG display will set its display to that 
size.

To Add Text - simply position the mouse cursor where you want the text to go and double-click.    An 
Edit Text Window will appear and you can type in the text as desired.    Press ENTER to manually 
add line breaks as desired.

NOTE: The entire text of any given element has the same formats (bold/underline/font etc.) so if you
want to mix/match formats then put each differently formatted text in its own element.

To Edit Text - simply position the mouse cursor over the text you want to edit and double-click.    An 
Edit Text Window will appear with the current text element in it and you can change the text, its style, 
justification, font or size as desired.

To Move Text - with the mouse, simply click on the text element you want to move and drag it to a 
new position, or press any arrow key to move it in that direction.

Display/Editing Options

Display Size - there are two zoom settings for the WYSIWYG display, Full Page and Zoomed.    
When you select ZOOMED, it displays the page to the width of the Title Page Publisher's WYSIWYG 
screen and you'll need to scroll up/down to see the top or bottom of the page.    In FULL PAGE mode,
it will display the page to the height of the WYSIWYG screen and automatically adjust accordingly.

Position Information - When you have text selected (which will be displayed by showing a dashed   
box around it) then it will display its position on the page in either inches or centimeters as selected 
in the GRID OPTIONS.    "X" is the left position, "Y" is the top position.

NOTE: The position information reports the position of the Text Element Box rather than the text 
itself.    This means that if, for example, you have centered text in a box larger than then width of the
text itself, the left position that's reported will be further to the left than the printed text.

Grid Options - You can have a grid displayed over the title page in either Inches or Centimeters 
and the position information will also use the selected units.    The grid will NOT be printed but is 
merely there to aid in positioning text.

Use a ?? inch binding margin when Horizontally Centering on Page    - when checked, and this 
has a value greater than 0, then when you click on the Center on Page command on the Align 
Horizontally group, it will take into account the left binding when centering the text left-to-right on the
page.

Text Element Alignment - there are five automatic functions for aligning text elements both in 
respect to each other and to the page itself.    They are slightly different for horizontal (Left to right) 
and vertical (Top to Bottom) alignment.    You select between Horizontal and Vertical alignment 



options by clicking on the respective tab.

NOTE: All of the text alignments options except Center on Page require that you have at least two 
text elements selected as they align different elements with respect to each other.

Align Horizontally

· Left - will align the left edges of all selected text boxes with the left edge of the first text box 
that was selected

· Right -will align the right edges of all selected text boxes with the right edge of the first text 
box that was selected

· Centers -will horizontally center all selected text boxes with the horizontal center of the first 
text box that was selected

· Left to Right - this option is ONLY available when you have exactly two text boxes selected, 
and it will align the right-most box directly against the right edge of the left-most of the two 
boxes

· Center on page - will center all selected text boxes with respect to the width of the page, 
taking into account the binding margin, if checked. If more than one text box is selected then 
they will be centered as a group that is to say that their total width (furthest left to furthest 
right) is the value which will be used to center them rather than each one being centered 
individually.

· Undo Alignment - will undo the last alignment option selected unless the text elements in 
question have been otherwise dragged.

Align Vertically

· Tops - will align the tops of all selected text boxes to the top of the first text box that was 
selected

· Bottoms -will align the bottoms of all selected text boxes to the bottom of the first text box 
that was selected

· Centers -will vertically center all selected text boxes with respects to the vertical center of the
first text box that was selected

· Top to Bottom - this option is ONLY available when you have exactly two text boxes 
selected, and it will align the lower of the two boxes directly against the bottom of the upper 
of the two boxes

· Center on page - will center all selected text boxes with respect to the height of the page.    If
more than one text box is selected then they will be centered as a group, that is to say that 
their total height is the value which will be used to center them rather than each one being 
centered individually.

· Undo Alignment - will undo the last alignment option selected unless the text elements in 
question have been otherwise dragged.

Print the Title Page - will do just that.    You can also print the title page along with the text of the 
script by checking the TITLE PAGE CheckBox on the Print Menu.

Load Button - allow you to load existing title pages created in the Title Page Publisher from either 
saved Title Page Files or directly from other Screenwriter scripts.    On the Load Menu that appears 
you can select either the Title Page File format or Screenwriter Script format to select the appropriate
files.

Save Button - allows you to save existing title pages created in the Title Page Publisher as a 
separate Title Page Files for use as a "template" in the future.    However, as the title page is 



automatically saved as part of the script itself , you DO NOT need to save it here unless you want to 
access it separately later.



The Top Speed Bar
This is the top bar immediately under the Main Menu Bar with Speed Buttons 
for easy mouse access to common document handling and editing features.

You can see what each button does simply by holding the mouse over that button and a hint will drop
down immediately underneath it saying what the button does, and more information including 
keyboard alternatives--if extant--will also be displayed on the Bottom Bar.

You can turn on or off the display of this Top Speed Bar by going to the File Menu on the Main Menu 
Bar, choosing the Display Options then selecting Top Speed Bar.    When it is set to be displayed 
there will be a check mark next to this menu item, otherwise there won't be.



Trouble-Shooting Omitteds
If you're already in the middle of production and need help Trouble-shooting 
Omitteds, then continue reading below, otherwise please read the General 
Information Section on Omitteds

I can't get rid of an OMITTED Scene Heading that was accidentally put in

1 Place the cursor anywhere in the Scene Heading
2 Press the [END] key to get to the very end of the line
3 Press [BACKSPACE] repeatedly until it prompts you "SHOULD I REALLY DELETE THIS 

SCENE?"
4 Select YES

I need to simply MOVE an existing OMITTED SCENE HEADING within a Locked Script

As you're editing over time, it is not uncommon to end up with one or more omitted Scene Headings 
all alone on an otherwise omitted page.    This isn't very desirable, and you'll often want to combine 
these omitteds on a page, preferable the one preceding or following it that has some text on it.    

If the option COMBINE OMITTEDS THAT ARE "WIDOWED" ON A PAGE is checked on the 
SMARTCHECK page of the Program Options Menu, then SmartCheck will find and correct most 
instances of this type automatically.

However, if there is no previous or following SCENE OMITTED for SmartCheck to use, you may 
need to move the offending Omitted Scene Heading manually.    To do so, do the following:

1 Select the entire Scene Heading and nothing else
2 Using the mouse, DRAG'N'DROP this selected Scene Heading to its new position.

Assuming you did exactly as listed above, it will move the Omitted Scene Heading without creating a 
new OMITTED for you.

NOTE: For this to simply move the Omitted Scene Heading and keep its scene number intact 
without creating an A-SCENE, you MUST select the Scene Heading in its entirety and with no other 
text, and you MUST use the Drag'n'Drop function, not cut and paste.

At this point, you may need to use the CHEAT THE PAGE function to squeeze the newly moved 
Scene Heading onto the page.    Do so, or not, as needed.

I've got a bunch of Scene Omitteds in a row, how to I combine them?

As you're editing over time, it is not uncommon to end up with several omitted Scene Headings in a 
row like as follows:

  12  OMITTED                                   12

  12A OMITTED                                   12A

  12B INT. KEN'S OFFICE -- DAY                  12B

      ....



If you want to combine 12 and 12A in this case, it's very easy.    Simply do the following:

1 Select both Scene Headings so they are highlighted (ie blocked)
2 Press the [DELETE] key.    It will automatically produce the following:

  12  OMITTED:12A                               12
  AND                                           AND
  12A                                           12A

  12B INT. KEN'S OFFICE -- DAY                  12B

      ....
NOTE: the ":12A" in this case will NOT print, but is displayed there to enable manual override 
control

I need to override one of the number in a run of OMITTEDS

To override the STARTING NUMBER (ie, the 12 in the example listed above) do the following:

1 Place the cursor anywhere in the Scene Heading
2 Click on the FORMAT MENU, then CHEAT then ELEMENT (or simply press [F3])
3 Check Override Scene Number and set it to the desired starting number, then press OK

To override the ENDING NUMBER (ie, the 12A in the example listed above) do the following:

1 Place the cursor anywhere in the Scene Heading
2 Press the [END] key to get to the end of the Scene Heading
3 Press the [BACKSPACE] Key until all that's left is the Omitted Text
4 Type in a single colon ":" if this is to be an "AND" omitted (ie 12 AND 12A) or two colons if it is 

to be a "THRU" omitted (ie 12 THRU 13C) then simply type in the desired Ending Number
5 Click the FORMAT Menu, then REPAGINATE NOW (or press [CTRL+R]) to make sure it 

updates the numbering on all following Scene Headings
If the problem you're having is not listed here, you should also try the Section Scene Numbers in 
Production.



Typing the Multimedia Script
Before you can begin typing a Multimedia Script you need to load the 
Multimedia Script Format.    Once this is done, you will have access to all the 
Multimedia features and elements, and you can begin typing.

If you have the speed buttons on the right speed bar set to be visible, they will change to reflect the 
fact that you're writing a multimedia script. 

The top button (with the picture of several frames of an animated movie) will run the Multimedia Run-
Time Player; the one below that (with the picture of a graph) will Graphically Display the Multimedia 
Script; the one below that (with the picture of a hand pointing to a page) will run the User Activity 
Wizard which helps you write User Activies; the one below that (with a picture of a branching tree) 
will run the Branch Point Menu to easily create new Branch Points.

QuickType in the Multimedia Script

While you're in a Multimedia script, pressing [ENTER] in a blank action line will display a Menu with 
three items on it:

· USER ACTIVITY WIZARD will start the User Activity Wizard which will help walk you through
the creation of User Activities with plenty of examples as to what each of your choices mean. 
If the cursor was in a User Activity line when you selected this, the Wizard will first parse the 
activity and set up its options to reflect the current choices, making it painless to edit existing 
User Activities within the wizard.

· CREATE BRANCH POINT will display the Branch Point Menu with all the currently available 
Branch Targets and the ability to create new Branch Targets so you can easily build a Branch
Point without having to remember what the Branch Targets were.

· CREATE NEW BRANCH TARGET will start a New Branch Target in the script, give it a 
unique number and let you type in whatever text you want it to have.

You can also type User Activities without using the Wizard, simply by typing IF, ELSE, OTHERWISE, 
SET or ENDIF on any blank action line and it will immediately start a User Activity for you, allowing 
you to "manually" type it in as desired.



Multi-Level Undo
Movie Magic Screenwriter has a Multi-Level Undo function available.    You can enable up to 10 
levels of Undo, and the only reason to use less is if your computer is low on available memory.

Setting Available Undo Levels

Go to the FILE Menu, select Program Options then on the Editing Page there is a field named 
Undo Levels whose value you can set from between 0 to 10.    0 will completely disable the 
Undo functionality and the Undo/Redo Options will not be visible on the Edit    Menu

Using Undo

To undo any changes you have just made, simply go to the EDIT Menu and select UNDO.    Repeat 
as necessary.

Using Redo

Redo allows you to restore the script to the way it was immediately prior to the most recent Undo.    
You can only use Redo after having used Undo and before you make any additional changes.



Uninstallation
To uninstall Movie Magic Screenwriter and get back an installation credit, 
simply put the Movie Magic Screenwriter Installation disk into your disk drive 
and...

If you're in Windows 3.1: pull down the FILE menu from the Program Manager, select RUN and 
type A:SETUP or B:SETUP (whichever is appropriate) and then press the <ENTER> key.    

If you're in Windows 95: click the [START] Button, select RUN and type A:SETUP or B:SETUP 
(whichever is appropriate) and then press the <ENTER> key. 

When the first menu appears, instead of pressing OK, press the [UNINSTALL] button.    Follow all on-
screen prompts at that point and you will get an installation credited back onto your installation 
diskette.

NOTE: Uninstalling does NOT remove any actual files from your hard drive, it merely removes the 
copy protection validation, so if you want to remove the program from a computer completely, you 
must--AFTER uninstalling--delete the files yourself.



Unlock The Script Menu
This Menu is gotten to by clicking on Production, then Unlock the Script... and
is used to revert a locked script for to an unlocked one -- typically the only 
reason one would ever do this is if the Production Revisions have gotten SO 
extensive as to require an entirely new draft.

NOTE: Several items on this menu will typically be grayed out and inaccessible, this is due to that 
item having been already de-selected and not being an issue at this point.

UNCHECK any of the following items to TURN them OFF...

· Top Scene Continueds - these are the CONTINUED: lines that will go on the top of each 
page that does not start with a Scene Heading.    They are "place holders" for Scene 
Numbers and are almost invariably used in Production Scripts

· Bottom Scene Continueds - these are the (CONTINUED) lines that will go on the bottom of 
each page where that scene continues onto the next page.    Although they are of less real 
production value than then Top Scene Continueds, they are almost invariably used in 
Production Scripts

· Left & Right Scene Numbers - these are the Scene Numbers that that will on either side of 
the each Scene Heading, and which are used by the entire production staff to uniquely 
identify each scene.    Unchecking this option will turn off BOTH scene numbers.    To remove 
only the left or right, go to the Edit Script Formats Menu, Scene Heading Page and 
uncheck Left or Right as desired.

· Auto-Revision Marks - unchecking this item will NOT remove all current revision marks, it 
will simply turn off the AUTO revisions marks such that any new changes will NOT 
automatically get a revision mark next to them.    To remove all current Revision Marks, go to 
the Production Menu, select Remove, then Current Revision Marks.

UNCHECK any of the following to UNLOCK them...

· Scene Headings - by unchecking this item all A-Numbered Scene Headings will be 
converted back to normally numbered Scene Headings and all Scene Headings will be 
renumbered accordingly.

· Page Breaks - by unchecking this item, any existing A-Pages and Locked Pages will be 
converted to normal pages, and the entire script repaginated accordingly.

· Headers - by unchecking this item, any headers will be unlocked and updated to the current 
header text.



User Activity Wizard
On this screen, you are choosing the basic function of this User activity.

· Does the user have a choice to do something? - choose this option when the player is 
going to have the chance to perform an activity such as picking up a dog or opening a door.

· Does the user have a choice to do something but this choice is contingent on he or 
she already having done or learned something? - choose this option when the user is 
going to have a choice but only if something else has already happened.    For example, you 
might be at a point where the player can press a button and start the engine of a space ship, 
but they can only do this if they've already re-inserted the dilithium crystals back into the 
engine.    So the ability to make the choice to start the space ship is contingent on having 
fixed the engine.

· Are we checking to see if the user has already done something? - use this when the 
player isn't currently making a choice but events happen differently depending on whether or 
not they've already done something.    For example, the player has just entered a room.    
Now that he or she is in the room, we want to check whether he or she has already turned off
the alarm system.    If it hasn't been turned off then it blares loudly and awakes the dog which 
eats the player, otherwise the player will be able to sneak by.

· Are we simply setting a variable? - use this to set variables which are going to be checked 
later but which don't have any immediate impact on the play and happen regardless of what 
the player does.    For example, if the player enters a room and immediately meets GOD then
you might want to set the variable <MET GOD> to true because that's going to be important 
later.

Once you've selected your initial choice [NEXT] will take you to the next screen that's appropriate for 
the choice you made on this one.



User Activity Wizard
On this screen, you need to describe the action which the user has a choice 
to do.

What is it the User can do? - you are filling out here the text that is actually going to be put between
the IF and the THEN statements of the User Activity.    So if the action which the user can do is to a 
stab a dragon, you'd fill in STAB DRAGON and the user activity will ultimately read "IF YOU STAB 
DRAGON THEN"

Is this action something which we should be able to check later and see it has been 
performed? - check YES if you are going to need to be able to know later whether this action has be
performed.    For example this action might only have immediate effects, such as "IF YOU PICK UP 
CAT THEN IT PURRS" but there's no greater impact and it's unimportant whether it's happened.    
However, it might have more far-ranging effects like "IF YOU PUT A FISH IN YOUR EAR THEN YOU
<CAN UNDERSTAND ALL LANGUAGES>."    Later when you meet an apparently ferocious alien, if 
you can understand him, you'll realize he's really offering you a ride not trying to eat you.    So at that 
point, you'll have to be able to check whether or not you can <UNDERSTAND ALL LANGUAGES> 
and you'd need to have checked this box here.



User Activity Wizard
On this screen, we're describing the ramifications of the previous action, what
variables it affects and how we'll be able to check if it was performed later.

If the user chooses to [perform previously described action] now, what action has been 
performed? - the text you're entering now will become a variable that can be later checked, so if 
the action the user had a choice to do was "PUT FISH IN YOUR EAR" then you could enter "HAS 
FISH IN EAR" here, but if this action gives you the ability to understand all spoken languages then it 
would be betting to say "CAN UNDERSTAND ALL LANGUAGES" because that's the real 
ramifications of the action.

If action is performed then set this variable to FALSE - check this when the action changes a 
previously defined variable from true to false.    This is most common when the action results in the 
user using up or giving away an object, such as if the action is "BUY LAMP" then it might set the 
variable "HAVE GOLD" to false.

Does this action affect other variables - check this option when the action in question affects more
than one variable, such as in the previous example of "BUY LAMP" which might set "HAVE LAMP" to
true and "HAVE GOLD" to false.



User Activity Wizard
This screen lets you select variables from list of all the previously defined 
variables in the script, specifying which of them are affected by this action 
and whether it sets them to true or false.

Drag Variables from the list below to the appropriate window in order to set the state of the 
Variable - the first list contains ALL the variables previously defined in the script, and it is from this 
list that you should choose the ones that are affected by the action in question.    

You do so by clicking on that variable and dragging it down into either the Set these variables to 
TRUE list or the Set these variables to FALSE list as needed.



User Activity Wizard
This window lets you specify what happens in the story when the user choose
to perform this action.

Events happen because of it - check this item if--when the user chooses to perform this action--that
changes the direction the story goes or other characters say or do something differently based on 
whether this action is performed.    For example, if the action is "SWEET-TALK SALESWOMAN" then
if it is performed she'll give you a better deal and show you the store's stock reserved for "special 
customers," if you don't then you just get the tourist rip-off rate.    Thus the action affects the flow of 
the story.

Branch to new position in story - check this item when the action moves you to another "branch 
target" which may be a physical location such as a new room or more of a "story plot point" such as 
advancing to Level 2.    Depending on how you write the script, this option may be used in place of 
the preceding option "events happen because if it" if you break up interactions into separate branch 
targets rather than nesting if-then statements.

The story continues normally - use this option when the action affects variables but not the 
immediate flow of the story.    For example if the action is "PICK UP BROOM" and the result is to set 
the variable "HAVE BROOM" to true but not affect anything else at this point in the story then you'd 
choose this option.

Something different happens if the user does NOT perform the specified action - check this 
box when not performing the action causes a different set of events to happen, such as in the 
example    of "SWEET-TALK SALESWOMAN" above.



User Activity Wizard
This screen is where you select the Branch Target that performing this action 
will take you to.

Select where this action should branch you to: - Simply click on one of the existing Branch 
Targets to select it, or click on [Create New Branch Target] to create and select a new one.



User Activity Wizard
This screen is where you choose which variable is being set and whether it is 
being set to true or false.

Enter a new Variable or select an existing variable by clicking on the down arrow,,, - you can 
either create a new variable by simply typing the text in the variable field, or you can select an 
existing variable by clicking on the arrow to pop-down a list of all the currently defined variables and 
selecting the one you want.

Set this Variable to FALSE - unless you have this box checked, it will set the variable to true, 
otherwise it will be set to false.



User Activity Wizard
This screen lets you select which variables must be true or false before 
this action can be performed.

Drag Variables from the list below to the appropriate window in order to set the conditions for
this activity to happen - the first list contains ALL the variables previously defined in the script, and 
it is from this list that you should choose the ones that must be either true or false before this activity 
can be performed.    

You do so by clicking on that variable and dragging it down into either the Check to see if the 
following variables are TRUE list or the Check to see if the following variables are FALSE list as
desired.



User Activity Wizared
The User Activity Wizard is designed to make the creation and editing of User 
Activities (in Multimedia Scripts) painless and fun.

The User Activity Wizard is displayed by doing one of the following:

· Clicking on the User Activity Wizard speed button (the third one down on the right speed bar 
with the picture of a hand pointing at a page)

· Pressing [ENTER] in a blank Action line and selecting User Activity Wizard from the menu 
that appears

NOTE: if you are in a User Activity Element and you click on the User Activity Wizard speed button, 
then the current User Activity Element will be parsed and its values filled into the Wizard for easy 
editing.

Once the wizard is displayed there are four options on the first screen.



Watermarks for Script Serialization
This Menu is gotten to by going to the PRINT Menu, clicking on SETUP and 
selecting Watermark.

Watermark Security Options allow production companies to keep track of their scripts by having each
script have a name/serial number printed in gray in the background of every page.    To use this 
function, it will have to print out every page of every copy so you should ensure that you have a very 
fast printer or a lot of time...

Text - this is an optional line of text (it can be left blank) that will be printed as a "watermark" on every
page and might be used for the company name.    This is set a program default for all scripts -- the 
other three options are kept specific to each script.

Bitmap - you can select a bitmap to be printed on every page.    This WILL slow down the printing 
process however, so you may want to consider not using this feature or having paper pre-printed with
a light gray graphic if really want one.

Distrib. List - this is the heart of the Serialization functionality, allowing you to build a list of all the 
names of people to whom the script is being distributed.    Then when you print, you merely select 
which people should get copies and the program will internally handle the serialization numbering.

· To Create a New Name List simply type in a name such as "FIGHTER."    As soon as you type 
in text, the LOAD button will change to EDIT, and you should click on it.    The Name you entered 
will automatically be given the. LST extension and created for you.    You will then be taken to the
Edit Watermark Name List Menu where you can add names and otherwise edit the list.

· To Load an Existing Name List, without having any text in the Name List Field, simply click on 
LOAD button and select an existing list.    This list is just an ASCII file with each name on its own 
line with a hard return following it, so you can create it or generate it in another program if 
desired.

Serial # lets you (optionally) specify a starting serial number that will be used for the first name in the
Name List.    Each subsequent name will be given the next incremenation of this number.      The 
number can be any combination of letters/Numbers and is incremented from right to left.    In other 
words if you put in as a serial number "1000-0001" then the next incrementation would be "1000-
0002" and so on, when it reached "1000-0009" then the next one would be "1000-0010"

Print Just the Serial Numbers without Names - this option will only be available if you have both a 
name list and a starting Serial Number set up.    If checked, then it will not print the names from the 
name list on the printed watermark.

Select Font for Watermark Text allows you to change the font, style and size of the font used for 
the Watermark Text.

Watermark Density allows you to select how dark the gray is from complete black (0) to complete 
white(255).    Different versions of Windows, different printers, and different print resolutions can 
make dramatic changes in how each darkness of gray prints so you need to experiment and find out 
what works best for your particular system.

Graying Method - different versions of Windows and different print drivers allow more or less 
efficient ways of printing gray text.    You'll have to experiment with your setup to find the best one for 
you:



· Print Gray as Color this is the preferred method as it will not slow down printing at all - 
however if it prints black text when you select this you may need to change the Printer 
Settings in either Control Panel or the Printers Windows (in Win95) to set it to print TrueTypes
as Bitmaps or Graphics.    And certain Windows 95 printers don't seem to support this option 
at all so you may need to select...

· Graphically Gray this prints the text as a gray graphic and is the most reliable method 
across all versions of Windows and printers but may be a little slower and/or "rougher" 
looking than Print Gray as Color

Print Name in Lower Right Hand Corner instead of Grayed/Centered will do just that, printing the
name in the lower right hand corner of every page.

[Print Gray Sample] will print out a page of gray text using the current Graying Method and 
Watermark Density.

Text Angle allows you to control the rotation of the text from +90 degrees (rotating counter 
clockwise) to -90 degrees (rotating clockwise)

Letter Spacing increasing the amount of white space between the letters.    You can increase letter 
spacing from 100% (normal) up to 300% if you're printing using Gray as Color, or up to 200% if 
you're using Graphically Gray.    This difference is due to the limitations of Windows Graphic Device 
Interface (GDI) when printing the text graphically.



Windows' Printer Setup Menu
This pops up the standard Windows Printer Setup Menu allowing you to select a printer, change the 
page size, and any of the other normal printer options.    See your Windows' documentation for 
further details.



Zoom Screen Text Menu
You can get to this menu by hitting the [Zoom] Speed Button on the Top 
Speed Bar or by selecting the File Menu, choosing Display Options then Zoom
Screen Text...

To change the Zoom level - simply drag the scroll bar left or right to zoom the size of the on-screen 
text to a more pleasing level.

NOTE: Depending on your screen's current resolution, you may have to zoom several percentage 
points in order to see a difference in size of the on-screen text.



A-Pages
A page numbering scheme used only in production.    This scheme generates A and B pages as new text
is added to a locked script. For example if enough new text is added to Page 6 to require a new page, 
then the new page generated is numbered 6A.    Page 7 begins at exactly the same point in the script as 
it did before revisions were added.



A-Scenes
A Scene numbering scheme used only in production.    This scheme generates A and B scenes as new 
scenes are added to a locked script. For example if a new Scene is added between Scenes 2 and 3, the 
new scene will be numbered Scene 2A.



Act Information
An element used only in TV Scripts to denote the Act.    It is typically centered, not infrequently 
underlined, and can have a variety of different numbering schemes.



Action
A basic Element, also sometimes called Scene Description or Stage Description



adding text
You can add text by typing normally. If the Insert Mode is on, then new text added at the cursor will push 
over old text.    If Typeover Mode is on, then new text will type over and delete the old text to the right of 
the cursor



ASCII
A format consisting of just the standard letters and numbers and spaces but without any program-
specific formatting codes



Asterisked Pages
An option on the Print Menu that will print only those pages with Asterisk on them, and any A-Pages 
immediately following those pages.    Typically used only in Production.



Auto-Revision Color
A color which will be applied to any new text changes.



AutoRevision Marks
An automatically added Revision Marks put in whenever you add/delete or change text in your script.    
This is designed specifically for use when you're in production, but can also be quite useful if you are 
writing with a partner and are sending drafts back and forth.    Turned on/off by selecting Auto-Revision 
Marks on the Format Menu.



Available Movement keys
Up & Down Arrow                      - Move Up or Down One Line
PgUp & PgDn                                  - Move Up or Down One Screen
Ctrl+PgUp & Ctrl+PgDn      - Move Up One Full Page
Left & Right Arrows                  - Move by single letters
Ctrl+ Left & Right Arrows - Move by words
Home &    End                                      - Move to beginning or end of line
Goto Menu in the Main Menu Bar - numerous movement options



Bolding Text
Method 1:  
Method 1: On The Top Speedbar,    click the button labeled "B" 

Method 2: Press <CTRL+B>



Bottom Continued
The Scene Continued (optionally) printed on those pages where a scene continues onto the next page.   
You can set its text in the Edit Script Formats Menu and its position on the Printer Page of the Program 
Options Menu.



Bottom Margin
The minimum distance between the last line of text and the bottom of the page.    Set on the Setup Page 
Layout Menu.



Branch Points
are the Multimedia Script's way of handling the non-linearity of a multimedia project, allowing you to 
branch (or jump) from the current place in the script to any Branch Target that's referenced in that 
Branch Point.    For example, in a multimedia adventure game, a Branch Point might contain three 
Branch Targets because you are in a room with three exits, or in an educational CD ROM it might have 
eight Branch Targets when you're at the Main Menu with eight possible sub-menus.    

Branch points are bolded, with each Branch Target on a separate line, and a triangular pointer to the left 
of the margin indicating that it is a Branch Point.    Each line also has the reference number of the Branch
Target    to which it is pointing.    Don't worry about these numbers, though, as Movie Magic Screenwriter 
maintains them automatically.



Branch Targets
are the Multimedia script's equivalent of Scene Headings, and are used in the Multimedia script as 
"places" that can be branched (or jumped) to.    A sample Branch Target in a Multimedia Adventure game
might be SECRET PASSAGEWAY, or in an educational CD ROM about Dinosaurs, FEEDING HABITS 
OF TRICERATOPS.    

Branch targets are all in capitals, are underlined, and have an automatically generated number to the left
of the margin which is used internally by the program as a reference for the Multimedia branching.      For
example:

(1)      SECRET PASSAGEWAY



Changing an Element from One Type to Another
Method 1:    Select the Edit Menu, then Change Element Type and select a new element type from the 
list of available Elements.

Method 2:    Press the Change Element Button (the one with the current element type displayed) on the 
Top Speedbar, then select a new element type from the list of available Elements.

Method 3: Press F4 for the Change Element Type Menu and select a new element type from the list of 
available Elements.



Changing the Capitalization of Existing Text
Select the text to be changed using any method as described in Selecting Text above.    Select the Edit 
Menu,    then chose Convert Case and choose Uppercase, Lowercase, or Initial Capitals as desired.



Character Extensions
Character Extensions are directions such as O.S. (Off Screen) or V.O (Voice over) and Continued.



Character Name
Strangely enough, the name of the character.



Character Names
An element which precedes Dialogue and identifies who is speaking.



Cheat Button
The Cheat Button--the button on the Top Speed Bar with the icon of a hand and card coming out of its 
sleeve--will put up the Cheat Element Menu where you can cheat the left/right margins, line spacing, 
lines before, capitalization, text style and font for the element the cursor is on.    In addition, for Character
Names you can override the automatic Character Continued, and for Scene Headings, you can override 
the Scene Number.



Cheating the Margins of an Element
Method 1: Select the Edit Menu, then Cheat, then Element and change the margins as desired.

Method 2: Press <F3> to get to Cheat Element Menu and change the margins as desired.

Method 3: Display the Ruler by going to Display Options in the File Menu and selecting Ruler or by 
clicking on the Ruler Button in the Top Speedbar, then put your cursor in the element whose margins you
want to adjust and move the right or left margin markers accordingly.



CheckBoxes
CheckBoxes are checked and unchecked by (1) pressing the Underlined QuickSelect Letter, (2) clicking 
on them with the mouse, or (3) cursoring to them and pressing Enter or the Space Bar.



close
Or, in other words, "exit".    Close is Windows' terminology because you are "closing" a Window.



Collaborator®
A story development software program that is a registered trademark of Collaborator Systems, Inc.



Copying Script Elements into User Lists
If you want to make Character Names or Scene Body Text (Locations) items that are in the script text 
available for other scripts, then you need to copy them into the appropriate User List. There are three 
element types that you can copy, and they are Character Names, Scene Body Text (locations), and 
Transitions, and they all use the Method below:

To do so, get to the the Edit User Lists Menu and then when you select one of the three listed above 
user lists there will be a button at the bottom left of the screen labelled Copy from Script and when you 
click that button you'll be presented with a menu of the unique instances of that Element.    To    copy an 
element into the list, simply double click on it.    Repeat as desired until the User List is filled or you    
select [CLOSE].



Copying Text
First select the text you want to move as described in Selecting Text above and then...

Method 1: Click the Copy Button on the Top Speed Bar.

Method 2: Select Copy from the Edit Menu.

Method 3: Press <CTRL+INS> or <CTRL+C> depending on the editing scheme you've selected on the 
Keyboard Page of the Program Options Menu -- default is <CTRL+INS>

Method 4: Click the Right Mouse button and click on Copy from the menu or PowerPanel that appears.



Courier Old
A TrueType font supplied with Screenwriter that is a darker Courier font than the Windows' Courier New. 
Generally recommended for use with the Substitute Font for Courier New option on the Printing Page of 
the Program Options Menu.



Current Revision Marks
A Revision Mark (or Asterisk) that is either put in automatically via the AutoRevision Mark Function or by 
pressing the asterisk key on the keyboard.      It is used by production companies to denote what's been 
changed on the page and is typically simply an asterisk though it may be an (X) or some other text.
 
These Current Revision Marks are the only ones which will be removed by selecting Remove Current 
Revision Marks from the FORMAT Menu; they are the only ones that will be found when you select Next 
Current Revision Mark from the GOTO menu; and finally, they are the only ones used to select pages to 
print when you select Asterisked Pages on the Print Menu.



Cut & Paste Importing from another Windows Program



Cut & Paste Importing from other Windows Programs
Step 1: Open the script in whatever Windows Word Processor it is currently in, and select the entire 
script (most programs have an option for Select All on their Edit Menu, but see that program's 
documentation for details if needed).

Step 2: Wiith the entire script selected, go to the Edit Menu and choose Copy.

Step 3. Press <ALT+TAB> to task switch out of that program without exiting it and run Movie Magic 
Screenwriter if it isn't running already.

Step 4. Once in Movie Magic Screenwriter, start a new script, and go to the Edit Menu and select Paste. 
You will see a menu with the following options: Import Text in Script Format, Import Text as Action Only, 
and Text Only (Non-RTF).    

Unless what you are importing is an outline or some other non-script text, then leave Import Text in 
Script Format checked and unless you try this and have a problem, don't check the Text Only box.    
Press [OK] and your script wil



Cutting Text
First select the text using any method then... 

Method 1: Select the Cut Button in the Top Speed Bar.

Method 2: Select Cut from the Edit Menu

Method 3: Press <SHIFT+DEL> or <CTRL+X> depending on which editing key scheme you have set on 
the Keyboard Page of the Program Options Menu -- the default is <SHIFT+DEL>

Method 4: Click the Right Mouse button and click on CUT from the menu or PowerPanel that appears.



Deleting Text
You can delete the letter that the cursor is on with the Delete key and the letter to the left of the cursor 
can be deleted with the Backspace key.    
 
If you have text selected, pressing the Delete key will delete the block and that text will be gone forever 
unless you use the Undo function from Edit Menu before you do any further editing.
 
There are additional options for deleting the word, and to the end of the line and you can set which keys 
do them on the Keyboard Page of the Program Options Menu



Dialogue
The actual dialogue (what they say, man!) of a character -    usually displayed and printed within 
somewhat wide margins within the script.



Drag'n'Drop
The ability to select text with the mouse, click anywhere WITHIN the blocked text and while HOLDING 
THE MOUSE BUTTON DOWN, drag the mouse cursor to a new position.    When the mouse button is 
released, the text will be "dropped"    (ie moved from its old position to here) at the cursor position.



Dramatica®
A story development software program that is a registered trademark of Screenplay Systems, Inc.



Editing User Lists
To edit your user lists, go to the Format Menu and select Edit User Lists and you will see the Edit User 
Lists Menu where you can edit the lists themselves.



element group
Elements which are grouped together by script format, such as a Character Name and any 
Dialogue/Parentheticals following it, or a Scene Heading and the following Action.



Elements
A Movie Magic Screenwriter Element is the most basic unit of the script, with its own margins, line 
spacing, capitalization etc.    The six most common elements are Scene Heading, Action, Character 
Name, Dialogue, Parenthetical, and Transition.



Flex A-Pages
This reverts all Fixed A-Pages to Flexible A-Pages which may cause several A-Pages to be combined.    
It is done by selecting Fix/Flex A-Pages on the Format Menu and then selecting Flex All A-Pages.



Font
or TYPEFACE...



Fonts
or TYPEFACE...



Getting to Index Card Viewing Mode
Movie Magic Screenwriter allows you to see your Script as if it were on Index Cards, with each scene on
its own card, the Scene Heading on the top bar of the card, and the initial text of the scene (including 
dialogue) within the card itself.    This lets you see your script in more of a gestalt, in addition to allowing 
you to shuffle the scenes around as desired.    To get into Index Card Viewing Mode select View As Index
Cards under Windows Menu in the Main Menu Bar or click the Index Card View Button on the Top 
Speedbar.



Group
A logical combination of related elements such as - Character Name and Dialogue or Scene Heading 
and Action immediately following it.



Hard-Dash
Is a dash that will NOT be used to Word-wrap a word over the end of a line.    For example, if you have a 
two words with a dash in between them, such as set-up that you don't want Movie Magic Screenwriter to
separate over the line break, then use a Hard-Dash between them.



Hard-Space
A Hard-Space is a space that will NOT be used to Word-wrap a word over the end of a line. For 
example, if you have a two words that you want kept together on a line, such as Mr. Beckenridge, then 
use a Hard-Space between them and Movie Magic Screenwriter will treat them as one long word.



Insert
When typing in this mode it will insert letters at the cursor position, pushing any existing text to the right.  
This is the mode the program always starts in, and you can force the program to stay in Insert mode by 
unchecking Allow Typeover on the Text Entry/Editing Page of the Program Options menu



Italicizing Text
Method 1: On The Top Speedbar,    click the button labeled "I" 

Method 2: Press <CTRL+Y>

NOTE: Screenwriter uses <CTRL+Y> for Italics because <CTRL+I> puts in    INT.



Line Spacing
Has two parts to it:    

LINES BEFORE which are the blank lines between the start of this element and the previous element.

INTERLINE which is the spacing between the lines WITHIN this element if it wraps to multiple lines.



List Menu
This is a scrollable menu similar to the Pull-Down menu except this menu's options DO NOT have any 
Underlined QuickSelect letters in them.    You can (1) scroll through the options with the arrow keys, (2) 
scroll through the options using scroll-bar, (3) use the mouse and click on the option you want, or (4) 
type letters and it will match what you've typed against the menu options, automatically scrolling to the 
matching one.    When the one you want is highlighted, press Enter.



Loading User Lists
User Lists from other Movie Magic Screenwriter scripts or created in other programs can be loaded into 
Screenwriter.    If you are loading from a Screenwriter script it will load ALL the User Lists, if you are 
loading from an ASCII file, it will only load Character Names or Locations (Scene Body Text) and if there 
are more items in the List to be loaded than Screenwriter allows, (which is only a problem when you are 
loading a ASCII Text File or from lists generated with another program), then Screenwriter will only load 
the first ones in the list.

NOTE: To load a user List from a ASCII file, the file must have each Item on a single line with a Hard 
Return at the end of the item.

Method: Select the Format Menu from the Main Menu Bar and then choose Load User List from and 
select among the options Screenwriter Script, ASCII List, Collaborator, or Dramatica as appropriate.



Locked Letter Skip List
A list of letters which should be skipped in the numbering of Act & Scene Info, in addition to A&B 
Pages/Scenes.    Typical letters skipped are I and O because they look too much like the numbers 1 and 
0 and E and F because they look too much alike.    This Skip List is set on the Locked Scripts Page of 
the Edit Scripts Format Menu.



Locked Revision Marks
A Locked Revision Mark (or Asterisk) is an ex-Current Revision Mark used by Animation Production 
companies to denote what's been changed on the page and is two or more asterisks depending on its 
locking level.
 
These Locked Revision Marks will NOT be removed by selecting Remove Current Revision Marks from 
the FORMAT Menu; they will NOT be found when you select Next Current Revision Mark from the 
GOTO menu; and finally, they are not used to select pages to print when you select Asterisked Pages on
the Print Menu.



Long File Name
In Windows 95 it is the normal Windows 95 long file name.



Main Menu Bar
Movie Magic Screenwriter's Pull-Down menus can be accessed from the Main Menu Bar by single-
clicking on the menu items or by pressing Alt key and the underlined letter in the menu item.
NOTE: To use Alt-keys to access Main Menu Bar you must have Enable Alt-keys for Character Name 
Entry box unchecked in the Program Options.



Margins
The border or blank space around an element -- c'mon don't you know what margins are?



Merging Scripts
Retrieve the first one and place the cursor where you want the second script to be added.    This can be 
in the middle of the script, and even in the middle of an element, if desired.

Select the Edit Menu, and select Paste From...    A menu will appear of all existing scripts and you should
select the one to Merge.    Movie Magic Screenwriter will then merge that script into the one on screen, 
reformatting it automatically.



Movie Magic Scheduling
A widely used Scheduling program produced by Screenplay Systems



Movie Magic®
A budgeting and scheduling program which is also a registered trademark of Screenplay Systems, Inc.



Movie Master®
A screenwriting program which is also a registered trademark of Comprehensive Video, Inc.



MOW
Movie of the Week - a long-form TV script typically using the standard screenplay format but broken up 
into acts



Non-Printing Text
Text which has been marked as Non-Printing by going to the Format Menu, selecting Cheat, then Mark 
as Non-Printing.

When text is marked as Non-Printing, then it will display on-screen as grayed and striked out and it will 
not take up any space in the script nor will it print.

This allows you to effectively delete text from your script but not lose it so that you can restore it later if 
desired.



Opening an ASCII RTF Movie Master® or Scriptware® Tagged File
Step 1: Run Movie Magic Screenwriter if you aren't already.

Step 2: Go to the File Menu and select Open.

Step 3: Change the File Type to the type of file you are opening, be it WordPerfect, MS Word, ASCII, 
RTF, Movie Master or Scriptware Tagged.    If your file is not listed then it may not have the expected 
extension and you should select ALL Files instead.

Step 4: Select the file you want to open and press [OK].    Your script will then be imported.



Opening any of the supported formats
Step 1: Run Movie Magic Screenwriter if you aren't already.

Step 2: Go to the File Menu and select Open.

Step 3: Change the File Type to the type of file you are opening, be it WordPerfect, MS Word, ASCII, 
RTF, Movie Master or Scriptware Tagged.    If your file is not listed then it may not have the expected 
extension and you should select ALL Files instead.

Step 4: Select the file you want to open and press [OK].    Your script will then be imported.



Option Menu
These menus have different types of input options including PushButtons, CheckBoxes, RadioBoxes, 
and Text & Numerical Input Fields.    All options have a Underlined letter, and you can select the option 
you want by (1) pressing that letter (if you're in a Text or Numerical Input Field such as the File Name, 
press Alt + that letter so that it can distinguish that from straight input); (2) moving around in the menu by
pressing the Tab key or the up and down arrow keys and edit the option you want when it's highlighted, 
or (3) using the mouse and clicking on the one you want.



Overriding the breaking of Action or Dialogue
If there is a specific block of Dialogue or Action that Movie Magic Screenwriter is breaking over a page 
break and you want it to keep it together, it's not a problem.    

With the cursor at the beginning    of the element you want to keep together...

Method 1: Click on the Format Menu , select Cheat and then Keep Together on Page.

Method 2: Press <CTRL+K>



Pages
Pages are screens on many menus which have more options on them then can be displayed at one 
time.    Examples of menus that have pages are the Edit Scripts Format Menu whose different pages are 
accessed by pressing radio buttons on the right hand side of the screen, and the Configuration Wizard 
whose pages are accessed by clicking Tabs at the bottom of the screen.



Parenthetical
stage directions to the actor, denoting specific instructions for the delivery of that line.    e.g. (whispering),
(amusedly), etc.



Pasting Text
Position the cursor where you want the text to be pasted and...

Method 1: Click the Paste Button on the Top Speed Bar.

Method 2: Select Paste from the Edit Menu.

Method 3: Press <SHIFT+INS> or <CTRL+V> depending on the editing scheme you have selected on 
the Keyboard Page of the Program Options 

Method 4: Click the Right Mouse button and click on PASTE from the menu or PowerPanel that appears.



PowerPanel
Movie Magic Screenwriter' unique Right Button Interface which gives you acess to the most common 
editing features with just a click of the Right Mouse button. This Pop-Up Panel of PushButtons 
considerably speeds up script editing and can be turned on or off on the Mouse Page of the Program 
Options Menu.



Preparing a Script from any other non-Windows Word Processor
See their manual or call their Tech Support to find out the best way to produce a RICH TEXT FORMAT 
file (preferred) or an ASCII file with formatting and line-feeds (or Hard Returns) at the end of each line--
typically there is an option to "Print to a File" if you can't actually save it directly as a TEXT ONLY or 
ASCII file.



Preparing a Script from any Windows Word Processor
Step 1: Load the Windows program that you're exporting from and retrieve the script as you would 
normally.

Step 2: Go to that program's File Menu and choose Save As.    On the menu that appears, there should 
be an option for the filename. Change it to C:\SCRIPTS\(FILENAME).RTF replacing (FILENAME) with 
the script's name.

Step 3: On the Save As Menu there should also be an option like FORMAT or FILE TYPE or SAVE 
TYPE that lets you specify what format it's saving in, and you should change it to RICH TEXT FORMAT 
or RTF if possible.    If neither of those are available then choose DOS TEXT or ASCII TEXT (and if you 
have DOS or ASCII options that says something like WITH LINE BREAKS or WITH FORMATTING then 
those are the ones you want to select).

Step 4: Click [OK] and then exit the Word Processor when it's done saving and follow the instructions in 
Opening an ASCII, RTF, Movie Master or Scriptware Tagged File.



Preparing a Script from Final Draft®
Step 1: Open your script file in FINAL DRAFT as you would normally.

Step 2: Select the FILE Menu, then EXPORT...

Step 3: Change the FORMAT to RICH TEXT FORMATthen change the file name to make sure you don't 
overwrite your original file. 

Step 4: Click the EXPORT button and then when it is done exporting, exit Final Draft as you would 
normally and then follow the instructions as described in the section "Opening any of the supported 
formats" listed above



Preparing a Script from Microsoft Word® (DOS) other than Ver 5.5
Step 1: Open the script file in Microsoft Word as you would normally.

Step 2: Start to save your script, but at the screen where you can specify the file name, you should 
change the name to C:\SCRIPTS\(FILENAME).RTF replacing (FILENAME) with the name of your script, 
and change the format to RTF then save the script.

Step 3: Exit Microsoft Word and follow the instructions as described in the section "Opening any of the 
supported formats" listed above



Preparing a Script from Movie Master® for DOS
Step 1: Open your script file in Movie Master as you would normally.

Step 2: In your CONFIGURATION, select a TTY printer.

Step 3: Select Print from the menu and enter the names of the file(s) that make up your script.

Step 4: Select Export from the Print Menu and enter a file name, specifying the C:\SCRIPTS 
Subdirectory if it lets you.

Step 5: Exit Movie Master as you would normally and then follow the instructions as described in the 
section "Opening any of the supported formats" listed above



Preparing a Script from Movie Master® for Windows
If Movie Master for Windows is on the same machine as Movie Magic Screenwriter then use the CUT & 
PASTE importing otherwise...

Step 1: Open your script file in Movie Master for Windows as you would normally.

Step 2: Select the FILE Menu, then SAVE AS...

Step 3: On the SAVE AS Menu change the FILE TYPE to RTF if it's available, otherwise ASCII.    
Change the file name to make sure you don't overwrite your original file.    Press OK.

Step 4: Exit Movie Master as you would normally and then follow the instructions as described in the 
section "Opening any of the supported formats" listed above



Preparing a Script from Scriptware®
Due to the changes in the program, we don't have up-to-date information on how one produces a 
Scriptware Tagged file in all the versions so try the following and if it doesn't work, then see Scriptware's 
printed documentation or call their tech support for help on producing a Scriptware Tagged file.

Step 1: Open the Script in Scriptware as you would normally.

Step 2: Press <Esc>, then select Project.

Step 3: Press E for Export.

Step 4: Enter C:\SCRIPTS\(FILENAME).TAG, replacing (FILENAME) with the name of the script and 
press [OK].

Step 5: You will then see an EXPORT OPTIONS screen and you should turn SCRIPTWARE "TAGGED" 
FILE to ON then press the [OK] button.

Step 6. Exit Scriptware and then follow the instructions as described in the section "Opening any of the 
supported formats" listed above



Preparing a script in WordPerfect® 5.0 (for DOS) or earlier
Step 1: Load WordPerfect and retrieve the script as you would normally.

Step 2: Press <CTRL+F5> and chose SAVE AS then GENERIC. 

It will allow you to type in a name and you should type in:
                          C:\SCRIPTS\(FILENAME).DOS 
...replacing (FILENAME) with the name of your script and press <ENTER>.

Step 4. When it is done saving, press <F7>, press N when it asks you if you want to save and then Y
to exit.    Now follow the instructions as described in the section "Opening any of the supported 

formats" listed above



Preparing a script in WordPerfect® 7.0 or later    -- DOS or Windows
Step 1: Load WordPerfect and retrieve the script as you would normally.

Step 2: Go to the FILE Menu, chose SAVE AS and under FORMAT select RICH TEXT FORMAT (RTF).

Step 3: For FILENAME, enter C:\SCRIPTS\(FILENAME).RTF replacing (FILENAME) with the name of 
the script and press <ENTER>.

Step 4: Exit WordPerfect as you would normally, but DON'T save the script when it prompts you, and 
now follow the instructions as described in the section "Opening any of the supported formats" listed 
above



Preparing Text created in Dramatica® version 3.0 or later
See your Dramatica manual for information on creating a "Screenwriter Export"    file.    Follow those 
instructions and then simply open the text as described in the section "Opening any of the supported 
formats" listed above



Pull-Down Menu
This is a scrollable menu whose options all have a Underlined QuickSelect letter in them.    To make a 
selection, you can (1) scroll through the options with the arrow keys and press Enter, (2) use the mouse 
and single-click on the one you want, or (3) simply press the Underlined QuickSelect Letter and the 
option you want will be instantly selected.



PushButtons
You select a PushButton by (1) clicking on it with a mouse, (2) selecting it with the arrow or tab keys and 
pressing Enter, or (3) pressing its Underlined letter and whatever function it does will be accessed 
immediately.    Ok will always exit a menu, accepting all of the current settings, Cancel will always cancel
a menu without changing anything.



Put a Location into a Scene Heading (ie KIRK'S DEN)
Method 1: Type it in. 

Method 2: If you already have this location in a Scene Heading anywhere in the script, then once you 
have the initial text (ie INT. or EXT.) typed into the Scene Heading, simply press <ENTER> and select it 
off the list that appears.



Put an Existing Character Name into Action/Dialogue
Press <CTRL+C> and a Pop-Up menu will appear with all the existing Character Names.    Select the 
one you want and it will be put in as text at the cursor.



Put in a Centered Title
Press <SHIFT+F6> in any Action Element.



Put in a Character Name Extension
While the cursor is anywhere in a Character Name, press the left parenthesis "(" and a Pop-Up Menu 
will appear with all of your Character Extension Options.    Choose the extension you want.



Put in a Forced Page Break
Method 1: Select the EDIT Menu in the Main Menu Bar, choose Add Forced Page Break.

Method 2: Press <SHIFT+ENTER>



Put in a New Character Name
From anywhere in the script, press the <TAB> key, type in the name and press Enter.



Put in a Parenthetical
Press the left parenthesis "(" while the cursor is anywhere in Dialogue and a Parenthetical will be 
inserted at that position, automatically breaking the Dialogue if needed.



Put in a Script Note
Method 1:    Press <CTRL+F1>

Medthod2: Click on the Element Button on the Right Speed Bar with a Musical Note on it.    (Note this 
may not be displayed...)



Put in a Shot
Method 1: Type any valid Shot Text (like    BACK TO SCENE) at the beginning of a blank line and Movie 
Magic Screenwriter will turn it into a SHOT with capitalization and everything.    

Method 2: Press <CTRL+H>anywhere in the script and Movie Magic Screenwriter will put you into a 
Shot and display a Pop-Up Menu of all available Shot Texts. If the one you want isn't on this menu, then 
select New Shot and then type it in.



Put in a Transition
Method 1: At the beginning of any blank line, type any valid Transition text (CUT TO:, FADE OUT:) and 
Movie Magic Screenwriter will automatically capitalize it, space it correctly and so on. 

Method 2: From anywhere in the script, press <CTRL+T> and you will be put into a Transition.



Put in a Hard-Dash
A Hard-Dash is a dash that will NOT be used to Word-wrap a word over the end of a line.    For example, 
if you have a two words with a dash in between them, such as set-up that you don't want Movie Magic 
Screenwriter to separate over the line break, then use a Hard-Dash between them.

Method : Press <CTRL+SHIFT+DASH>



Put in a Hard-Space
A Hard-Space is a space that will NOT be used to Word-wrap a word over the end of a line. For 
example, if you have a two words that you want kept together on a line, such as Mr. Beckenridge, then 
use a Hard-Space between them and Movie Magic Screenwriter will treat them as one long word.

Method: Put the cursor where you want the Hard-Space to be inserted and press <CTRL+ALT+SPACE>.



Put in a Soft-Hyphen



Put in a Soft-Hyphen
A Soft-Hyphen is a dash that will ONLY appear if the word needs to be broken over a line end, otherwise
it will be invisible.

Method : Press <CTRL+DASH>



Put in Act Information (TV Format)
Method 1: Type any valid PROLOGUE Text with any capitalization at the beginning of a blank line and 
Movie Magic Screenwriter will automatically center it and capitalize it.

Method 2: Type NEWACT with any capitalization at the beginning of any blank line and Movie Magic 
Screenwriter will center it and change it to ACT <NUMBER>, automatically incrementing the number 
from the most previous Act.

Method 3:Type SAMEACT with any capitalization at the beginning of any blank line and Movie Magic 
Screenwriter will center it and change it to ACT <NUMBER>, automatically keeping the same number as
the previous Act.



Put in an Existing Character Name
From anywhere in the script, press the <TAB> key and then start typing in the name.    After you enter 
the first letter, a Pop-Up Menu will appear, displaying all the existing names in the script that start with 
that letter.    

At this point either (1) keep typing as many letters as needed to make the name you want highlighted 
and then press <ENTER> or (2) select the name you want with the arrow keys and press <ENTER>, or 
(3) select the name you want by clicking on it with the mouse.



Put in FADE IN:
Method 1: Type it in.    When you press the colon (:) at the end, it will miraculously become capitalized.    
If QuickType is on, a pop-up PULL-DOWN menu will also now appear with Initial Scene Heading Text 
Options.

Method 2: In a completely blank script, press <ENTER> and a pop-up box will appear, asking you if you 
want it to put in "FADE IN:".    Click on Yes Button or press Y to put it in.



Put in Scene Information (TV Format)
Method 1: Type NEWSCENE with any capitalization at the beginning of any blank line and Movie Magic 
Screenwriter will capitalize and center the word SCENE followed by the Scene Number in the currently 
selected format.

Method 2: Press <ENTER> while in an Act Info Line and Screenwriter will put in the appropriate Scene 
Info for you, UNLESS you have checked "Don't Use" in the Scene Information Page of the Edit Script 
Formats Menu.



Put in Action
Method 1: Press <ENTER> as many times as necessary until you are in Action.    How many times will 
vary depending on what element you're starting from, though it won't typically be more than two.

Method 2: From anywhere in the script, press    <CTRL+ENTER>.



Put in Dialogue
Press <ENTER> while the cursor is in a Character Name or a Parenthetical Element.



Put the Time of Day in a Scene Heading (ie -- DAY)
Method 1: Type it in.

Method 2: If you are in a Scene Heading with Initial Text and a location then press <ENTER> and a Pop-
Up menu with Common Times of Day will appear.    Select the one you want and it will be put in at the 
end of the Scene Heading with however many dashes were specified in the Script Options menu (see 
Setting Script Options for more details) and you'll be dropped down to Action.



Putting in a Hard Return (ie Ending Lines Short)
Method 1: Select the Edit Menu, then select Add Hard Return

Method 2: Press <ALT+ENTER>.



Putting in and Removing Revision Marks
A Revision Mark is used to identify text that has been changed from one draft to the next and is 
positioned to the far right of the revised text.    It is typically an asterisk though some people use 'X' or 
'(X)'.

Method: With the cursor anywhere in the line you want to either add or remove a revision mark, 
simply press the asterisk (*) and if there is an existing Revision Mark then it will be removed, otherwise 
one will be added.

NOTE: No matter what the Revision Mark itself is actually set to be, use the asterisk key to add/remove 
it.    The symbol you want to use as a Revision Mark can be specified on the Locked Scripts Page of the 
Edit Script Formats Menu.



Putting In Dual-Column Dialogue
Screenwriter's dual-column dialogue function currently still displays the dialogue sequentially though it 
will PRINTone column next to the other, and the page breaking routines will take into account the fact 
that they're next to each other.

Step 1: Type in the two speeches normally, entering the left speech before the right one.

Step 2: Putting the cursor anywhere in the left speech, click on the FORMAT Menu, click on CHANGE 
ELEMENT TYPE and select LEFT COLUMN.

Step 3: Place the cursor anywhere within the speech that is to be on the right column, , click on the 
FORMAT Menu, click on CHANGE ELEMENT TYPE and select RIGHT COLUMN.



Quick Bold & Capitalization of Previous Word
Press <CTRL+F12>



Quick Capitalization of Previous Word
Press F12



Quick Lower-casing of Previous Word
Press <ALT+F12>



RadioBoxes
RadioBoxes are identical to CheckBoxes except that only one RadioBox in any given group--usually 
shown in a box will be checked at any one time.    If you select a different RadioBox then the currently 
checked one, the old one will automatically be unchecked.



Real-Time Spell Checking
Real- Time Spell Checking is a feature which checks your spelling as you type, and beeps at you when a
typo is encountered.    In addition this feature can automatically correct common typo's (eg "teh" is really 
"the")    This feature can be enabled in the SpellCheck Page    in the Program Options Menu



Reloading the Original Program Default Lists
Select the Format Menu from the Main Menu bar, then choose Load User Lists and then Original 
Defaults.



Remove a Character Extension
While the cursor is at the end of a Character Name, press either Del key and it will remove the 
Extension.



Remove a Forced Page Break
Method 1: Simply put the cursor at the beginning of the element immediately FOLLOWING the forced 
page break and press the Backspace key.

Method 2: Select the EDIT Menu in the Main Menu Bar, choose Remove Forced Page.



Revision Marks
There are two types of Revision Marks available in Movie Magic Screenwriter, Current Revision Marks 
and Locked Revision Marks.
 
Current Revision Marks are the ones that are put in automatically (or by pressing *) and which will not be
visible if you turn on reveal codes.    These Current Revision Marks are the only ones which will be 
removed by selecting Remove Current Revision Marks from the FORMAT Menu; they are the only ones 
that will be found when you select Next Current Revision Mark from the GOTO menu; and finally, they 
are the only ones used to select pages to print when you select Asterisked Pages on the Print Menu.

Locked Revision Marks are ex-Current Revision Marks which have been Locked by selecting Lock 
Current Revision Marks from the FORMAT Menu on the Main Menu Bar.    These are only used in 
Animation Production.



Rich Text Format
Also knows as RTF -- a format designed by Microsoft as an interchange format between different 
programs.    Not all versions of RTF are compatible.



Right Speedbar
Right Speedbar has Up-Down Scrollbar and PushButtons, and optional Element Buttons for easy script 
management.    Right Speedbar is displayed at the right side of your screen.



RTF
Rich Text Format - a format designed by Microsoft as an interchange format between different programs.
Not all versions of RTF are compatible.



Saving a Script's Lists as the Default Lists for all New Scripts
If you want all new scripts to start with Lists that are different from the ones than Movie Magic 
Screenwriter defaults to, then you should set the User Lists in one script to what you want all scripts to 
use and then...

Method: Select the Format Menu from the Main Menu bar, then    Edit User Lists and simply check the 
CheckBox Save as Defaults for All New Scripts before pressing [OK].



Saving Portions of your Script
Select the Text you want to save as described above in Selecting Text, and then...

Select the Edit Menu, and choose either Cut To.., or Copy To... depending on whether you want to keep 
the text in your script or not.    You will be then prompted to give this text a name and it will be saved as a
separate file.



Scene Body Text User List
The User List in Screenwriter which contains locations or sets.



Scene Heading
An element which is also sometimes called a SLUG or Slug Line.    It starts each scene and which 
commonly begins with INT. or EXT. then has a location and a time of day, such as...

EXT. MORGUE -- NIGHT



Scene Headings
An element which is also sometimes called a SLUG or Slug Line.    It starts each scene and which 
commonly begins with INT. or EXT. then has a location and a time of day, such as...



Scene Info
An element used almost exclusively in Stage Plays and Sitcoms, it is typically centered and follows an 
ACT INFO element.    Not to be confused with a Scene Heading.



Scene Information
An element used almost exclusively in Stage Plays and Sitcoms, it is typically centered and follows an 
ACT INFO element.    Not to be confused with a Scene Heading.



Screenplay Format
This is the fairly standard format used in feature scripts, MOWs, Hour Dramatic TV shows and most 
long-form drama.    It has upper/lower case ACTION, single spaced DIALOGUE and can have ACT 
BREAKS as needed.



Screenplay
This is the fairly standard format used in feature scripts, MOWs, Hour Dramatic TV shows and most 
long-form drama.    It has upper/lower case ACTION, single spaced DIALOGUE and can have ACT 
BREAKS as needed.



Screenplays
This is the fairly standard format used in feature scripts, MOWs, Hour Dramatic TV shows and most 
long-form drama.    It has upper/lower case ACTION, single spaced DIALOGUE and can have ACT 
BREAKS as needed.



Script Directory
The Subdirectory where Movie Magic Screenwriter will use to save and retreive scripts unless you 
specify otherwise.    Set on the Startup/Files Page of the Program Options Menu.



Script Notes
A feature which allows you to write notes in the script.    These notes do not affect the Pagination of the 
script, and can be printed either separately, or as a part of the printed script.    (Note, if they are printed 
as a part of the Script, they will of course affect the pagination of the output)



Scriptware® Tagged
A format produced by Cinovation Inc.'s screenwriting program Scriptware®



Scriptware®
A screenwriting program which is a registered trademark of Cinovation, Inc.



Selecting Text
Method 1: Press <SHIFT> and while holding it down, press any movement key to extend the block.

Method 2: Left-Click the mouse at the position where you want the block to start and while holding the 
Left Button down, drag the mouse cursor to extend the block.    If you put the cursor anywhere on the top
or bottom menu bar while still holding the mouse down, it will scroll in that direction for you.

Method 3: Left Click the mouse twice to hightlight a word, twice again for the sentence, twice again for 
the element and so on...

Method 4: Right Click the Mouse (assuming your mouse has a right button, otherwise you're out of luck!)
and click on the Select button if you have PowerPanel selected or choose the appropriate selection 
Menu Item otherwise.



Shot
Camera directions, such as P.O.V., or ANGLE ON.    Any following action is kept on the same page as 
the shot text.    Similar to a Scene Heading, except not numbered.



Sitcom Version I
This is a semi-standard sitcom format that is generally used on filmed shows and has smaller margins 
than a typical screenplay, ACTION is capitalized, DIALOGUE is double-spaced and PARENTHETICALs 
are indented within the DIALOGUE margins.

NOTE: There are NO true Standard Sitcom Formats at all and unless you are personally familiar with the
format of any given show, I HIGHLY recommend that you get a copy of an actual script and match its 
formats and spelling before you submit it anywhere.



Sitcom Version II
This is a semi-standard Sitcom format that is generally used on taped shows and has smaller margins 
than a typical screenplay, ACTION is capitalized and in Parenthesis, DIALOGUE is double-spaced and 
PARENTHETICALs are outdented to the ACTION margin.

NOTE: There are NO true Standard Sitcom Formats at all and unless you are personally familiar with the
format of any given show, I HIGHLY recommend that you get a copy of an actual script and match its 
formats and spelling before you submit it anywhere.



Sitcom
Comes preset in two versions: Sitcom Version I which is the semi-standard format for filmed shows, and 
Sitcom Version II which is the semi-standard format for taped shows.



Sitcoms
Comes preset in two versions: Sitcom Version I which is the semi-standard format for filmed shows, and 
Sitcom Version II which is the semi-standard format for taped shows.



Skip List
A list of letters which should be skipped in the numbering of Act & Scene Info, in addition to A&B 
Pages/Scenes.    Typical letters skipped are I and O because they look too much like the numbers 1 and 
0 and E and F because they look too much alike.    This Skip List is set on the Locked Scripts Page of 
the Edit Scripts Format Menu.



SmartCheck
Movie Magic Screenwriter' unique feature that will scan your script for common formatting errors, 
allowing you to correct them prior to printing your script.    It can be run automatically before every print 
job, or can be run alone by selecting Run SmartCheck from the Format Menu.    It has several options 
which you can set on the SmartCheck Page of the Program Options Menu



Stage Play
This a format based on Samuel French's guidelines and has indented ACTION margins with 
Parenthesis, wide DIALOGUE margins and ACT & SCENE INFORMATION.



Stage Plays
This a format based on Samuel French's guidelines and has indented ACTION margins with 
Parenthesis, wide DIALOGUE margins and ACT & SCENE INFORMATION.



Start a Scene Heading
Method 1: Type INT. or EXT. (or any valid Initial scene Heading Text) with any capitalization at the 
beginning of a blank line and Movie Magic Screenwriter will automatically make it into a Scene Heading, 
capitalization etc al.

Method 2: Press <ENTER> while in a Blank Action Line and a pop-up PULL-DOWN menu will appear 
with Initial Scene Heading Text options.    Select the one you want, and type away.

Method 3: Press <Ctrl+ I> for INT. or <Ctrl+E> for EXT. and it will start a Scene Heading with the 
appropriate INT. or EXT. text already typed into it.



Switching among Documents
Movie Magic Screenwriter supports standard Windows multiple document handling.    If you want to work
with two or more (up to nine) documents at the same time, you should open all the scripts you want by 
selecting Open as many times as needed.

You can then switch among them in full-screen mode by going to Window Menu and choosing the 
document you want from the list of all the open files.    

Under the same menu you can also Cascade or Tile all the open windows to see them in a multiple 
Window interface, Minimize all documents to reduce them to Icons, Arrange Icons of Minimized 
Documents, and use Maximize Window to restore the active Window to full screen.



Switching between Insert & Typeover Modes
When typing in Screenwriter, you can have it insert letters at the cursor position, thus pushing any 
existing text to the right--this is Insert Mode and it the mode that the program always starts with--or you 
can have it type over any existing text in that element, replacing as you type--this is Typeover Mode. 

Method: Press the <INSERT> Key or click on the Insert Button in the Bottom Status bar, it will 
change from Insert to Typeover, and vice-versa.



Text or Numerical Input Fields
Text or Numerical Input Fields will allow you to enter text or numbers as required.    Depending on what 
you are entering text for, it may or may not allow you to enter spaces, and it may or may not 
automatically be in all caps.



Text Style
The "style' of the text -- whether it's normal, bolded, underlined, italicized or some combination thereof.



Text Styles
The "style' of the text -- whether it's normal, bolded, underlined, italicized or some combination thereof.



Time-of-Day Normalization
A unique feature in Movie Magic Screenwriter' Production Breakdowns that takes Scene Headings 
whose time of day is LATER, CONTINUOUS or SAME and gives them the previous scene's Time of 
Day, in addition to normalizing times of day like AFTERNOON to DAY and EVENING to NIGHT to make 
for easier and more accurate scheduling.



Timed Backup
An automatic backup of your script saved in the default script subdirectory under the name SAVE1, 
SAVE2 etc (depending on the number of Windows open) and with the extension .TMB.    This does NOT 
overwrite your script and you MUST save your script when you exit or your changes may be lost for 
good!



toggle
A toggle is an item that has two states, and you switch between them by simply re-selecting that item



Top Continued
The Scene Continued (optionally) printed on those pages where a scene continues from the previous 
page.    You can set its text in the Edit Script Formats Menu and its position on the Printer Page of the 
Program Options Menu.    It will also pickup whatever numbering (left and/or right) that you have set for 
Scene Headings.



Top Margin
The distance between the top of the page and the first text on the page.



Top Speedbar
Top Speedbar has several PushButtons for editing and file management, Current Element Window, 
Change Element Pulldown menu, and Right-Left Scroll Bar that allow quick access to frequently used 
program functions. Top Speedbar is located just under the Main Menu Bar.



Transition
An element such as CUT TO: or DISSOLVE TO: which transitions you from one scene to another -- use 
sparingly.



Transitions
An element such as CUT TO: or DISSOLVE TO: which transitions you from one scene to another -- use 
sparingly.



Turning On/Off Scene Numbering
Although we do NOT recommend the use of Scene Numbers in a Spec Script (as they are really a 
Production format), Screenwriter can put them in or take them out pretty instantly.

Method: Click on the Format Menu, select Edit Script Formats and click the button labeled Scene 
Headings then check or uncheck the CheckBoxes Left (which turns on/off Left Scene Numbering) and 
Right (which controls the Right Scene Numbering) as desired.



Typeover
When typing in this mode, it will typeover any existing text in the element, replacing text as you type.    
See also Insert mode



Underlining Text
Method 1: On The Top Speedbar,    click the button labeled "U"

Method 2: Press <CTRL+U>



User Activities
are where the User (the person who eventually will be playing the adventure game or using the 
educational CD ROM) can make choices and/or do things.    All User Activities MUST be in the form of a 
statement that is either true or false, such as    "IF USER PRESSES BUTTON THEN".    If the User does 
press the button, then the statement is true, otherwise the statement is false.

An Activity line generally starts with the word IF and (with certain exceptions) must have the word THEN 
in it.    It is indented from the left-hand margin, is capitalized, and has one or more angle brackets 
pointing to it to identify it as an activity.    For example.

> IF YOU PICK UP THE GLOWING SWORD THEN

When the script is played, if the activity line becomes true (i.e. the user does pick up the glowing sword) 
then all the text (and/or dialogue) between this User Activity and the next User Activity Line with the 
words ENDIF in it are processed, otherwise that chunk of the script



User Dictionary
A supplemental dictionary to which you can add words--if desired each script can have its own 
supplemental User Dictionary.



User Selection Box
The box in the Multimedia Run-Time Player where the user can make jumps and choose yes or no to 
User Activities.



Why Loading Character Names or Scene Body Text Lists from Screenwriter 
scripts sometimes doesn't work
Just because a Location or Character Name is displayed on a Pull-Down menu does NOT mean that it is
on that script's User List!    A common confusion is to try and load the Scene Body Text (Locations) or 
Character Names User Lists from a script only to have nothing loaded.    The reason for this that the 
Locations and Character Names are not actually in that script's User Lists, but are simply accessed from
the script itself.    To make these items available to be loaded into other scripts, you must first copy them 
into a User List (see Copying Script Elements into User Lists below).



Workspace
The Screenwriter Workspace is the desktop screen with all the open scripts with their window's size, 
position and layout with respect to each other..    It is saved automatically when you select EXIT from the 
FILE Menu, though if you CLOSE each script individually then the Workspace will only consist of the 
LAST script that you had open.



WYSIWYG
What-You-See-Is-What-You-Get...



ZapSave
A specialized Screenwriter file format, which allows for very fast saving and retrieval of files.






